Conventions used in this guide

**TIP:** Tips provide helpful hints or shortcuts.

**NOTE:** Notes provide important information to explain a concept or to complete a task.

**CAUTION:** Cautions indicate procedures that you should follow to avoid losing data or damaging the product.

**WARNING!** Warnings alert you to specific procedures that you should follow to avoid personal injury, catastrophic loss of data, or extensive damage to the product.
# Table of contents

## 1 Product basics
- Product comparison ................................................................. 1
  - HP LaserJet Enterprise 600 M601 models ................................. 2
  - HP LaserJet Enterprise 600 M602 models ................................. 3
  - HP LaserJet Enterprise 600 M603 models ................................. 4
- Environmental features .............................................................. 5
- Accessibility features ............................................................... 6
- Product views ............................................................................ 7
  - Front view .............................................................................. 7
  - Rear view .............................................................................. 8
  - Interface ports ....................................................................... 9
  - Serial number and model number location ......................... 9

## 2 Control panel menus
- Control-panel layout ............................................................... 12
- Retrieve Job from USB menu .................................................... 14
- Retrieve Job from Device Memory menu ................................. 15
- Supplies menu ......................................................................... 16
- Trays menu ............................................................................. 17
- Administration menu ............................................................. 18
  - Reports menu ....................................................................... 18
  - General Settings menu ......................................................... 18
  - Retrieve From USB Settings menu ........................................ 21
  - General Print Settings menu ................................................. 21
  - Default Print Options menu ................................................. 23
  - Display Settings menu ......................................................... 23
  - Manage Supplies menu ....................................................... 24
  - Manage Trays menu ............................................................. 25
  - Stapler/Stacker Settings menu ............................................. 26
  - Multi-Bin Mailbox Settings menu ....................................... 26
  - Network Settings menu ........................................................ 27
3 Software for Windows ........................................................................................................ 35
   Supported operating systems and printer drivers for Windows ............................................. 36
   Select the correct printer driver for Windows ........................................................................... 37
      HP Universal Print Driver (UPD) ......................................................................................... 37
         UPD installation modes ................................................................................................. 38
   Change print job settings for Windows ...................................................................................... 39
      Priority for print settings ............................................................................................... 39
      Change the settings for all print jobs until the software program is closed .................... 39
      Change the default settings for all print jobs ...................................................................... 39
      Change the product configuration settings ...................................................................... 40
   Remove the printer driver from Windows .............................................................................. 41
   Supported utilities for Windows ............................................................................................ 42
      HP Web Jetadmin .......................................................................................................... 42
      HP Embedded Web Server ............................................................................................ 42
      HP ePrint ....................................................................................................................... 42
   Software for other operating systems ..................................................................................... 43

4 Use the product with Mac .................................................................................................... 45
   Software for Mac .................................................................................................................. 46
   Supported operating systems and printer drivers for Mac ..................................................... 46
   Install software for Mac operating systems ......................................................................... 46
      Install software for Mac computers connected directly to the product ...................... 46
      Install software for Mac computers on a wired network ............................................. 47
         Configure the IP address .......................................................................................... 47
         Install the software .................................................................................................. 48
   Remove the printer driver from Mac operating systems ...................................................... 49
   Priority for print settings for Mac ......................................................................................... 50
   Change printer-driver settings for Mac ................................................................................ 50
      Change the settings for all print jobs until the software program is closed .................. 50
      Change the default settings for all print jobs ............................................................... 50
      Change the product configuration settings ................................................................. 50
   Software for Mac computers ............................................................................................... 51
      HP Utility for Mac ......................................................................................................... 51
         Open the HP Printer Utility ...................................................................................... 51
Tray and bin capacity ................................................................. 77
Load paper trays ........................................................................ 78
  Load Tray 1 ........................................................................... 78
  Load Tray 2 or an optional 500-sheet tray ................................. 79
  Load an optional 1,500-sheet tray ........................................... 81
Paper orientation for loading trays ........................................... 83
  Load letterhead, preprinted, or prepunched paper ................. 83
  Load envelopes .................................................................... 84
Configure trays ......................................................................... 85
  Configure a tray when loading paper .................................... 85
  Configure a tray to match print job settings ......................... 85
  Configure a tray from the control panel .............................. 86
Select an output bin ................................................................. 87
  Print to the top (standard) output bin ................................. 87
  Print to the rear output bin ................................................. 87
  Print to the optional stacker or stapler/stacker ................. 88
  Print to the 5-bin mailbox .................................................. 89

7 Print cartridges ....................................................................... 91
Print cartridge information ..................................................... 92
Supplies views ......................................................................... 93
  Print cartridge views ......................................................... 93
Manage print cartridges ......................................................... 94
  Change settings for print cartridges ................................... 94
    Print when a print cartridge is at estimated end of life .... 94
    Enable or disable the Very Low Settings options from the control panel 94
    Print with EconoMode .................................................... 95
Store and recycle supplies .................................................... 95
  Recycle supplies ............................................................. 95
  Print-cartridge storage ...................................................... 95
  HP policy on non-HP print cartridges ............................... 95
HP anticounterfeit Web site .................................................. 95
Replacement instructions ....................................................... 97
  Replace the print cartridge ............................................... 97
  Replace staples ................................................................. 99
  Perform preventive maintenance ........................................ 100
    Reset the maintenance-kit counter ............................... 100
Solve problems with print cartridges .................................... 101
  Check the print cartridges ............................................... 101
    Inspect the print cartridge for damage ......................... 102
    Repeating defects ......................................................... 103
8 Print tasks .................................................................................................................... 107

Cancel a print job with Windows .................................................................................. 108
Basic print tasks with Windows ..................................................................................... 109
  Open the printer driver with Windows ......................................................................... 109
  Get help for any printing option with Windows ......................................................... 110
  Change the number of print copies with Windows ...................................................... 110
Save custom print settings for reuse with Windows ..................................................... 111
  Use a printing shortcut with Windows ........................................................................ 111
  Create printing shortcuts ........................................................................................... 112
Improve print quality with Windows ............................................................................... 115
  Select the page size with Windows ............................................................................. 115
  Select a custom page size with Windows .................................................................... 115
  Select the paper type with Windows ........................................................................... 115
  Select the paper tray with Windows .......................................................................... 115
Print on both sides (duplex) with Windows .................................................................. 116
  Manually print on both sides with Windows ............................................................. 116
  Automatically print on both sides with Windows ....................................................... 117
Print multiple pages per sheet with Windows ............................................................. 119
Select page orientation with Windows .......................................................................... 120
Use HP ePrint .................................................................................................................. 122
Additional print tasks with Windows ............................................................................. 123
  Print on preprinted letterhead or forms with Windows ............................................... 123
  Print on special paper, labels, or transparencies with Windows ................................. 125
  Print the first or last page on different paper with Windows ....................................... 128
  Scale a document to fit page size with Windows ......................................................... 130
  Add a watermark to a document with Windows ......................................................... 132
  Create a booklet with Windows .................................................................................. 132
Select output options with Windows ............................................................................. 134
  Select an output bin with Windows ............................................................................. 134
  Select staple options with Windows ............................................................................ 135
Use job storage features with Windows ......................................................................... 137
  Create a stored job with Windows ............................................................................. 137
  Print a stored job ........................................................................................................ 138
  Delete a stored job ....................................................................................................... 138
  Set job storage options with Windows ........................................................................ 139
    Print one copy for proof before printing all copies ................................................... 139
    Temporarily store a personal job on the product and print it later ......................... 139
    Temporarily store a job on the product ..................................................................... 139
9 Manage and maintain ................................................................. 145

Print information pages ............................................................ 146
Use the HP Embedded Web Server ............................................. 147
   Open the HP Embedded Web Server by using a network connection .... 147
   HP Embedded Web Server features ......................................... 148
      Information tab ........................................................................ 148
      General tab ............................................................................. 148
      Print tab ................................................................................ 149
      Troubleshooting tab ............................................................. 149
      Security tab .......................................................................... 150
      HP Web Services tab ........................................................... 150
      Networking tab ..................................................................... 150
      Other Links list ..................................................................... 150
Use HP Web Jetadmin software ................................................ 151
Product security features ............................................................ 152
   Security statements .............................................................. 152
      IP Security ........................................................................... 152
   Secure the HP Embedded Web Server ................................... 152
   Encryption support: HP Encrypted High Performance Hard Disks (xh models only) .... 152
   Secure stored jobs .................................................................. 153
   Lock the control panel menus ............................................... 153
   Lock the formatter .................................................................. 153
Economy settings ........................................................................ 154
   Print with EconoMode ............................................................ 154
   Powersave modes .................................................................... 154
      Disable or enable sleep mode ............................................. 154
      Set the sleep timer ............................................................ 155
      Set the sleep schedule .................................................... 155
Install memory and internal USB devices .................................... 156
   Overview .............................................................................. 156
   Install memory ..................................................................... 156
10 Solve problems .......................................................................................................................... 167

Solve problems checklist ............................................................................................................... 169
Factors that affect product performance .................................................................................... 170
Restore factory settings ............................................................................................................. 171
Interpret control-panel messages .......................................................................................... 172
Control-panel message types .................................................................................................... 172
Control-panel messages ............................................................................................................. 172

Paper feeds incorrectly or becomes jammed ............................................................................... 173
The product does not pick up paper ........................................................................................ 173
The product picks up multiple sheets of paper ......................................................................... 173
Prevent paper jams .................................................................................................................... 173
Clear jams .................................................................................................................................. 175
Jam locations .............................................................................................................................. 175
Clear jams from the output areas ............................................................................................. 175
Clear jams from the rear output bin ........................................................................................ 176
Clear jams from the optional stacker or stapler/stacker .......................................................... 176
Clear paper jams from the optional stacker or stapler/stacker .................................................. 177
Clear staple jams from the optional stapler/stacker .................................................................. 177
Clear jams from the optional 5-bin mailbox ............................................................................ 179
Clear jams from the fuser area .................................................................................................. 181
Clear jams from the optional duplexer .................................................................................... 184
Clear jams from the trays .......................................................................................................... 186
Clear jams from Tray 1 ............................................................................................................. 186
Clear jams from Tray 2 or an optional 500-sheet tray .............................................................. 186
Clear jams from the optional 1,500-sheet tray ........................................................................ 187
Clear jams from the optional envelope feeder ....................................................................... 189
Clear jams from the top-cover and print-cartridge areas ......................................................... 190
Change jam recovery ................................................................................................................ 192

Improve print quality .................................................................................................................. 193
Select a paper type ..................................................................................................................... 193
Use paper that meets HP specifications ..................................................................................... 193
Print a cleaning page ............................................................................................ 194
Check the print cartridge ........................................................................................ 194
Use the printer driver that best meets your printing needs ........................................... 196
The product does not print or it prints slowly .......................................................... 197
The product does not print ...................................................................................... 197
The product prints slowly ........................................................................................ 198
Solve walk-up USB printing problems ........................................................................ 199
  The Retrieve From USB menu does not open when you insert the USB accessory .... 199
  The file does not print from the USB storage accessory ............................................ 199
  The file that you want to print is not listed in the Retrieve From USB menu .......... 200
Solve connectivity problems ...................................................................................... 201
Solve direct-connect problems ................................................................................ 201
Solve network problems ......................................................................................... 201
  Poor physical connection ...................................................................................... 201
  The computer is using the incorrect IP address for the product ......................... 201
  The computer is unable to communicate with the product .................................... 202
  The product is using incorrect link and duplex settings for the network .......... 202
  New software programs might be causing compatibility problems ................... 202
  The computer or workstation might be set up incorrectly .................................... 202
  The product is disabled, or other network settings are incorrect ......................... 202
Solve product software problems with Windows ...................................................... 203
  A printer driver for the product is not visible in the Printer folder ....................... 203
  An error message was displayed during the software installation ....................... 203
  The product is in Ready mode, but nothing prints .............................................. 203
Solve product software problems with Mac ............................................................. 205
  The printer driver is not listed in the Print & Fax list .......................................... 205
  The product name does not appear in the product list in the Print & Fax list ....... 205
  The printer driver does not automatically set up the selected product in the Print & Fax list .......................................................................................... 205
  A print job was not sent to the product that you wanted ...................................... 206
  When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is selected .................................................. 206
  You are using a generic printer driver when using a USB connection ................. 206

Appendix A  Product supplies and accessories ......................................................... 207
Order parts, accessories, and supplies ................................................................. 208
Part numbers ............................................................................................................ 209
Paper-handling accessories .................................................................................... 209
Customer self-repair parts ...................................................................................... 209
Cables and interfaces ............................................................................................. 210
Appendix B Service and support .......................................................................................... 211
Hewlett-Packard limited warranty statement ................................................................. 212
HP’s Premium Protection Warranty: LaserJet print cartridge limited warranty statement .... 214
Data stored on the print cartridge .................................................................................. 215
End User License Agreement ......................................................................................... 216
Customer self-repair warranty service .......................................................................... 219
Customer support ........................................................................................................ 220
Repack the product ........................................................................................................ 221

Appendix C Product specifications .................................................................................. 223
Physical specifications ................................................................................................... 224
Power consumption, electrical specifications, and acoustic emissions ......................... 224
Operating environment ................................................................................................. 224

Appendix D Regulatory information ............................................................................... 225
FCC regulations ........................................................................................................... 226
Environmental product stewardship program ............................................................... 227
Protecting the environment ......................................................................................... 227
Ozone production ......................................................................................................... 227
Power consumption ...................................................................................................... 227
Toner consumption ...................................................................................................... 227
Paper use .................................................................................................................... 227
Plastics ........................................................................................................................ 227
HP LaserJet print supplies ............................................................................................ 228
Return and recycling instructions ................................................................................. 228
United States and Puerto Rico ..................................................................................... 228
Multiple returns (more than one cartridge) ................................................................... 228
Single returns ............................................................................................................... 228
Shipping ...................................................................................................................... 228
Non-U.S. returns .......................................................................................................... 229
Paper ............................................................................................................................ 229
Material restrictions ..................................................................................................... 229
Disposal of waste equipment by users in private households in the European Union ...... 230
Chemical substances ................................................................................................. 230
Material Safety Data Sheet (MSDS) ........................................................................... 230
For more information ................................................................................................. 230
Declaration of Conformity ......................................................................................... 232
Safety statements ........................................................................................................ 234
Laser safety .................................................................................................................. 234
Canadian DOC regulations ......................................................................................... 234
Index ......................................................................................................................... 239
1 Product basics

- Product comparison
- Environmental features
- Accessibility features
- Product views
# Product comparison

## HP LaserJet Enterprise 600 M601 models

<table>
<thead>
<tr>
<th>M601n printer</th>
<th>CE989A</th>
</tr>
</thead>
<tbody>
<tr>
<td>· Prints up to 45 pages per minute (ppm) on Letter size paper and 43 ppm on A4 size paper</td>
<td></td>
</tr>
<tr>
<td>· Embedded HP Jetdirect networking</td>
<td></td>
</tr>
<tr>
<td>· Contains 512 megabytes (MB) of random access memory (RAM). Expandable to 1 gigabyte (GB).</td>
<td></td>
</tr>
<tr>
<td>· 4 GB solid-state module memory</td>
<td></td>
</tr>
<tr>
<td>· Tray 1 holds up to 100 sheets</td>
<td></td>
</tr>
<tr>
<td>· Tray 2 holds up to 500 sheets</td>
<td></td>
</tr>
<tr>
<td>· 500-sheet face-down output bin</td>
<td></td>
</tr>
<tr>
<td>· 100-sheet face-up output bin</td>
<td></td>
</tr>
<tr>
<td>· 4-line color graphical control-panel display</td>
<td></td>
</tr>
<tr>
<td>· Hi-speed USB 2.0 port</td>
<td></td>
</tr>
<tr>
<td>· Host USB printing port</td>
<td></td>
</tr>
<tr>
<td>· Walk-up USB printing port</td>
<td></td>
</tr>
<tr>
<td>· One open dual inline memory module (DIMM) slot</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M601dn printer</th>
<th>CE990A</th>
</tr>
</thead>
<tbody>
<tr>
<td>· Has the same features as the HP LaserJet Enterprise 600 M601n printer, plus the following:</td>
<td></td>
</tr>
<tr>
<td>· Duplex-printing accessory for automatic printing on both sides</td>
<td></td>
</tr>
<tr>
<td>· Wireless network printing</td>
<td></td>
</tr>
</tbody>
</table>
## HP LaserJet Enterprise 600 M602 models

<table>
<thead>
<tr>
<th>Model</th>
<th>Key Features</th>
<th>Model</th>
<th>Key Features</th>
</tr>
</thead>
</table>
| M602n printer | - Prints up to 52 pages per minute (ppm) on Letter size paper and 50 ppm on A4 size paper  
               - Embedded HP Jetdirect networking  
               - Contains 512 megabytes (MB) of random access memory (RAM). Expandable to 1 gigabyte (GB).  
               - 4 GB solid-state module memory  
               - Tray 1 holds up to 100 sheets  
               - Tray 2 holds up to 500 sheets  
               - 500-sheet face-down output bin  
               - 100-sheet face-up output bin  
               - 4-line color graphical control-panel display  
               - Numeric keypad  
               - Hi-speed USB 2.0 port  
               - Host USB printing port  
               - Walk-up USB printing port  
               - One open dual inline memory module (DIMM) slot  
               - Walkup USB printing port  
               - Hardware interface pocket | M602dn printer | Has the same features as the HP LaserJet Enterprise 600 M602n printer, plus the following:  
               - Duplex-printing accessory for automatic printing on both sides  
               - Wireless network printing |
| M602x printer | Has the same features as the HP LaserJet Enterprise 600 M602n printer, plus the following:  
               - Duplex-printing accessory for automatic printing on both sides  
               - One additional 500-sheet input tray (Tray 3)  
               - Wireless network printing |
HP LaserJet Enterprise 600 M603 models

M603n printer
CE994A

- Prints up to 62 pages per minute (ppm) on Letter size paper and 60 ppm on A4 size paper
- Embedded HP Jetdirect networking
- Contains 512 megabytes (MB) of random access memory (RAM). Expandable to 1 gigabyte (GB).
- 4 GB solid-state module memory
- Tray 1 holds up to 100 sheets
- Tray 2 holds up to 500 sheets
- 500-sheet face-down output bin
- 100-sheet face-up output bin
- 4-line color graphical control-panel display
- Numeric keypad
- Hi-speed USB 2.0 port
- Host USB printing port
- Walk-up USB printing port
- One open dual inline memory module (DIMM) slot
- Walkup USB printing port
- Hardware interface pocket

M603dn printer
Has the same features as the HP LaserJet Enterprise 600 M603n printer, plus the following:
CE995A

- Duplex-printing accessory for automatic printing on both sides
- Wireless network printing

M603xh printer
Has the same features as the HP LaserJet Enterprise 600 M603n printer, plus the following:
CE996A

- Duplex-printing accessory for automatic printing on both sides
- Wireless network printing
- One additional 500-sheet input tray (Tray 3)
- 250 GB HP Encrypted High Performance Hard Disk (replaces the 4 GB solid-state module memory that is in the n and dn models)
## Environmental features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplex</td>
<td>Save paper by using duplex printing as your default print setting.</td>
</tr>
<tr>
<td>Print multiple pages per sheet</td>
<td>Save paper by printing two or more pages of a document side-by-side on one sheet of paper. Access this feature through the printer driver.</td>
</tr>
<tr>
<td>Recycling</td>
<td>Reduce waste by using recycled paper.</td>
</tr>
<tr>
<td></td>
<td>Recycle print cartridges by using the HP return process.</td>
</tr>
<tr>
<td>Energy savings</td>
<td>Save energy by initiating sleep mode for the product.</td>
</tr>
<tr>
<td>HP Smart Web printing</td>
<td>Use HP Smart Web printing to select, store, and organize text and graphics from multiple Web pages and then edit and print exactly what you see onscreen. It gives you the control you need for printing meaningful information while minimizing waste.</td>
</tr>
<tr>
<td></td>
<td>Download HP Smart Web printing from this Web site: <a href="http://www.hp.com/go/smartweb">www.hp.com/go/smartweb</a>.</td>
</tr>
<tr>
<td>Job storage</td>
<td>Use the job storage features to manage print jobs. By using job storage, you activate printing while you are at the shared product, eliminating lost print jobs that are then reprinted.</td>
</tr>
</tbody>
</table>
Accessibility features

The product includes several features that aid you with accessibility issues.

- Online user guide that is compatible with text screen-readers.
- Print cartridges can be installed and removed by using one hand.
- All doors and covers can be opened by using one hand.
- Paper can be loaded in Tray 1 by using one hand.
Product views

Front view

1. Top output bin
2. Control panel (the M602 and M603 models include a numeric keypad)
3. Top cover (provides access to the print cartridge)
4. Walkup USB printing port
5. Tray 1 (pull to open)
6. On/off button
7. Tray 2
**Rear view**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rear output bin (pull to open)</td>
</tr>
<tr>
<td>2</td>
<td>Duplex accessory cover (remove this to install the duplex printing accessory)</td>
</tr>
<tr>
<td>3</td>
<td>Interface ports</td>
</tr>
<tr>
<td>4</td>
<td>Right cover (provides access to the DIMM slot)</td>
</tr>
<tr>
<td>5</td>
<td>Hardware integration pocket (M602 and M603 models only)</td>
</tr>
</tbody>
</table>
# Interface ports

1. RJ-45 Network connection
2. Power connection
3. Host USB connection, for adding fonts and other third-party solutions (this connection might have a removable cover)
4. Slot for a cable-type security lock
5. Hi-speed USB 2.0 connection, for connecting directly to a computer

<table>
<thead>
<tr>
<th>Serial number and model number location</th>
</tr>
</thead>
<tbody>
<tr>
<td>The label that contains the model and serial numbers is on the back of the product.</td>
</tr>
</tbody>
</table>
2 Control panel menus

- Control-panel layout
- Retrieve Job from USB menu
- Retrieve Job from Device Memory menu
- Supplies menu
- Trays menu
- Administration menu
- Device Maintenance menu
**Control-panel layout**

Use the control panel to obtain product and job status information and to configure the product.

![Control-panel diagram]

<table>
<thead>
<tr>
<th>Number</th>
<th>Button or light</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Control-panel display</td>
<td>Shows status information, menus, help information, and error messages</td>
</tr>
<tr>
<td>2</td>
<td>▲ Up arrow</td>
<td>Navigates to the previous item in the list, or increases the value of numeric items</td>
</tr>
<tr>
<td>3</td>
<td>? Help button</td>
<td>Provides information about the message on the control-panel display</td>
</tr>
</tbody>
</table>
| 4      | OK button | ● Saves the selected value for an item  
                  ● Performs the action that is associated with the item that is highlighted on the control-panel display  
                  ● Clears an error condition when the condition is clearable |
| 5      | ☎ Stop button | Cancels the current print job and clears the pages from the product |
| 6      | ▼ Down arrow | Navigates to the next item in the list, or decreases the value of numeric items |
| 7      | ◀ Back arrow | Backs up one level in the menu tree or backs up one numeric entry |
| 8      | 🏠 Home button | Opens and closes the menus. |
| 9      | ⚡ Ready light | ● **On**: The product is online and ready to accept data to print.  
                  ● **Off**: The product cannot accept data because it is offline (paused) or has experienced an error.  
                  ● **Blinking**: The product is going offline. The product stops processing the current job and expels all of the active pages from the paper path. |
| 10     | 🗃 Data light | ● **On**: The product has data to print, but is waiting to receive all of the data.  
                  ● **Off**: The product has no data to print.  
                  ● **Blinking**: The product is processing or printing the data. |
<table>
<thead>
<tr>
<th>Number</th>
<th>Button or light</th>
<th>Function</th>
</tr>
</thead>
</table>
| 11     | ![Attention light](image) | - **On**: The product has experienced a problem. See the control-panel display.  
- **Off**: The product is functioning without error.  
- **Blinking**: Action is required. See the control-panel display. |
| 12     | ![Folder or STAR (Secure Transaction Access Retrieval) button](image) | Provides quick access to the **Retrieve Job** menu |
| 13     | ![Backspace button](image) | Returns values to their defaults and exits the help screen |
| 14     | ![Numeric keypad](image) | Enter numeric values |

**NOTE:** This item is not included for the M601 models.
## Retrieve Job from USB menu

**NOTE:** You must enable this feature by using the control-panel menus or the HP Embedded Web Server before it can be used.

To enable this feature by using the control-panel menus, open the **Administration** menu, open the **Retrieve From USB Settings** sub menu, and then select the **Enable** option. To enable this feature by using the HP Embedded Web Server, click the **Print** tab.

**To display:** At the product control panel, press the Home button, and then select the **Retrieve Job from USB** menu.

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a file or folder</td>
<td>&lt;Job name&gt;</td>
<td>Copies</td>
</tr>
</tbody>
</table>
**Retrieve Job from Device Memory menu**

*To display:* At the product control panel, press the Home button, and then select the **Retrieve Job from Device Memory** menu.

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All Jobs (With PIN)</strong></td>
<td>Print</td>
<td>Copies</td>
</tr>
<tr>
<td></td>
<td>Print and Delete</td>
<td>Copies</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td><strong>All Jobs (No PIN)</strong></td>
<td>Print</td>
<td>Copies</td>
</tr>
<tr>
<td></td>
<td>Print and Delete</td>
<td>Copies</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>&lt;Job name with PIN&gt;</td>
<td>Print</td>
<td>Copies</td>
</tr>
<tr>
<td></td>
<td>Print and Delete</td>
<td>Copies</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>&lt;Job name without PIN&gt;</td>
<td>Print</td>
<td>Copies</td>
</tr>
<tr>
<td></td>
<td>Print and Delete</td>
<td>Copies</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>
## Supplies menu

**To display:** At the product control panel, press the Home button, and then select the **Supplies** menu.

In the following table, asterisks (*) indicate the factory default setting.

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Third level</th>
<th>Fourth level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Supplies</td>
<td>Print Supplies Status</td>
<td>Supply Settings</td>
<td>Black Cartridge</td>
<td>Very Low Settings</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Prompt to continue</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Continue *</td>
</tr>
<tr>
<td>Low Threshold Settings</td>
<td>1-100%</td>
<td>Default values for the CE390A cartridge:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● M601 = 8%</td>
<td>● M602 = 11%</td>
<td>● M603 = 20%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default values for the CE390X cartridge:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● M602 = 5%</td>
<td>● M603 = 9%</td>
<td></td>
</tr>
<tr>
<td>Maintenance Kit</td>
<td>Very Low Settings</td>
<td>Stop</td>
<td>Prompt to continue</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continue *</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Threshold Settings</td>
<td>1-100%</td>
<td>Default = 10%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supply Messages</td>
<td>Low Message</td>
<td>On *</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level Gauge</td>
<td>On *</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Supplies</td>
<td>New Maintenance Kit</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Black Cartridge</td>
<td>The status is displayed.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maintenance Kit</td>
<td>The status is displayed.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To display: At the product control panel, press the Home button, and then select the Trays menu.

In the following table, asterisks (*) indicate the factory default setting.

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Trays</td>
<td>Use Requested Tray</td>
<td>Exclusively*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>First</td>
</tr>
<tr>
<td>Manually Feed Prompt</td>
<td>Always*</td>
<td>Unless Loaded</td>
</tr>
<tr>
<td>Size/Type Prompt</td>
<td>Display*</td>
<td>Do Not Display</td>
</tr>
<tr>
<td>Use Another Tray</td>
<td>Enabled*</td>
<td>Disabled</td>
</tr>
<tr>
<td>Alternative Letterhead Mode</td>
<td>Disabled*</td>
<td>Enabled</td>
</tr>
<tr>
<td>Duplex Blank Pages</td>
<td>Auto *</td>
<td>Yes</td>
</tr>
<tr>
<td>Tray 2 Model</td>
<td>Standard Tray*</td>
<td>Custom Tray</td>
</tr>
<tr>
<td>Image Rotation</td>
<td>Standard*</td>
<td>Alternate</td>
</tr>
<tr>
<td>Override A4/Letter</td>
<td>Yes*</td>
<td>No</td>
</tr>
</tbody>
</table>

Envelopes Feeder Size: Select a size from the list.

Envelopes Feeder Type: Select a type from the list.

Tray <X> Size: Select a size from the list.

Tray <X> Type: Select a type from the list.
Administration menu

Reports menu

To display: At the product control panel, press the Home button, select the Administration menu, and then select the Reports menu.

Table 2-3 Reports menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration/Status Pages</td>
<td>Administration Menu Map</td>
</tr>
<tr>
<td></td>
<td>Configuration Page</td>
</tr>
<tr>
<td></td>
<td>Supplies Status Page</td>
</tr>
<tr>
<td></td>
<td>Usage Page</td>
</tr>
<tr>
<td></td>
<td>File Directory Page</td>
</tr>
<tr>
<td>Other Pages</td>
<td>PCL Font List</td>
</tr>
<tr>
<td></td>
<td>PS Font List</td>
</tr>
</tbody>
</table>

General Settings menu

To display: At the product control panel, press the Home button, select the Administration menu, and then select the General Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-4 General Settings menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Third level</th>
<th>Fourth level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time Settings</td>
<td>Date/Time Format</td>
<td>Date Format</td>
<td></td>
<td>DD/MMM/YYYY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>MMM/DD/YYYY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>YYYY/MMM/DD</td>
</tr>
<tr>
<td></td>
<td>Time Format</td>
<td></td>
<td></td>
<td>12 hour (AM/PM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>24 hours</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date</td>
<td>Month</td>
<td></td>
<td>Select values from</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>the lists.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Day</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Year</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 2-4 General Settings menu (continued)

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Third level</th>
<th>Fourth level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time</strong></td>
<td><strong>Hour</strong></td>
<td></td>
<td><strong>Values</strong></td>
<td>Select values from the lists.</td>
</tr>
<tr>
<td></td>
<td><strong>Minute</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>AM/PM</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Time Zone</strong></td>
<td></td>
<td></td>
<td><strong>Values</strong></td>
<td>Select the time zone from the list.</td>
</tr>
<tr>
<td><strong>Adjust for Daylight</strong></td>
<td><strong>Savings</strong></td>
<td></td>
<td><strong>Values</strong></td>
<td><strong>On</strong>*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Off</strong></td>
</tr>
<tr>
<td><strong>Energy Settings</strong></td>
<td><strong>Sleep Timer Settings</strong></td>
<td><strong>Sleep/Auto Off Timer</strong></td>
<td><strong>Enabled</strong>*</td>
<td><strong>Disabled</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Sleep/Auto Off After</strong></td>
<td>If you enabled the sleep/auto off timer, enter a value between 0 and 120 minutes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Default value: 30 minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Wake/Auto On Events</strong></td>
<td><strong>All Events</strong>*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Network port</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Power button only</strong></td>
</tr>
<tr>
<td><strong>Print Quality</strong></td>
<td><strong>Image Registration</strong></td>
<td><strong>Adjust Tray &lt;X&gt;</strong></td>
<td><strong>Print Test Page</strong></td>
<td><strong>X1 Shift</strong> -5.00 mm to 5.00 mm</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Y1 Shift</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>X2 Shift</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Y2 Shift</strong></td>
</tr>
<tr>
<td><strong>Adjust Paper Types</strong></td>
<td><strong>Select from a list of paper types that the product supports. The available options are the same for each paper type.</strong></td>
<td><strong>Print Mode</strong></td>
<td><strong>Select from a list of print modes.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Resistance Mode</strong></td>
<td><strong>Normal</strong></td>
<td></td>
<td></td>
<td><strong>Up</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Down</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Humidity Mode</strong></td>
<td><strong>Normal</strong></td>
<td></td>
<td></td>
<td><strong>High</strong></td>
</tr>
<tr>
<td><strong>Restore Modes</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First level</td>
<td>Second level</td>
<td>Third level</td>
<td>Fourth level</td>
<td>Values</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>-------------</td>
<td>--------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Optimize</td>
<td>Line Detail</td>
<td></td>
<td></td>
<td>Normal*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Alternate 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Alternate 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Alternate 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Off</td>
</tr>
<tr>
<td>Restore Optimize</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td></td>
<td></td>
<td></td>
<td>300 x 300 dpi</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>600 x 600 dpi</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>FastRes 1200*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ProRes 1200</td>
</tr>
<tr>
<td>REt</td>
<td></td>
<td></td>
<td></td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>On*</td>
</tr>
<tr>
<td>Economode</td>
<td></td>
<td></td>
<td></td>
<td>Off*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>On</td>
</tr>
<tr>
<td>Toner Density</td>
<td></td>
<td></td>
<td></td>
<td>Range: 1 - 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Default = 3</td>
</tr>
<tr>
<td>Quiet Mode</td>
<td></td>
<td></td>
<td></td>
<td>Off*</td>
</tr>
<tr>
<td>Jam Recovery</td>
<td></td>
<td></td>
<td></td>
<td>On</td>
</tr>
<tr>
<td>Manage Stored Jobs</td>
<td></td>
<td>Quick Copy Job</td>
<td></td>
<td>1-100</td>
</tr>
<tr>
<td></td>
<td>Storage Limit</td>
<td>Held Timeout</td>
<td></td>
<td>Default = 32</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Off*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1 Hour</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4 Hours</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1 Day</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1 Week</td>
</tr>
<tr>
<td>Default Folder Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 2-4  General Settings menu (continued)
Table 2-4  General Settings menu (continued)

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Third level</th>
<th>Fourth level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sort Stored Jobs By</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Job Name*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Date</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>First level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Factory Settings</td>
<td></td>
</tr>
</tbody>
</table>

Retrieve From USB Settings menu

**To display:** At the product control panel, press the Home button, select the Administration menu, and then select the Retrieve From USB Settings menu.

Table 2-5  Retrieve From USB Settings menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Retrieve from USB</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td>Disabled*</td>
</tr>
</tbody>
</table>

General Print Settings menu

**To display:** At the product control panel, press the Home button, select the Administration menu, and then select the General Print Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-6  Print Settings menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Feed</td>
<td></td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disabled*</td>
</tr>
<tr>
<td>Courier Font</td>
<td></td>
<td>Regular*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dark</td>
</tr>
<tr>
<td>Wide A4</td>
<td></td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disabled*</td>
</tr>
<tr>
<td>Print PS Errors</td>
<td></td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disabled*</td>
</tr>
<tr>
<td>Print PDF Errors</td>
<td></td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disabled*</td>
</tr>
</tbody>
</table>
Table 2-6  Print Settings menu (continued)

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Personality</strong></td>
<td></td>
<td>Auto*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PCL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PDF</td>
</tr>
<tr>
<td><strong>PCL</strong></td>
<td><strong>Form Length</strong></td>
<td>Range: 5 – 128</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default = 60</td>
</tr>
<tr>
<td><strong>Orientation</strong></td>
<td><strong>Portrait</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Landscape</strong></td>
</tr>
<tr>
<td><strong>Font Source</strong></td>
<td><strong>Internal</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>USB</strong></td>
</tr>
<tr>
<td><strong>Font Number</strong></td>
<td>Range: 0 – 110</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default = 0</td>
<td></td>
</tr>
<tr>
<td><strong>Font Pitch</strong></td>
<td>Range: 0.44 – 99.99</td>
<td>Default = 10.00</td>
</tr>
<tr>
<td><strong>Font Point Size</strong></td>
<td>Range: 4.00 – 999.75</td>
<td>Default = 12.00</td>
</tr>
<tr>
<td><strong>Symbol Set</strong></td>
<td>Select from a list of symbol sets.</td>
<td></td>
</tr>
<tr>
<td><strong>Append CR to LF</strong></td>
<td><strong>No</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Yes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Suppress Blank Pages</strong></td>
<td><strong>No</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Yes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Media Source Mapping</strong></td>
<td><strong>Standard</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Classic</strong></td>
<td></td>
</tr>
</tbody>
</table>
**Default Print Options menu**

To display: At the product control panel, press the Home button, select the Administration menu, and then select the Default Print Options menu.

In the following table, asterisks (*) indicate the factory default setting.

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Copies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default Paper Size</td>
<td></td>
<td>Select from a list of sizes that the product supports.</td>
</tr>
<tr>
<td>Default Custom Paper Size</td>
<td>Unit of Measure</td>
<td>Inches, mm</td>
</tr>
<tr>
<td>Output Bin</td>
<td></td>
<td>Select from a list of available output bins.</td>
</tr>
<tr>
<td>Sides</td>
<td></td>
<td>1-sided*, 2-sided</td>
</tr>
<tr>
<td>2-Sided Format</td>
<td></td>
<td>Book-style*, Flip-style</td>
</tr>
<tr>
<td>Edge-To-Edge</td>
<td></td>
<td>Enabled, Disabled*</td>
</tr>
</tbody>
</table>

**Display Settings menu**

To display: At the product control panel, press the Home button, select the Administration menu, and then select the Display Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Brightness</td>
<td></td>
<td>Range -10 to 10</td>
</tr>
<tr>
<td>Language</td>
<td></td>
<td>Select from a list of languages that the product supports.</td>
</tr>
<tr>
<td>Show IP Address</td>
<td></td>
<td>Display, Hide</td>
</tr>
<tr>
<td>Inactivity Timeout</td>
<td></td>
<td>Range: 10 – 300 seconds, Default = 60 seconds</td>
</tr>
</tbody>
</table>
Table 2-7  Display Settings menu (continued)

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clearable Warnings</td>
<td>On</td>
<td>Job*</td>
</tr>
<tr>
<td>Continuable Events</td>
<td>Auto continue (10 seconds)*</td>
<td>Press OK to continue</td>
</tr>
</tbody>
</table>

**Manage Supplies menu**

**To display:** At the product control panel, press the Home button, select the Administration menu, and then select the Manage Supplies menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-8  Manage Supplies menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Third level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Supplies Status</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supply Settings</td>
<td>Black Cartridge</td>
<td>Very Low Settings</td>
<td>Stop</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Prompt to continue</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Continue*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Threshold Settings</td>
<td>1-100%</td>
<td>Default values for the CE390A cartridge:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● M601 = 8%</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● M602 = 11%</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● M603 = 20%</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default values for the CE390X cartridge:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● M602 = 5%</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● M603 = 9%</td>
<td></td>
</tr>
<tr>
<td>Maintenance Kit</td>
<td>Very Low Settings</td>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Prompt to continue</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continue*</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Low Threshold Settings</td>
<td>1-100%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default = 10%</td>
<td></td>
</tr>
</tbody>
</table>
Table 2-8  Manage Supplies menu (continued)

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Third level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply Messages</td>
<td>Low Message</td>
<td></td>
<td>On *</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>Level Gauge</td>
<td></td>
<td>On *</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Off</td>
</tr>
<tr>
<td>Reset Supplies</td>
<td>New Maintenance Kit</td>
<td></td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Manage Trays menu**

**To display:** At the product control panel, press the Home button, select the Administration menu, and then select the Manage Trays menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-9  Manage Trays menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Requested Tray</td>
<td>Exclusively *</td>
</tr>
<tr>
<td></td>
<td>First</td>
</tr>
<tr>
<td>Manually Feed Prompt</td>
<td>Always *</td>
</tr>
<tr>
<td></td>
<td>Unless Loaded</td>
</tr>
<tr>
<td>Size/Type Prompt</td>
<td>Display *</td>
</tr>
<tr>
<td></td>
<td>Do Not Display</td>
</tr>
<tr>
<td>Use Another Tray</td>
<td>Enabled *</td>
</tr>
<tr>
<td></td>
<td>Disabled</td>
</tr>
<tr>
<td>Alternative Letterhead Mode</td>
<td>Disabled *</td>
</tr>
<tr>
<td></td>
<td>Enabled</td>
</tr>
<tr>
<td>Duplex Blank Pages</td>
<td>Auto *</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Tray 2 Model</td>
<td>Standard Tray</td>
</tr>
<tr>
<td></td>
<td>Custom Tray</td>
</tr>
<tr>
<td>Image Rotation</td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td>Alternate</td>
</tr>
<tr>
<td>Override A4/Letter</td>
<td>Yes *</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>
**Stapler/Stacker Settings menu**

To display: At the product control panel, press the Home button, select the Administration menu, and then select the **Stapler/Stacker Settings** menu.

In the following table, asterisks (*) indicate the factory default setting.

**Table 2-10  Stapler/Stacker Settings menu**

<table>
<thead>
<tr>
<th>First level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stapling</td>
<td></td>
</tr>
<tr>
<td></td>
<td>None*</td>
</tr>
<tr>
<td></td>
<td>Top left or right</td>
</tr>
<tr>
<td></td>
<td>Top left</td>
</tr>
<tr>
<td></td>
<td>Top right</td>
</tr>
<tr>
<td>Staples Very Low</td>
<td>Continue*</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
</tr>
</tbody>
</table>

**Multi-Bin Mailbox Settings menu**

To display: At the product control panel, press the Home button, select the Administration menu, and then select the **Multi-Bin Mailbox Settings** menu.

In the following table, asterisks (*) indicate the factory default setting.

**Table 2-11  Multi-Bin Mailbox Settings menu**

<table>
<thead>
<tr>
<th>First level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation Mode</td>
<td>Mailbox*</td>
</tr>
<tr>
<td></td>
<td>Stacker</td>
</tr>
<tr>
<td></td>
<td>Job Separator</td>
</tr>
<tr>
<td></td>
<td>Collator</td>
</tr>
</tbody>
</table>
Network Settings menu

To display: At the product control panel, press the Home button, select the Administration menu, and then select the Network Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-12  Network Settings menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Timeout</td>
<td>Range: 5 – 300 sec</td>
</tr>
<tr>
<td></td>
<td>Default = 15</td>
</tr>
</tbody>
</table>

Jetdirect Menu

See the table that follows for details.

Table 2-13  Jetdirect Menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Third level</th>
<th>Fourth level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td>Print Sec Page</td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Enable</td>
<td></td>
<td></td>
<td>On*</td>
</tr>
</tbody>
</table>

Host Name

IPV4 Settings  Config Method

Bootp
DHCP*
Auto IP
Manual

Manual Settings

NOTE: This menu is available only if you select the Manual option under the Config Method menu.

IP Address

Enter the address.

Subnet Mask

Enter the address.

Default Gateway

Enter the address.

Default IP

Auto IP*
Legacy

DHCP Release

No*
Yes
<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Third level</th>
<th>Fourth level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP Renew</td>
<td></td>
<td></td>
<td></td>
<td>No*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Primary DNS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secondary DNS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPV6 Settings</td>
<td>Enable</td>
<td></td>
<td></td>
<td>On*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manual Settings</td>
<td>Enable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Address</td>
<td>Manual Settings</td>
<td>Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DHCPV6 Policy</td>
<td>Router Specified</td>
<td>Router Unavailable*</td>
<td>Always</td>
<td></td>
</tr>
<tr>
<td>Primary DNS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secondary DNS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proxy Server</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proxy Port</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Idle Timeout</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Security</td>
<td>Secure Web</td>
<td>HTTPS Required*</td>
<td>HTTPS Optional</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Keep</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disable*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPSEC</td>
<td></td>
<td>Reset</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Keep*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>802.1X</td>
<td></td>
<td>Reset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Security</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Embedded Tests</td>
<td>LAN HW Test</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>HTTP Test</td>
<td>No*</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNMP Test</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No*</td>
<td></td>
</tr>
<tr>
<td>First level</td>
<td>Second level</td>
<td>Third level</td>
<td>Fourth level</td>
<td>Values</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>-------------</td>
<td>--------------</td>
<td>--------</td>
</tr>
<tr>
<td>Data Path Test</td>
<td></td>
<td></td>
<td>Yes</td>
<td>No*</td>
</tr>
<tr>
<td>Select All Tests</td>
<td></td>
<td></td>
<td>Yes</td>
<td>No*</td>
</tr>
<tr>
<td>Execution Time [H]</td>
<td></td>
<td></td>
<td>Range: 1 – 60 hours</td>
<td>Default = 1 hour</td>
</tr>
<tr>
<td>Execute</td>
<td></td>
<td></td>
<td>No*</td>
<td>Yes</td>
</tr>
<tr>
<td>Ping Test</td>
<td>Dest Type</td>
<td></td>
<td>IPV4</td>
<td>IPV6</td>
</tr>
<tr>
<td>Dest IPv4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dest IPv6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Packet Size</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timeout</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Results</td>
<td></td>
<td></td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Execute</td>
<td></td>
<td></td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ping Results</td>
<td>Packets Sent</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Packets Received</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent Lost</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RTT Min</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RTT Max</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RTT Average</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ping in Progress</td>
<td></td>
<td></td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>First level</td>
<td>Second level</td>
<td>Third level</td>
<td>Fourth level</td>
<td>Values</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>-------------</td>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Refresh</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Link Speed | Auto *       | 10T Half    | 10T Full     | 100TX Half   |
|           |              | 100TX Full  | 1000T Full   |              |
Troubleshooting menu

To display: At the product control panel, press the Home button, select the Administration menu, and then select the Troubleshooting menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-14 Troubleshooting menu

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Third level</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Event Log</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Event Log</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Paper Path Page</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Quality Pages</td>
<td>Print Fuser Test Page</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagnostic Tests</td>
<td>Paper Path Sensors</td>
<td>Select from a list of the product sensors.</td>
<td></td>
</tr>
<tr>
<td>Paper Path Test</td>
<td>Print Test Page</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td></td>
<td>Select from a list of the available trays.</td>
<td></td>
</tr>
<tr>
<td>Destination</td>
<td></td>
<td>Select from a list of the available bins.</td>
<td></td>
</tr>
<tr>
<td>Duplex</td>
<td>Off*</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copies</td>
<td>1*</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>50</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stacking</td>
<td>Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual Sensor Test</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual Tray/Bin Sensor Test</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Component Test</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print/Stop Test</td>
<td></td>
<td>Range: 0 – 60,000</td>
<td></td>
</tr>
</tbody>
</table>
Device Maintenance menu

Backup/Restore menu

To display: At the product control panel, press the Home button, select the **Device Maintenance** menu, and then select the **Backup/Restore** menu.

In the following table, asterisks (*) indicate the factory default setting.

<table>
<thead>
<tr>
<th>Table 2-15 Backup/Restore menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First level</strong></td>
</tr>
<tr>
<td>Backup Data</td>
</tr>
<tr>
<td>Days Between</td>
</tr>
<tr>
<td>Backup Now</td>
</tr>
<tr>
<td>Export Last Backup</td>
</tr>
</tbody>
</table>

| Restore Data | | |

Calibrate/Cleaning menu

To display: At the product control panel, press the Home button, select the **Device Maintenance** menu, and then select the **Calibrate/Cleaning** menu.

In the following table, asterisks (*) indicate the factory default setting.

<table>
<thead>
<tr>
<th>Table 2-16 Calibrate/Cleaning menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First level</strong></td>
</tr>
<tr>
<td>Cleaning Settings</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Cleaning Interval</td>
</tr>
<tr>
<td>Cleaning Size</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

| Print Cleaning Page | |

32 Chapter 2  Control panel menus
**USB Firmware Upgrade menu**

**To display:** At the product control panel, press the Home button, select the **Device Maintenance** menu, and then select the **USB Firmware Upgrade** menu.

Insert a USB storage device with a firmware upgrade bundle into the USB port, and follow the on-screen instructions.

**Service menu**

**To display:** At the product control panel, press the Home button, select the **Device Maintenance** menu, and then select the **Service** menu.

The **Service** menu is locked and requires a PIN for access. This menu is intended for use by authorized service personnel.
3 Software for Windows

- Supported operating systems and printer drivers for Windows
- Select the correct printer driver for Windows
- Change print job settings for Windows
- Remove the printer driver from Windows
- Supported utilities for Windows
- Software for other operating systems
Supported operating systems and printer drivers for Windows

The product supports the following Windows operating systems:

- Windows XP (32-bit and 64-bit)
- Windows Server 2008 (32-bit and 64-bit)
- Windows Vista (32-bit and 64-bit)
- Windows 7 (32-bit and 64-bit)

The installation program on the software CD that came with the product supports the following Windows operating systems:

- Windows XP Service Pack 2 or greater (32-bit)
- Windows Server 2008 (32-bit and 64-bit)
- Windows Server 2008 R2 (64-bit)
- Windows Vista (32-bit and 64-bit)
- Windows 7, including Starter Edition (32-bit and 64-bit)

NOTE: You also can install the product software on 64-bit Windows XP and 64-bit Windows Server 2003 operating systems by using the Windows Add Printer feature.

The product supports the following Windows printer drivers:

- HP PCL 6 (this is the default printer driver)
- HP postscript emulation Universal Print Driver (HP UPD PS)
- HP PCL 5 Universal Print Driver (HP UPD PCL 5)
- HP PCL 6 Universal Print Driver (HP UPD PCL 6)

The printer drivers include online Help that has instructions for common printing tasks and also describes the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: For more information about the UPD, see www.hp.com/go/upd.
Select the correct printer driver for Windows

Printer drivers provide access to the product features and allow the computer to communicate with the product (using a printer language). The following printer drivers are available at www.hp.com/go/lj600Series_software.

<table>
<thead>
<tr>
<th>Printer Driver</th>
<th>Description</th>
</tr>
</thead>
</table>
| **HP PCL 6 driver** | - Provided as the default driver. This driver is automatically installed unless you select a different one.  
  - Recommended for all Windows environments  
  - Provides the overall best speed, print quality, and product-feature support for most users  
  - Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments  
  - Might not be fully compatible with third-party and custom software programs that are based on PCL 5 |
| **HP UPD PS driver** | - Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs  
  - Provides support for printing from postscript emulation needs, or for postscript flash font support |
| **HP UPD PCL 5** | - Recommended for general office printing in Windows environments  
  - Compatible with previous PCL versions and older HP LaserJet products  
  - The best choice for printing from third-party or custom software programs  
  - The best choice when operating with mixed environments, which require the product to be set to PCL 5 (UNIX, Linux, mainframe)  
  - Designed for use in corporate Windows environments to provide a single driver for use with multiple printer models  
  - Preferred when printing to multiple printer models from a mobile Windows computer |
| **HP UPD PCL 6** | - Recommended for printing in all Windows environments  
  - Provides the overall best speed, print quality, and printer feature support for most users  
  - Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows environments  
  - Might not be fully compatible with third-party and custom software programs that are based on PCL 5 |

**HP Universal Print Driver (UPD)**

The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
proven HP print driver technology and has been tested thoroughly and used with many software programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then customizes the user interface to show the product’s unique, available features. It automatically enables features that are available for the product, such as two-sided printing and stapling, so you do not need to enable them manually.

For more information, go to www.hp.com/go/upd.

<table>
<thead>
<tr>
<th>UPD installation modes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Traditional mode</strong></td>
</tr>
<tr>
<td>● Use this mode if you are installing the driver from a CD for a single computer.</td>
</tr>
<tr>
<td>● When installed from the CD that comes with the product, UPD operates like traditional printer drivers. It operates with a specific product.</td>
</tr>
<tr>
<td>● If you use this mode, you must install UPD separately for each computer and for each product.</td>
</tr>
<tr>
<td><strong>Dynamic mode</strong></td>
</tr>
<tr>
<td>● To use this mode, download UPD from the Internet. See <a href="http://www.hp.com/go/upd">www.hp.com/go/upd</a>.</td>
</tr>
<tr>
<td>● Dynamic mode allows you to use a single driver installation, so you can discover and print to HP products in any location.</td>
</tr>
<tr>
<td>● Use this mode if you are installing UPD for a workgroup.</td>
</tr>
</tbody>
</table>
Change print job settings for Windows

Priority for print settings

Changes to print settings are prioritized depending on where the changes are made:

**NOTE:** The names of commands and dialog boxes might vary depending on your software program.

- **Page Setup dialog box:** Click *Page Setup* or a similar command on the *File* menu of the program you are working in to open this dialog box. Settings changed here override settings changed anywhere else.

- **Print dialog box:** Click *Print*, *Print Setup*, or a similar command on the *File* menu of the program you are working in to open this dialog box. Settings changed in the *Print* dialog box have a lower priority and usually do not override changes made in the *Page Setup* dialog box.

- **Printer Properties dialog box (printer driver):** Click *Properties* in the *Print* dialog box to open the printer driver. Settings changed in the *Printer Properties* dialog box usually do not override settings anywhere else in the printing software. You can change most of the print settings here.

- **Default printer driver settings:** The default printer driver settings determine the settings used in all print jobs, unless settings are changed in the *Page Setup*, *Print*, or *Printer Properties* dialog boxes.

- **Printer control panel settings:** Settings changed at the printer control panel have a lower priority than changes made anywhere else.

Change the settings for all print jobs until the software program is closed

1. On the *File* menu in the software program, click *Print*.
2. Select the driver, and then click *Properties* or *Preferences*.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):** Click *Start*, and then click *Printers and Faxes*.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view): Click *Start*, click *Settings*, and then click *Printers*.

Windows Vista: Click *Start*, click *Control Panel*, and then in the category for *Hardware and Sound* click *Printer*.

Windows 7: Click *Start*, and then click *Devices and Printers*.

2. Right-click the driver icon, and then select *Printing Preferences*.
Change the product configuration settings

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):** Click **Start**, and then click **Printers and Faxes**.

   **Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view):** Click **Start**, click **Settings**, and then click **Printers**.

   **Windows Vista:** Click **Start**, click **Control Panel**, and then in the category for **Hardware and Sound** click **Printer**.

   **Windows 7:** Click **Start**, and then click **Devices and Printers**.

2. Right-click the driver icon, and then select **Properties** or **Printer properties**.

3. Click the **Device Settings** tab.
Remove the printer driver from Windows

Windows XP
1. Click **Start**, **Control Panel**, and then **Add or Remove Programs**.
2. Find and select the product from the list.
3. Click the **Change/Remove** button to remove the software.

Windows Vista
1. Click **Start**, **Control Panel**, and then **Programs and Features**.
2. Find and select the product from the list.
3. Select the **Uninstall/Change** option.

Windows 7
1. Click **Start**, **Control Panel**, and then under the **Programs** heading, click **Uninstall a program**.
2. Find and select the product from the list.
3. Select the **Uninstall** option.
Supported utilities for Windows

HP Web Jetadmin

HP Web Jetadmin is a simple print and imaging peripheral management software tool that helps optimize product use, control color costs, secure products, and streamline supplies management by enabling remote configuration, proactive monitoring, security troubleshooting, and reporting of printing and imaging products.

To download a current version of HP Web Jetadmin and for the latest list of supported host systems, visit www.hp.com/go/webjetadmin.

When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a supported Web browser (such as Microsoft® Internet Explorer) by navigating to the HP Web Jetadmin host.

HP Embedded Web Server

The product is equipped with the HP Embedded Web Server, which provides access to information about product and network activities. This information appears in a Web browser, such as Microsoft Internet Explorer, Netscape Navigator, Apple Safari, or Mozilla Firefox.

The HP Embedded Web Server resides on the product. It is not loaded on a network server.

The HP Embedded Web Server provides an interface to the product that anyone who has a network-connected computer and a standard Web browser can use. No special software is installed or configured, but you must have a supported Web browser on your computer. To gain access to the HP Embedded Web Server, type the IP address for the product in the address line of the browser. (To find the IP address, print a configuration page. For more information about printing a configuration page, see Print information pages on page 146).

For a complete explanation of the features and functionality of the HP Embedded Web Server, see Use the HP Embedded Web Server on page 147.

HP ePrint

With HP ePrint, you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile device. HP ePrint works with any email-capable device. If you can e-mail, you can print to an HP ePrint-enabled product. For more details, go to www.hpeprintcenter.com.

NOTE: The product must be connected to a network and have Internet access to use HP ePrint.

HP ePrint is disabled as a default setting in the product. Use this procedure to enable it.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded Web Server.

2. Click the Web Services tab.

3. Select the option to enable Web Services.
# Software for other operating systems

<table>
<thead>
<tr>
<th>OS</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIX</td>
<td>For HP-UX and Solaris networks, go to <a href="http://www.hp.com/go/jetdirectunix_software">www.hp.com/go/jetdirectunix_software</a> to install model scripts using the HP Jetdirect printer installer (HPPI) for UNIX. For the latest model scripts, go to <a href="http://www.hp.com/go/unixmodelscripts">www.hp.com/go/unixmodelscripts</a>.</td>
</tr>
<tr>
<td>Linux</td>
<td>For information, go to <a href="http://www.hplip.net">www.hplip.net</a>.</td>
</tr>
<tr>
<td></td>
<td>For information, go to <a href="http://www.hp.com/go/sap/print">www.hp.com/go/sap/print</a>.</td>
</tr>
</tbody>
</table>
4 Use the product with Mac

- Software for Mac
- Basic print tasks with Mac
- Solve problems with a Mac
Software for Mac

Supported operating systems and printer drivers for Mac

The product supports the following Mac operating systems:

- Mac OS X 10.5 and 10.6

**NOTE:** For Mac OS X 10.5 and later, PPC and Intel® Core™ Processor Macs are supported. For Mac OS X 10.6, Intel Core Processor Macs are supported.

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs), and the HP Utility for use with Mac OS X computers. The HP printer PPD and PDE files, in combination with the built-in Apple PostScript printer drivers, provide full printing functionality and access to specific HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Install the software from the CD. Click the product icon, and follow the onscreen instructions. If you did not add a printer during the CD install process, continue with the next step.

3. At the computer, open the Apple menu , click the **System Preferences** menu, and then click the **Print & Fax** icon.

4. Click the plus (+) symbol in the lower left corner of the **Printer Names** column, select the product from the **Add Printer** window, and then make sure that the product driver is listed in the **Print Using** area.
5. Click **Add** to create the printer queue.

**NOTE:** For Mac OS X 10.5 and 10.6, the installation procedure should automatically configure the installed options.

6. Print a page from any program to make sure that the software is correctly installed.

**NOTE:** If the installation failed, reinstall the software.

### Install software for Mac computers on a wired network

#### Configure the IP address

1. Connect the network cable to the product and to the network.

![Network cable connected](image)

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns an IP address or host name for the product.

3. At the product control panel, press the Home button.

4. Open the following menus:
   - Administration
   - Reports
   - Configuration/Status Pages
   - Configuration Page
5. Find the IP address on the Embedded Jetdirect page.

6. **IPv4**: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure the IP address. Otherwise, the network configuration was successful.

   **IPv6**: If the IP address begins with “fe80:”, the product should be able to print. If not, you must manually configure the IP address.

**Install the software**

1. Install the software from the CD. Click the product icon, and follow the onscreen instructions. If you did not add a printer during the CD install process, continue with the next step.

2. At the computer, open the Apple menu  
   , click the System Preferences menu, and then click the Print & Fax icon.

3. Click the plus (+) symbol in the lower left corner of the Printer Names column.

   By default, Mac OS X uses the Bonjour method to find the driver and add the product to the printer pop-up menu. This method is best in most situations. If Mac OS X cannot find the HP printer driver, an error message displays. Reinstall the software.

   If you are connecting the product to a large network, you might need to use IP printing to connect rather than Bonjour. Follow these steps:
   
   a. From the Add Printer window, click the IP Printer button.
   
   b. From the Protocol drop-down list, select the HP Jetdirect-Socket option. Enter the IP address or host name for the product. From the Print Using drop-down list, select the product model if one is not already selected.

4. Print a page from any program to make sure that the software is correctly installed.
Remove the printer driver from Mac operating systems

You must have administrator rights to remove the software.

1. Open **System Preferences**.
2. Select **Print & Fax**.
3. Highlight the product.
4. Click the minus (-) symbol.
5. Delete the print queue, if necessary.
Priority for print settings for Mac

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

- **Page Setup dialog box**: Click Page Setup or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed here might override settings changed anywhere else.

- **Print dialog box**: Click Print, Print Setup, or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed in the Print dialog box have a lower priority and do not override changes made in the Page Setup dialog box.

- **Default printer driver settings**: The default printer driver settings determine the settings used in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog boxes.

- **Printer control panel settings**: Settings changed at the printer control panel have a lower priority than changes made anywhere else.

Change printer-driver settings for Mac

**Change the settings for all print jobs until the software program is closed**

1. On the File menu, click the Print button.
2. Change the settings that you want on the various menus.

**Change the default settings for all print jobs**

1. On the File menu, click the Print button.
2. Change the settings that you want on the various menus.
3. On the Presets menu, click the Save As... option and type a name for the preset.

These settings are saved in the Presets menu. To use the new settings, you must select the saved preset option every time you open a program and print.

**Change the product configuration settings**

1. From the Apple menu, click the System Preferences menu and then click the Print & Fax icon.
2. Select the product in the left side of the window.
3. Click the Options & Supplies button.
4. Click the Driver tab.
5. Configure the installed options.
Software for Mac computers

HP Utility for Mac

Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected to a TCP/IP-based network.

Open the HP Printer Utility

▲ From the dock, click HP Utility.

-or-

From Applications, click Hewlett Packard, and then click HP Utility.

HP Utility features

The HP Utility consists of pages that you open by clicking in the Configuration Settings list. The following table describes the tasks that you can perform from these pages. At the top of any page, click the HP Support link to access technical assistance, online supplies ordering, online registration, and recycling and return information.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information And Support</td>
<td>Supplies Status</td>
<td>Shows the product supplies status and provides links for online supplies-ordering.</td>
</tr>
<tr>
<td></td>
<td>Device Information</td>
<td>Shows information about the currently selected product.</td>
</tr>
<tr>
<td></td>
<td>File Upload</td>
<td>Transfers files from the computer to the product.</td>
</tr>
<tr>
<td></td>
<td>Upload Fonts</td>
<td>Transfers font files from the computer to the product.</td>
</tr>
<tr>
<td></td>
<td>Update Firmware</td>
<td>Transfers a firmware update file to the product.</td>
</tr>
<tr>
<td></td>
<td>Commands</td>
<td>Sends special characters or print commands to the product after the print job.</td>
</tr>
<tr>
<td>Printer Settings</td>
<td>Trays Configuration</td>
<td>Changes the default tray settings.</td>
</tr>
<tr>
<td></td>
<td>Economode &amp; Toner</td>
<td>Changes toner density to use toner more economically</td>
</tr>
<tr>
<td></td>
<td>Density</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolution</td>
<td>Sets the default print resolution for the product</td>
</tr>
<tr>
<td></td>
<td>Output Devices</td>
<td>Manages settings for the optional output accessories</td>
</tr>
<tr>
<td></td>
<td>Duplex Mode</td>
<td>Turns on the automatic two-sided printing mode.</td>
</tr>
<tr>
<td></td>
<td>Stored Jobs</td>
<td>Manages print jobs that are stored on the product hard disk.</td>
</tr>
<tr>
<td></td>
<td>E-mail Alerts</td>
<td>Configures the product to send e-mail notices for certain events.</td>
</tr>
<tr>
<td></td>
<td>Network Settings</td>
<td>Configures the network settings, such as the IPv4 and IPv6 settings.</td>
</tr>
<tr>
<td></td>
<td>Supplies Management</td>
<td>Configures how the product should behave when supplies are nearing the end of their estimated life.</td>
</tr>
<tr>
<td>Menu</td>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Protect Direct Ports</td>
<td>Disables printing over USB or parallel ports.</td>
</tr>
<tr>
<td></td>
<td>Additional Settings</td>
<td>Provides access to the HP Embedded Web Server.</td>
</tr>
</tbody>
</table>

**Supported utilities for Mac**

**HP Embedded Web Server**

The product is equipped with the HP Embedded Web server, which provides access to information about product and network activities. Access the HP Embedded Web Server from the HP Utility. Open the **Printer Settings** menu, and then select the **Additional Settings** option.

You can also access the HP Embedded Web Server from the Safari Web browser:

1. Select the page icon in the left side of the Safari toolbar.
2. Click the Bonjour logo.
3. In the list of printers, double-click this product. The HP Embedded Web Server opens.

**HP ePrint**

With HP ePrint, you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile device. HP ePrint works with any email-capable device. If you can e-mail, you can print to an HP ePrint-enabled product. For more details, go to [www.hpeprintcenter.com](http://www.hpeprintcenter.com).

**NOTE:** The product must be connected to a network and have Internet access to use HP ePrint.

HP ePrint is disabled as a default setting in the product. Use this procedure to enable it.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded Web Server.
2. Click the **Web Services** tab.
3. Select the option to enable Web Services.

**AirPrint**

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in the following applications:

- Mail
- Photos
- Safari
- Select third-party applications
To use AirPrint, the product must be connected to a network. For more information about using AirPrint and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

NOTE: You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/go/lj600Series_firmware.
Basic print tasks with Mac

Cancel a print job with Mac

1. If the print job is currently printing, cancel it by following this procedure:
   a. Press the Stop button on the product control panel.
   b. The product prompts you to confirm the deletion. Press the OK button.
2. You can also cancel a print job from a software program or a print queue.
   - **Software program:** Typically, a dialog box appears briefly on the computer screen, allowing you to cancel the print job.
   - **Mac print queue:** Open the print queue by double-clicking the product icon in the Dock. Highlight the print job, and then click the Delete button.

Change the paper size and type with Mac

1. On the **File** menu in the software program, click the Print option.
2. In the **Copies & Pages** menu, click the Page Setup button.
3. Select a size from the Paper Size drop-down list, and then click the OK button.
4. Open the **Finishing** menu.
5. Select a type from the Media-type drop-down list.
6. Click the Print button.

Resize documents or print on a custom paper size with Mac

<table>
<thead>
<tr>
<th>Mac OS X 10.5 and 10.6</th>
<th>1. On the <strong>File</strong> menu, click the Print option.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Click the <strong>Page Setup</strong> button.</td>
</tr>
<tr>
<td></td>
<td>3. Select the product, and then select the correct settings for the Paper Size and Orientation options.</td>
</tr>
</tbody>
</table>

1. On the **File** menu, click the **Print** option.
2. Open the **Paper Handling** menu.
3. In the **Destination Paper Size** area, click the Scale to fit paper size box, and then select the size from the drop-down list.

Create and use printing presets with Mac

Use printing presets to save the current printer driver settings for reuse.
Create a printing preset

1. On the File menu, click the Print option.
2. Select the driver.
3. Select the print settings that you want to save for reuse.
4. In the Presets menu, click the Save As... option, and type a name for the preset.
5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.
2. Select the driver.
3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Print a cover page with Mac

1. On the File menu, click the Print option.
2. Select the driver.
3. Open the Cover Page menu, and then select where to print the cover page. Click either the Before Document button or the After Document button.
4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type menu.

Use watermarks with Mac

1. On the File menu, click the Print option.
2. Open the Watermarks menu.
3. From the Mode menu, select the type of watermark to use. Select the Watermark option to print a semi-transparent message. Select the Overlay option to print a message that is not transparent.
4. From the Pages menu, select whether to print the watermark on all pages or on the first page only.
5. From the Text menu, select one of the standard messages, or select the Custom option and type a new message in the box.
6. Select options for the remaining settings.
Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.
2. Select the driver.
3. Open the Layout menu.
4. From the Pages per Sheet menu, select the number of pages that you want to print on each sheet (1, 2, 4, 6, 9, or 16).
5. In the Layout Direction area, select the order and placement of the pages on the sheet.
6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing) with Mac

1. Insert enough paper into one of the trays to accommodate the print job.
2. On the File menu, click the Print option.
3. Open the Layout menu.
4. From the Two-Sided menu, select a binding option.

Store jobs with Mac

You can store jobs on the product so you can print them at any time. You can share stored jobs with other users, or you can make them private.

1. On the File menu, click the Print option.
2. Open the Job Storage menu.
3. In the **Job Storage Mode** drop-down list, select the type of stored job.

- **Proof and Hold**: This feature provides a quick way to print and proof one copy of a job and then print more copies.

- **Personal Job**: When you send a job to the product, the job does not print until you request it at the product control panel. If you assign a personal identification number (PIN) to the job, you must provide the required PIN at the control panel.

- **Quick Copy**: If the optional hard disk is installed on the product, you can print the requested number of copies of a job and then store a copy of the job on the optional hard disk. Storing the job allows you to print additional copies of the job later.

- **Stored Job**: If the optional hard disk is installed on the product, you can store a job such as a personnel form, time sheet, or calendar on the product and allow other users to print the job at any time. Stored jobs also can be protected by a PIN.

4. To use a custom user name or job name, click the **Custom** button, and then enter the user name or the job name.

Select which option to use if another stored job already has that name.

<table>
<thead>
<tr>
<th>Use Job Name + (1 - 99)</th>
<th>Append a unique number to the end of the job name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace Existing File</td>
<td>Overwrite the existing stored job with the new one.</td>
</tr>
</tbody>
</table>

5. If you selected the **Stored Job** or **Personal Job** option in step 3, you can protect the job with a PIN. Type a 4-digit number in the **Use PIN to Print** field. When other people attempt to print this job, the product prompts them to enter this PIN number.
Solve problems with a Mac

See Solve product software problems with Mac on page 205.
5 Connect the product with Windows

- Printer sharing disclaimer
- Connect with USB
- Connect to a network with Windows
Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Connect with USB

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that is no longer than 2 m (6.5 ft).

⚠️ **CAUTION:** Do not connect the USB cable until the installation software prompts you to connect it.

CD installation

1. Quit all open programs on the computer.
2. Install the software from the CD, and follow the onscreen instructions.
3. When prompted, select the **Directly connect to this computer using USB cable** option, and then click the **Next** button.
4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the **Finish** button, or click the **More Options** button to install more software.
6. On the **More Options** screen, you can install more software, or click the **Exit** button.
7. Print a page from any program to make sure that the software is correctly installed.

⚠️ **NOTE:** If the installation failed, reinstall the software.
Connect to a network with Windows

You can configure network parameters from the control panel, the HP Embedded Web Server, or for most networks, from the HP Web Jetadmin software.

**NOTE:** HP Web Jetadmin software is not supported on Mac OS X operating systems.

For a complete list of supported networks and for instructions on configuring network parameters from software, see the *HP Jetdirect Embedded Print Server Administrator’s Guide*. The guide comes with products in which an HP Jetdirect embedded print server is installed.

**Supported network protocols**

**Table 5-1  Supported network protocols**

<table>
<thead>
<tr>
<th>Network type</th>
<th>Supported protocols</th>
</tr>
</thead>
</table>
| TCP/IP IPv4 and IPv6 networks | • Bonjour  
 • Simple Network Management Protocol (SNMP) v1, v2, and v3  
 • Hyper Text Transfer Protocol (HTTP)  
 • Secure HTTP (HTTPS)  
 • File Transfer Protocol (FTP)  
 • Port 9100  
 • Line printer daemon (LPD)  
 • Internet Printing Protocol (IPP)  
 • Secure IPP  
 • Web Services Dynamic Discovery (WS Discovery)  
 • IPsec/Firewall |
| TCP/IP IPv4 networks only | • Auto IP  
 • Service Location Protocol (SLP)  
 • Trivial File Transfer Protocol (TFTP)  
 • Telnet  
 • Internet Group Management Protocol (IGMP) v2  
 • Bootstrap Protocol (BOOTP)/DHCP  
 • Windows Internet Name Service (WINS)  
 • IP Direct Mode  
 • WS Print |
### Table 5-1  Supported network protocols (continued)

<table>
<thead>
<tr>
<th>Network type</th>
<th>Supported protocols</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP IPv6 networks only</td>
<td>• Dynamic Host Configuration Protocol (DHCP) v6</td>
</tr>
<tr>
<td></td>
<td>• Multicast Listener Discovery Protocol (MLD) v1</td>
</tr>
<tr>
<td></td>
<td>• Internet Control Message Protocol (ICMP) v6</td>
</tr>
<tr>
<td>Other supported network protocols</td>
<td>• AppleTalk</td>
</tr>
<tr>
<td></td>
<td>• iPrint</td>
</tr>
</tbody>
</table>

### Table 5-2  Advanced Security features for network management

<table>
<thead>
<tr>
<th>Service name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPsec/Firewall</td>
<td>Provides network-layer security on IPv4 and IPv6 networks. A firewall provides simple control of IP traffic. IPsec provides additional protection through authentication and encryption protocols.</td>
</tr>
<tr>
<td>Kerberos</td>
<td>Allows you to exchange private information across an open network by assigning a unique key, called a ticket, to each user who logs on to the network. The ticket is then embedded in messages to identify the sender.</td>
</tr>
<tr>
<td>SNMP v3</td>
<td>Employs a user-based security model for SNMP v3, which provides user authentication and data privacy through encryption.</td>
</tr>
<tr>
<td>SSL/TLS</td>
<td>Allows you to transmit private documents via the Internet and guarantee privacy and data integrity between the client and server applications.</td>
</tr>
<tr>
<td>IPsec batch configuration</td>
<td>Provides network-layer security through the simple control of IP traffic to and from the product. This protocol provides the benefits of encryption and authentication and allows for multiple configurations.</td>
</tr>
</tbody>
</table>
Install the product on a wired network with Windows

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns an IP address or host name for the product.

3. At the product control panel, press the Home button.

4. Open the following menus:
   - Administration
   - Reports
   - Configuration/Status Pages
   - Configuration Page
5. Find the IP address on the Embedded Jetdirect page.

6. **IPv4**: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure the IP address. Otherwise, the network configuration was successful.

   **IPv6**: If the IP address begins with “fe80:”, the product should be able to print. If not, you must manually configure the IP address.

**Install the software**

1. Quit all programs on the computer.
2. Install the software from the CD.
3. Follow the onscreen instructions.
4. When prompted, select the **Connect through a wired network** option.
5. From the list of available printers, select the printer that has the correct IP address.
6. At the end of the installation, click the **Finish** button, or click the **More Options** button to install more software.
7. Print a page from any program to make sure that the software is correctly installed.
Configure network settings with Windows

View or change network settings

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.
   - If you are using IPv4, the IP address contains only digits. It has this format:
     \[ xxx.xxx.xxx.xxx \]
   - If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. It has a format similar to this:
     \[ xxxx::xxxx::xxxx::xxxx::xxxx \]

2. To open the embedded Web server, type the IP address into the address line of a Web browser.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Set or change the network password

Use the embedded Web server to set a network password or change an existing password.

1. Open the embedded Web server, click the Networking tab, and click the Security link.

   **NOTE:** If a password has previously been set, you are prompted to type the password. Type the password, and then click the Apply button.

2. Type the new password in the New Password box and in the Verify password box.

3. At the bottom of the window, click the Apply button to save the password.
Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel **Administration** menus to manually set an IPv4 address, subnet mask, and default gateway.

1. At the control panel, press the Home button.

2. Open each of the following menus:
   a. **Administration**
   b. **Network Settings**
   c. **Jetdirect Menu**
   d. **TCP/IP**
   e. **IPV4 Settings**
   f. **Config Method**
   g. **Manual**
   h. **Manual Settings**
   i. **IP Address, Subnet Mask, or Default Gateway**

3. Use the numeric keypad, or press the up arrow ▲ or the down arrow ▼ to increase or decrease the number for the first byte of the IP address, subnet mask, or default gateway.

4. Press the **OK** button to move to the next set of numbers. To move to the previous set of numbers, press the back arrow ◀.

5. Repeat steps 3 and 4 until the IP address, subnet mask, or default gateway is complete, and then press the **OK** button to save the setting.
Manually configure IPv6 TCP/IP parameters from the control panel

Use the control-panel Administration menus to manually set an IPv6 address.

1. At the control panel, press the Home button.

2. To enable manual configuration, open each of the following menus:
   a. Administration
   b. Network Settings
   c. Jetdirect Menu
   d. TCP/IP
   e. IPV6 Settings
   f. Address
   g. Manual Settings
   h. Enable

   Select the On option, and then press the OK button.

3. To configure the address, open each of the following menus:
   - Administration
   - Network Settings
   - Jetdirect Menu
   - TCP/IP
   - IPV6 Settings
   - Address

   Use the numeric keypad, or press the up arrow ▲ or the down arrow ▼ to enter the address. Press the OK button.

**NOTE:** If you are using the arrow buttons, you must press the OK button after entering each digit.
Link speed and duplex settings

The link speed and communication mode of the print server must match the network. For most situations, leave the product in **Auto** mode. Incorrect changes to the link speed and duplex settings might prevent the product from communicating with other network devices. If you need to make changes, use the product control panel.

**NOTE:** Making changes to these settings causes the product to turn off and then on. Make changes only when the product is idle.

1. At the control panel, press the **Home** button.
2. Open each of the following menus:
   a. **Administration**
   b. **Network Settings**
   c. **Jetdirect Menu**
   d. **Link Speed**
3. Select one of the following options.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto</strong></td>
<td>The print server automatically configures itself for the highest link speed and communication mode allowed on the network.</td>
</tr>
<tr>
<td><strong>10T Half</strong></td>
<td>10 megabytes per second (Mbps), half-duplex operation</td>
</tr>
<tr>
<td><strong>10T Full</strong></td>
<td>10 Mbps, full-duplex operation</td>
</tr>
<tr>
<td><strong>100TX Half</strong></td>
<td>100 Mbps, half-duplex operation</td>
</tr>
<tr>
<td><strong>100TX Full</strong></td>
<td>100 Mbps, full-duplex operation</td>
</tr>
<tr>
<td><strong>100TX Auto</strong></td>
<td>Limits auto-negotiation to a maximum link speed of 100 Mbps</td>
</tr>
<tr>
<td><strong>1000T Full</strong></td>
<td>1000 Mbps, full-duplex operation</td>
</tr>
</tbody>
</table>
4. Press the **OK** button. The product turns off and then on.
6 Paper and print media

- Understand paper use
- Change the printer driver to match the paper type and size in Windows
- Supported paper sizes
- Supported paper types
- Tray and bin capacity
- Load paper trays
- Configure trays
- Select an output bin
Understand paper use

This product supports a variety of paper and other print media in accordance with the guidelines in this user guide. Paper or print media that does not meet these guidelines might cause poor print quality, increased jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend the use of other brands of media because HP cannot control their quality.

Store paper in the original package to prevent exposing the paper to moisture and other damage. Do not open the package until you are ready to use the paper.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory results. This might be the result of improper handling, unacceptable temperature and/or humidity levels, or other variables over which Hewlett-Packard has no control.

**CAUTION:** Using paper or print media that does not meet Hewlett-Packard’s specifications might cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard warranty or service agreements.

Special paper guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory results. When using special paper or print media, be sure to set the type and size in the printer driver to obtain the best results.

**CAUTION:** HP LaserJet products use fusers to bond dry toner particles to the paper in very precise dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the product.

<table>
<thead>
<tr>
<th>Media type</th>
<th>Do</th>
<th>Do not</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelopes</td>
<td>• Store envelopes flat.</td>
<td>• Do not use envelopes that are wrinkled, nicked, stuck together, or otherwise damaged.</td>
</tr>
<tr>
<td></td>
<td>• Use envelopes where the seam extends all the way to the corner of the envelope.</td>
<td>• Do not use envelopes that have clasps, snaps, windows, or coated linings.</td>
</tr>
<tr>
<td></td>
<td>• Use peel-off adhesive strips that are approved for use in laser printers.</td>
<td>• Do not use self-stick adhesives or other synthetic materials.</td>
</tr>
<tr>
<td>Labels</td>
<td>• Use only labels that have no exposed backing between them.</td>
<td>• Do not use labels that have wrinkles or bubbles, or are damaged.</td>
</tr>
<tr>
<td></td>
<td>• Use labels that lie flat.</td>
<td>• Do not print partial sheets of labels.</td>
</tr>
<tr>
<td></td>
<td>• Use only full sheets of labels.</td>
<td></td>
</tr>
<tr>
<td>Media type</td>
<td>Do</td>
<td>Do not</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transparencies</td>
<td>- Use only transparencies that are approved for use in laser printers.</td>
<td>- Do not use transparent print media not approved for laser printers.</td>
</tr>
<tr>
<td></td>
<td>- Place transparencies on a flat surface after removing them from the product.</td>
<td></td>
</tr>
<tr>
<td>Letterhead or preprinted forms</td>
<td>- Use only letterhead or forms approved for use in laser printers.</td>
<td>- Do not use raised or metallic letterhead.</td>
</tr>
<tr>
<td>Heavy paper</td>
<td>- Use only heavy paper that is approved for use in laser printers and meets the weight specifications for this product.</td>
<td>- Do not use paper that is heavier than the recommended media specification for this product unless it is HP paper that has been approved for use in this product.</td>
</tr>
<tr>
<td>Glossy or coated paper</td>
<td>- Use only glossy or coated paper that is approved for use in laser printers.</td>
<td>- Do not use glossy or coated paper designed for use in inkjet products.</td>
</tr>
<tr>
<td></td>
<td>- Use coated paper in the temperature and humidity range for this product.</td>
<td>- Do not use coated paper in extremely high or low humidity environments.</td>
</tr>
<tr>
<td>All paper types</td>
<td>- Store paper in the original packaging.</td>
<td>- Do not use paper that is curled.</td>
</tr>
<tr>
<td></td>
<td>- Store paper in a dust-free area.</td>
<td>- Do not use paper that has been stored in a humid environment.</td>
</tr>
</tbody>
</table>
Change the printer driver to match the paper type and size in Windows

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Select a size from the **Paper size** drop-down list.
5. Select a paper type from the **Paper type** drop-down list.
6. Click the **OK** button.
Supported paper sizes

This product supports a number of paper sizes, and it adapts to various media.

**NOTE:** To obtain best results, select the correct paper size and type in the printer driver before printing.

<table>
<thead>
<tr>
<th>Table 6-1 Supported paper and print media sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size and dimensions</strong></td>
</tr>
<tr>
<td>-------------------------</td>
</tr>
<tr>
<td>Letter</td>
</tr>
<tr>
<td>216 x 279 mm (8.5 x 11 in)</td>
</tr>
<tr>
<td>A4</td>
</tr>
<tr>
<td>210 x 297 mm (8.27 x 11.69 in)</td>
</tr>
<tr>
<td>Legal</td>
</tr>
<tr>
<td>216 x 356 mm (8.5 x 14 in)</td>
</tr>
<tr>
<td>Executive</td>
</tr>
<tr>
<td>184 x 267 mm (7.24 x 10.51 in)</td>
</tr>
<tr>
<td>A5</td>
</tr>
<tr>
<td>148 x 210 mm (5.83 x 8.27 in)</td>
</tr>
<tr>
<td>8.5 x 13</td>
</tr>
<tr>
<td>216 x 330 mm (8.5 x 13 in)</td>
</tr>
<tr>
<td>B5 (JIS)</td>
</tr>
<tr>
<td>182 x 257 mm (7.17 x 10.12 in)</td>
</tr>
<tr>
<td>Double Postcard (JIS)</td>
</tr>
<tr>
<td>148 x 200 mm (5.8 x 7.9 in)</td>
</tr>
<tr>
<td>16K</td>
</tr>
<tr>
<td>197 x 273 mm (7.8 x 10.8 in)</td>
</tr>
</tbody>
</table>
Table 6-1  Supported paper and print media sizes (continued)

<table>
<thead>
<tr>
<th>Size and dimensions</th>
<th>Tray 1</th>
<th>Tray 2 and the optional 500-sheet trays</th>
<th>Optional 1,500-sheet tray</th>
<th>Optional envelope feeder</th>
<th>Optional duplexer</th>
<th>Optional stacker and stapler/stacker</th>
<th>Optional 5-bin mailbox</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>76 x 127 mm to 216 x 356 mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(3.0 x 5.0 in to 8.5 x 14 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>148 x 210 mm to 216 x 356 mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(Stacker only)</td>
<td></td>
</tr>
<tr>
<td>(5.83 x 8.27 in to 8.5 x 14 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope Commercial #10</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>105 x 241 mm (4.13 x 9.49 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope DL ISO</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110 x 220 mm (4.33 x 8.66 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope C5 ISO</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>162 x 229 mm (6.37 x 9.01 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope B5 ISO</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>176 x 250 mm (6.92 x 9.84 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope Monarch #7-3/4</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>98 x 191 mm (3.9 x 7.5 in)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1 Custom sizes cannot be stapled, but they can be stacked in the output bins.
## Supported paper types

For a complete list of specific HP-brand paper that this product supports, go to [www.hp.com/support/lj600Series](http://www.hp.com/support/lj600Series).

### Supported paper types for input options

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Tray 1</th>
<th>Tray 2</th>
<th>Optional 500-sheet trays</th>
<th>Optional 1,500-sheet tray</th>
<th>Optional envelope feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Type</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Plain</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Light 60-74g</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Cardstock 176-220g</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Transparency</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Labels</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Letterhead</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Preprinted</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Prepunched</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Colored</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Rough</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Bond</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Recycled</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>HP EcoSMART Lite</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Envelope</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
</tr>
</tbody>
</table>
# Supported paper types for output options

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Standard top bin (face-down)</th>
<th>Rear bin (face-up)</th>
<th>Optional duplexer</th>
<th>Optional stacker or stapler/stacker</th>
<th>Optional 5-bin mailbox</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Type</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Plain</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Light 60-74g</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Cardstock 176-220g</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Transparency</td>
<td><img src="" alt=" " /></td>
<td></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Labels</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Letterhead</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Preprinted</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Prepunched</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Colored</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Rough</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Bond</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Recycled</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>HP EcoSMART Lite</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
<tr>
<td>Envelope</td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
<td><img src="" alt=" " /></td>
</tr>
</tbody>
</table>
# Tray and bin capacity

<table>
<thead>
<tr>
<th>Tray or bin</th>
<th>Paper type</th>
<th>Specifications</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tray 1</strong></td>
<td>Paper and cardstock</td>
<td>Range:</td>
<td>Maximum stack height: 10 mm (0.39 in) Equivalent to 100 sheets of 75 g/m² (20 lb bond)</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Less than 60 g/m² (16 lb bond) to 90 g/m² (24 lb bond)</td>
<td></td>
<td>Up to 10 envelopes</td>
</tr>
<tr>
<td>Labels</td>
<td>Maximum 0.23 mm (0.009 in) thick</td>
<td></td>
<td>Maximum stack height: 10 mm (0.39 in)</td>
</tr>
<tr>
<td>Transparencies</td>
<td>Minimum 0.13 mm (0.005 in) thick</td>
<td></td>
<td>Maximum stack height: 10 mm (0.39 in)</td>
</tr>
<tr>
<td><strong>Tray 2 and the optional 500-sheet trays</strong></td>
<td>Paper and cardstock</td>
<td>Range: 60 g/m² (16 lb bond) to 135 g/m² (36 lb bond)</td>
<td>Equivalent to 500 sheets of 75 g/m² (20 lb bond)</td>
</tr>
<tr>
<td>Labels</td>
<td>Maximum 0.13 mm (0.005 in) thick</td>
<td></td>
<td>Maximum stack height: 54 mm (2.1 in)</td>
</tr>
<tr>
<td>Transparencies</td>
<td>Minimum 0.13 mm (0.005 in) thick</td>
<td></td>
<td>Maximum stack height: 54 mm (2.1 in)</td>
</tr>
<tr>
<td><strong>Optional 1,500-sheet tray</strong></td>
<td>Paper</td>
<td>Range: 60 g/m² (16 lb bond) to 135 g/m² (36 lb bond)</td>
<td>Equivalent to 1,500 sheets of 75 g/m² (20 lb bond)</td>
</tr>
<tr>
<td><strong>Optional envelope feeder</strong></td>
<td>Envelopes</td>
<td>Less than 60 g/m² (16 lb bond) to 90 g/m² (24 lb bond)</td>
<td>Up to 75 envelopes</td>
</tr>
<tr>
<td><strong>Standard top bin</strong></td>
<td>Paper</td>
<td></td>
<td>Up to 500 sheets of 75 g/m² (20 lb bond)</td>
</tr>
<tr>
<td><strong>Rear bin</strong></td>
<td>Paper</td>
<td></td>
<td>Up to 100 sheets of 75 g/m² (20 lb bond)</td>
</tr>
<tr>
<td><strong>Optional duplexer</strong></td>
<td>Paper</td>
<td>Range: 60 g/m² (16 lb bond) to 120 g/m² (32 lb bond)</td>
<td></td>
</tr>
<tr>
<td><strong>Optional stacker</strong></td>
<td>Paper</td>
<td></td>
<td>Up to 500 sheets of 75 g/m² (20 lb bond)</td>
</tr>
<tr>
<td><strong>Optional stapler/stacker</strong></td>
<td>Paper</td>
<td></td>
<td>Stapling: Up to 20 print jobs of up to 15 pages each Stacking: Up to 500 sheets of 75 g/m² (20 lb bond)</td>
</tr>
<tr>
<td><strong>Optional 5-bin mailbox</strong></td>
<td>Paper</td>
<td></td>
<td>Up to 500 sheets of 75 g/m² (20 lb bond)</td>
</tr>
</tbody>
</table>
Load paper trays

Load Tray 1

**NOTE:** The product might print at a slower speed when using Tray 1.

**CAUTION:** To avoid jams, do not load trays while the product is printing. Do not fan the paper. Fanning can cause misfeeds.

1. Open Tray 1.

2. Pull out the tray extension.
3. Load the paper into the tray. Make sure that the paper fits under the tabs and below the maximum-height indicators.

4. Adjust the side guides so that they lightly touch the paper stack but do not bend the paper.

Load Tray 2 or an optional 500-sheet tray

⚠️ CAUTION: To avoid jams, do not load trays while the product is printing.

⚠️ CAUTION: Do not fan the paper. Fanning can cause misfeeds.

1. Pull the tray out and lift up slightly to remove it from the product.
2. Pinch the release lever that is located on the left guide and slide the side guides to the correct paper size.

3. Pinch the release lever that is located on the rear paper guide and slide it to the correct paper size.

4. Load the paper into the tray. Make sure that the stack is flat at all four corners and that the top of the stack is below the maximum-height indicators.

5. Slide the tray completely into the product.
Load an optional 1,500-sheet tray

The optional 1,500 sheet tray adjusts for Letter, A4, and Legal sizes. The product automatically senses which size is loaded if the tray guides are correctly adjusted.

⚠️ CAUTION: To avoid jams, do not load trays while the product is printing.

⚠️ CAUTION: Do not fan the paper. Fanning can cause misfeeds.

1. Press the release and open the door of the 1,500-sheet tray.

2. If paper is in the tray, remove it. When paper is in the tray, the guides cannot be adjusted.

3. Pinch the guides at the front of the tray and slide them to the correct paper size.
4. Load the paper into the tray. Load complete reams at one time. Do not divide reams into smaller sections.

5. Make sure that the height of the stack does not exceed the maximum-height indicators on the guides and that the front edge of the stack is aligned with the arrows.

6. Close the door on the tray.
Paper orientation for loading trays

Load letterhead, preprinted, or prepunched paper

If a duplexer is installed, or if a stapler/stacker is installed, the product alters the way the images for each page are arranged. If you are using paper that requires a specific orientation, load it according to the information in the following table.

<table>
<thead>
<tr>
<th>Tray</th>
<th>Single-sided printing, no stapler/stacker</th>
<th>Duplex printing, no stapler/stacker</th>
<th>Single-sided printing with the stapler/stacker</th>
<th>Duplex printing with the stapler/stacker</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1</td>
<td>Face-up</td>
<td>Face-down</td>
<td>Face-up</td>
<td>Face-down</td>
</tr>
<tr>
<td></td>
<td>Top edge leading into the product</td>
<td>Bottom edge leading into the product</td>
<td>Bottom edge leading into the product</td>
<td>Top edge leading into the product</td>
</tr>
<tr>
<td>All other trays</td>
<td>Face-down</td>
<td>Face-up</td>
<td>Face-down</td>
<td>Face-up</td>
</tr>
<tr>
<td></td>
<td>Top edge at the front of the tray</td>
<td>Bottom edge at the front of the tray</td>
<td>Bottom edge at the front of the tray</td>
<td>Top edge at the front of the tray</td>
</tr>
</tbody>
</table>
Load envelopes

Load envelopes into Tray 1 or the optional envelope feeder with the front of the envelope facing up, and the short, postage-edge leading into the product.
Configure trays

The product automatically prompts you to configure a tray for type and size in the following situations:

- When you load paper into the tray
- When you specify a particular tray or paper type for a print job through the printer driver or a software program and the tray is not configured to match the print-job’s settings

**NOTE:** The prompt does not appear if you are printing from Tray 1, and it is configured for the *Any Size* paper size and the *Any Type* paper type settings. In this situation, if the print job does not specify a tray, the product prints from Tray 1, even if the paper size and type settings in the print job do not match the paper loaded in Tray 1.

Configure a tray when loading paper

1. Load paper in the tray. Close the tray if you are using a tray other than Tray 1.
2. The tray configuration message appears.
3. Press the OK button to accept the detected size. Or, press the back arrow to choose a different configuration, and continue with the following steps.
4. To modify the tray configuration, press the down arrow to highlight the correct size, and then press the OK button.

**NOTE:** The product automatically detects most paper sizes in trays other than Tray 1.
5. Press the down arrow to highlight the correct type, and then press the OK button.

Configure a tray to match print job settings

1. In the software program, specify the source tray, the paper size, and the paper type.
2. Send the job to the product.
   
   If the tray needs to be configured, a prompt appears on the control-panel display.
3. If the displayed size is not correct, press the back arrow. Press the down arrow to highlight the correct size, or highlight the Custom option.
   
   To specify a custom size, first press the down arrow to highlight the correct unit of measure. Then set the X and Y dimensions by using the numeric keypad or by pressing the up arrow or the down arrow.
4. If the displayed paper type is not correct, press the back arrow, and then press the down arrow to highlight the paper type.
Configure a tray from the control panel

You can also configure the trays for type and size without a prompt from the product.

1. Press the Home button.

2. Open the **Trays** menu.

3. Press the down arrow \(\downarrow\) to highlight the size or type setting for the desired tray, and then press the **OK** button.

4. Press the up arrow \(\uparrow\) or the down arrow \(\downarrow\) to highlight the size or type. If you select a custom size, select the unit of measure, and then set the X dimension and the Y dimension.

5. Press the **OK** button to save your selection.
Select an output bin

The product has four output locations: the top (standard) output bin, the rear output bin, the optional stacker or stapler/stacker, and the optional 5-bin mailbox.

Print to the top (standard) output bin

The top output bin collects paper face-down, in the correct order. The top output bin should be used for most print jobs, including transparencies. To use the top output bin, be sure that the rear output bin is closed. To avoid jams, do not open or close the rear output bin while the product is printing.

Print to the rear output bin

The product always prints to the rear output bin if it is open. Paper that is printed to this bin will exit face-up, with the last page on top (reverse order).

Printing from Tray 1 to the rear output bin provides the straightest path. Opening the rear output bin might improve performance with the following items:

- Envelopes
- Labels
- Small custom-size paper
- Postcards
- Paper heavier than 120 g/m² (32 lb)

Opening the rear output bin makes the duplexer (if installed) and the top output bin unavailable. To avoid jams, do not open or close the rear output bin while the product is printing.
1. To open the rear output bin, grasp the handle at the top of the bin, and pull the bin down.

2. Slide out the extension.

Print to the optional stacker or stapler/stacker

The optional stacker or optional stapler/stacker can hold up to 500 sheets of paper (20-lb paper). The stacker accepts standard and custom paper sizes. The stapler/stacker accepts standard and custom paper sizes, but only Letter, Legal, and A4 sizes can be stapled. Do not try to send other types of print media, such as labels or envelopes.

**NOTE:** When a stapler/stacker is installed, the product automatically rotates the printed images 180° on all paper sizes, regardless of whether the job is stapled. Paper types that must be printed in the correct orientation, such as letterhead or prepunched paper, need to be loaded in a different direction.

To print to the optional stacker or optional stapler/stacker, select the option in the program, in the printer driver, or at the printer control panel.

Before you use the optional stacker or optional stapler/stacker, ensure that the printer driver is set to recognize it. You need to set this setting only once.
Windows


Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.

4. In the Installable Options area, set the Automatic Configuration item to Update Now.

Mac

1. From the Apple menu ⬇️, click the System Preferences menu and then click the Print & Fax icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.

Print to the 5-bin mailbox

The optional 5-bin mailbox provides five output bins that can be configured from the control panel to sort print jobs in a variety of ways.

1. Press the Home button.

2. Open the following menus:
   - Administration
   - Multi-Bin Mailbox Settings
   - Operation Mode

3. Press the down arrow ▼️ to highlight how the 5-bin mailbox sorts jobs:

<table>
<thead>
<tr>
<th>Mailbox</th>
<th>Each bin is assigned to a user or group of users. This is the default setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stacker</td>
<td>The product uses all of the bins to stack copies of a job. Jobs are sent to the bottom bin first, and then to the next highest bin, and so forth. When all bins are full, the product stops.</td>
</tr>
</tbody>
</table>
**Job Separator**  Each print job is sent to a different bin. Jobs are sent to an empty bin, starting with the top bin and continuing to the bottom bin.

**Collator**  The product sorts copies of a single print job into separate bins.

4. Press the OK button to select the option.
7 Print cartridges

The information contained herein is subject to change without notice. For the latest User Guide information go to www.hp.com/support/lj600Series_manuals.

- Print cartridge information
- Supplies views
- Manage print cartridges
- Replacement instructions
- Solve problems with print cartridges
# Print cartridge information

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part numbers</td>
<td>• Standard-capacity print cartridge: CE390A</td>
</tr>
<tr>
<td></td>
<td>• High-capacity print cartridge: CE390X</td>
</tr>
<tr>
<td>Accessibility</td>
<td>• The print cartridge can be installed and removed by using one hand.</td>
</tr>
<tr>
<td>Environmental features</td>
<td>• Recycle print cartridges by using the HP Planet Partners return and recycling program.</td>
</tr>
</tbody>
</table>

For more information about supplies, go to [www.hp.com/go/learnaboutsupplies](http://www.hp.com/go/learnaboutsupplies).
Supplies views

Print cartridge views

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Print cartridge memory chip</td>
</tr>
<tr>
<td>2</td>
<td>Plastic shield</td>
</tr>
<tr>
<td>3</td>
<td>Sealing tape</td>
</tr>
</tbody>
</table>
Manage print cartridges

Correctly using, storing, and monitoring the print cartridge can help ensure high-quality print output.

Change settings for print cartridges

Print when a print cartridge is at estimated end of life

- **Black cartridge low** message: The product indicates when a supply level is low. Actual print cartridge life remaining may vary. Consider having a replacement available to install when print quality is no longer acceptable. The supply does not need to be replaced now.

- **Black cartridge very low** message: The product indicates when a supply level is very low. Actual supply life remaining may vary. Consider having a replacement available to install when print quality is no longer acceptable. The supply does not need to be replaced now unless the print quality is no longer acceptable. Print-quality problems may occur when using a supply that is at its estimated end of life.

Once an HP print cartridge has reached “Very Low”, HP’s Premium Protection Warranty on that print cartridge has ended. HP’s Premium Protection Warranty applies only to the print cartridge for this product.

Enable or disable the Very Low Settings options from the control panel

You can enable or disable the default settings at any time, and you do not have to re-enable them when you install a new cartridge.

1. At the product control panel, press the Home button.
2. Open the following menus:
   - Administration
   - Manage Supplies
   - Supply Settings
   - Black Cartridge
   - Very Low Settings
3. Select one of the following options:
   - Select the **Continue** option to set the product to alert you that the cartridge is very low, but to continue printing.
     
     **NOTE:** Using the **Continue** setting allows printing beyond Very Low without customer interaction and can result in unsatisfactory print quality.

   - Select the **Stop** option to set the product to stop printing until you replace the cartridge.
   - Select the **Prompt to continue** option to set the product to stop printing and prompt you to replace the cartridge. You can acknowledge the prompt and continue printing.
If you select the **Stop** or **Prompt to continue** option, the product stops printing when it reaches the Very Low threshold. When you replace the cartridge, the product automatically resumes printing.

**Print with EconoMode**

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner and decrease the cost per page. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the print cartridge.

**NOTE:** This feature is available with the PCL 6 printer driver for Windows. If you are not using that driver, you can enable the feature by using the HP Embedded Web Server.

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Click the **EconoMode** check box.

**Store and recycle supplies**

**Recycle supplies**

To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new cartridge arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete information, see the recycling guide that is included with each new HP supply item.

**Print-cartridge storage**

Do not remove the print cartridge from its package until you are ready to use it.

**CAUTION:** To prevent damage to the print cartridge, do not expose it to light for more than a few minutes.

**HP policy on non-HP print cartridges**

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or remanufactured.

**NOTE:** Any damage caused by a non-HP print cartridge is not covered under the HP warranty and service agreements.

**HP anticounterfeit Web site**

Go to [www.hp.com/go/anticounterfeit](http://www.hp.com/go/anticounterfeit) when you install an HP print cartridge and the control-panel message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.
Your print cartridge might not be a genuine HP print cartridge if you notice the following:

- The supplies status page indicates that a non-HP supply is installed.
- You are experiencing a high number of problems with the print cartridge.
- The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).
Replacement instructions

Replace the print cartridge

1. Open the top cover.

2. Remove the used print cartridge from the product.

3. Remove the new print cartridge from the bag. Place the used print cartridge in the bag for recycling.
4. Grasp both sides of the print cartridge and distribute the toner by gently rocking the print cartridge.

   **CAUTION:** Do not touch the shutter or the surface of the roller.

5. Remove the shipping lock and the shipping tape from the new print cartridge. Discard the lock and tape according to local regulations.

6. Align the print cartridge with the tracks inside the product, insert the print cartridge until it is firmly seated, and then close the top cover.

   After a short time, the control panel should display the **Ready** message.

7. Installation is complete. Place the used print cartridge in the box in which the new cartridge arrived. See the enclosed recycling guide for recycling instructions.

8. If you are using a non-HP print cartridge, check the product control panel for further instructions.
Replace staples

Replace staples if the product control-panel display prompts you with a message. If the stapler runs out of staples, jobs continue to print to the stapler/stacker, but they are not stapled.

1. On the right side of the stapler/stacker, turn the stapler unit toward the front of the product until the unit clicks into the open position. Grasp the blue staple-cartridge handle and pull the cartridge out of the stapler unit.

2. Insert the new staple cartridge into the stapler unit and rotate the stapler unit toward the rear of the product until the unit snaps into place.
Perform preventive maintenance

To ensure optimum performance from the product, replace certain parts when the **Replace Maintenance Kit** message appears on the control-panel display.

The kit includes the following items:

- Fuser
- Transfer roller
- Plastic tool for removing the old transfer roller
- Eight feed rollers and four pickup rollers
- Installation instructions

**NOTE:** The maintenance kit is a consumable item and is not covered under the original product warranty or under most extended warranties. Installing the maintenance kit is the customer’s responsibility.

After a maintenance kit is installed, the maintenance-kit counter must be reset.

Reset the maintenance-kit counter

**NOTE:** Perform this procedure only after a maintenance kit has been installed. Do not use this procedure to temporarily clear the **Replace Maintenance Kit** message.

1. At the product control panel, press the Home button.

2. Open the following menus:
   - Administration
   - Manage Supplies
   - Reset Supplies
   - New Maintenance Kit

3. Select the **Yes** option to reset the maintenance-kit counter.
Solve problems with print cartridges

Check the print cartridges

Check the print cartridge, and replace it if necessary, if you are having any of the following problems:

- The printing is too light or seems faded in areas.
- Printed pages have small unprinted areas.
- Printed pages have streaks or bands.

**NOTE:** If you are using a draft or EconoMode print setting, the printing might appear light.

If you determine that you need to replace a print cartridge, print the supplies status page to find the part number for the correct genuine HP print cartridge.

<table>
<thead>
<tr>
<th>Type of print cartridge</th>
<th>Steps to resolve the problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refilled or remanufactured print</td>
<td>❌Hewlett-Packard Company cannot recommend the use of non-HP supplies, either new or</td>
</tr>
<tr>
<td>cartridge</td>
<td>remanufactured. Because they are not HP products, HP cannot influence their design or</td>
</tr>
<tr>
<td></td>
<td>control their quality. If you are using a refilled or remanufactured print cartridge and</td>
</tr>
<tr>
<td></td>
<td>are not satisfied with the print quality, replace the cartridge with a genuine HP cartridge.</td>
</tr>
<tr>
<td>Genuine HP print cartridge</td>
<td>1. The product control panel or the supplies status page indicates <strong>Very Low</strong> status</td>
</tr>
<tr>
<td></td>
<td>when the cartridge has reached the end of its designated life. Replace the print cartridge if</td>
</tr>
<tr>
<td></td>
<td>print quality is no longer acceptable.</td>
</tr>
<tr>
<td></td>
<td>2. Visually inspect the print cartridge for damage. See the instructions that follow.</td>
</tr>
<tr>
<td></td>
<td>Replace the print cartridge if necessary.</td>
</tr>
<tr>
<td></td>
<td>3. If printed pages have marks that repeat several times at the same distance apart, print a</td>
</tr>
<tr>
<td></td>
<td>cleaning page. If this does not solve the problem, use the repeating defects information in</td>
</tr>
<tr>
<td></td>
<td>this document to identify the cause of the problem.</td>
</tr>
</tbody>
</table>
Inspect the print cartridge for damage

1. Remove the print cartridge from the product, and verify that the sealing tape has been removed.
2. Check the memory chip for damage.
3. Examine the surface of the green imaging drum on the bottom of the print cartridge.

⚠️ CAUTION: Do not touch the green roller (imaging drum) on the bottom of the cartridge. Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the print cartridge.
5. If the imaging drum does not appear to be damaged, rock the print cartridge gently several times and reinstall it. Print a few pages to see if the problem has resolved.
Repeating defects

If defects repeat at any of the following approximate intervals on the page, the print cartridge might be damaged.

- 37 mm
- 63 mm
- 94 mm

Print the Supplies Status page

The Supplies Status page indicates the estimated life remaining in print cartridges. It also lists the part number for the correct genuine HP print cartridge for your product so you can order a replacement print cartridge, as well as other useful information.

1. At the product control panel, press the Home button.
2. Open the following menus:
   - Administration
   - Reports
   - Configuration/Status Pages
3. Select the Supplies Status Page option, and then press the OK button to print the report.
## Interpret control panel messages for supplies

### Table 7-1 Supplies status messages

<table>
<thead>
<tr>
<th>Control panel message</th>
<th>Description</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>10.0X.Y0 Supply memory error</strong></td>
<td>The product cannot read or write to the print cartridge memory chip or the memory chip is missing from the print cartridge.</td>
<td>Reinstall the print cartridge, or install a new print cartridge.</td>
</tr>
<tr>
<td><strong>Black cartridge low</strong></td>
<td>The product indicates when a supply level is low. Actual print cartridge life might vary. You do not need to replace the print cartridge at this time unless print quality is no longer acceptable.</td>
<td>If print quality is no longer acceptable, replace the print cartridge. Consider purchasing a replacement cartridge so it is available when the installed cartridge has reached the end of its estimated life.</td>
</tr>
<tr>
<td><strong>Black cartridge very low</strong></td>
<td>The product indicates when a supply level is very low. Actual print cartridge life might vary. After an HP supply has reached the very low threshold, the HP Premium Protection Warranty for that supply has ended.</td>
<td>If print quality is no longer acceptable, replace the print cartridge.</td>
</tr>
<tr>
<td><strong>Incompatible &lt;supply&gt;</strong></td>
<td>The indicated supply is not compatible with this product.</td>
<td>Replace the supply with one that is designed for this product.</td>
</tr>
<tr>
<td><strong>Incompatible supplies</strong></td>
<td>Supply items are installed that were not designed for this product. The product cannot print with these supplies installed.</td>
<td>Press the down arrow ▼ button to identify the incompatible supplies. Install supplies that are designed for this product.</td>
</tr>
<tr>
<td><strong>Maintenance Kit low</strong></td>
<td>The maintenance kit is low. The actual supply life remaining might vary. Consider having a replacement maintenance kit available to install when print quality is no longer acceptable. You do not need to replace the maintenance kit at this time unless print quality is no longer acceptable.</td>
<td>If print quality is no longer acceptable, replace the maintenance kit. Instructions are included with the maintenance kit.</td>
</tr>
<tr>
<td><strong>Maintenance Kit very low</strong></td>
<td>The maintenance kit is very low. The actual supply life remaining might vary. After an HP supply has reached the very low threshold, the HP Premium Protection Warranty for that supply has ended.</td>
<td>If print quality is no longer acceptable, replace the maintenance kit. Instructions are included with the maintenance kit.</td>
</tr>
<tr>
<td><strong>Replace &lt;supply&gt;</strong></td>
<td>The product indicates when a supply level is at its estimated end of life. The actual life remaining might be different than the estimation. Have a replacement supply available to install when print quality is no longer acceptable. The supply does not need to be replaced now unless the print quality is no longer acceptable. After an HP supply has reached its approximated end of life, HP’s Premium Protection Warranty on that supply ends.</td>
<td>Replace the specified supply. Or, configure the product to continue printing by using the Manage Supplies menu.</td>
</tr>
<tr>
<td>Control panel message</td>
<td>Description</td>
<td>Recommended action</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td><strong>Replace supplies</strong></td>
<td>Two or more supplies are at the estimated end of life. The actual life remaining might be different than the estimation. Consider having replacement supplies available to install when print quality is no longer acceptable. The supply does not need to be replaced now unless the print quality is no longer acceptable. After an HP supply has reached its approximated end of life, HP's Premium Protection Warranty on that supply ends.</td>
<td>Press the down arrow ▼ button to see which supplies need to be replaced. Or, configure the product to continue printing by using the <strong>Manage Supplies</strong> menu.</td>
</tr>
<tr>
<td><strong>Supplies low</strong></td>
<td>This message appears when at least two supplies have reached the low threshold. The actual supply life remaining might vary. Press the down arrow ▼ button to see which supplies are low. You do not need to replace the supplies at this time unless print quality is no longer acceptable. After an HP supply has reached the very low threshold, the HP Premium Protection Warranty for that supply has ended.</td>
<td>To continue printing, either replace the supply or reconfigure the product by using the <strong>Manage Supplies</strong> menu on the control panel.</td>
</tr>
<tr>
<td><strong>Supplies very low</strong></td>
<td>This message appears when at least two supplies have reached the very low threshold. Press the down arrow ▼ button to see which supplies are low. The actual supply life remaining might vary. You do not need to replace the supplies at this time unless print quality is no longer acceptable. After an HP supply has reached the very low threshold, the HP Premium Protection Warranty for that supply has ended.</td>
<td>To continue printing, either replace the supply or reconfigure the product by using the <strong>Manage Supplies</strong> menu on the control panel.</td>
</tr>
<tr>
<td><strong>Unsupported supply installed</strong></td>
<td>The print cartridge is for a different HP product.</td>
<td>If print quality is no longer acceptable, replace the print cartridge.</td>
</tr>
<tr>
<td><strong>Used supply in use</strong></td>
<td>The print cartridge has been previously used.</td>
<td>If you believe you purchased a genuine HP supply, go to <a href="http://www.hp.com/go/anticounterfeit">www.hp.com/go/anticounterfeit</a>.</td>
</tr>
</tbody>
</table>
8 Print tasks

- Cancel a print job with Windows
- Basic print tasks with Windows
- Use HP ePrint
- Additional print tasks with Windows
- Walk-up USB printing
Cancel a print job with Windows

**NOTE:** If the print job is too far into the printing process, you might not have the option to cancel it.

1. If the print job is currently printing, cancel it by following this procedure:
   a. Press the Stop button on the product control panel.
   b. The product prompts you to confirm the cancellation. Press the OK button.

2. You can also cancel a print job from a software program or a print queue.
   - **Software program:** Typically, a dialog box appears briefly on the computer screen, allowing you to cancel the print job.
   - **Windows print queue:** If a print job is waiting in a print queue (computer memory) or print spooler, delete the job there.
     - **Windows XP, Server 2003, or Server 2008:** Click Start, click Settings, and then click Printers and Faxes. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.
     - **Windows Vista:** Click Start, click Control Panel, and then, under Hardware and Sound, click Printer. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.
     - **Windows 7:** Click Start, and then click Devices and Printers. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.
Basic print tasks with Windows

The methods to open the print dialog from software programs can vary. The procedures that follow include a typical method. Some software programs do not have a **File** menu. See the documentation for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.
Get help for any printing option with Windows

1. Click the Help button to open the online Help.

Change the number of print copies with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then select the number of copies.
Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Printing Shortcuts** tab.

4. Select one of the shortcuts, and then click the **OK** button.

**NOTE:** When you select a shortcut, the corresponding settings change on the other tabs in the printer driver.

---

**Create printing shortcuts**

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the Properties or Preferences button.

3. Click the Printing Shortcuts tab.

4. Select an existing shortcut as a base.

   **NOTE:** Always select a shortcut before adjusting any of the settings on the right side of the screen. If you adjust the settings and then select a shortcut, all your adjustments are lost.
5. Select the print options for the new shortcut.

6. Click the **Save As** button.

7. Type a name for the shortcut, and click the **OK** button.
**Improve print quality with Windows**

**Select the page size with Windows**
1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Select a size from the **Paper size** drop-down list.

**Select a custom page size with Windows**
1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Click the **Custom** button.
5. Type a name for the custom size, specify the dimensions, and click the **OK** button.

**Select the paper type with Windows**
1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. From the **Paper type** drop-down list, click the **More...** option.
5. Expand the list of **Type is:** options.
6. Expand the category of paper types that best describes your paper, and then click the paper type that you are using.

**Select the paper tray with Windows**
1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Select a tray from the **Paper source** drop-down list.
Print on both sides (duplex) with Windows

Manually print on both sides with Windows

**NOTE:** This information applies only to products that do not have an automatic duplexer.

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Finishing** tab.
4. Select the **Print on both sides (manually)** check box. Click the **OK** button to print the first side of the job.

5. Retrieve the printed stack from the output bin, and place it with the printed-side facing up in Tray 1.

6. On the control panel, press the **OK** button to print the second side of the job.

**Automatically print on both sides with Windows**

[NOTE: This information applies only to products that have an automatic duplexer.]

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the Properties or Preferences button.

3. Click the Finishing tab.

4. Select the Print on both sides check box. Click the OK button to print the job.
Print multiple pages per sheet with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Finishing tab.
4. Select the number of pages per sheet from the **Pages per sheet** drop-down list.

5. Select the correct **Print page borders**, **Page order**, and **Orientation** options.

**Select page orientation with Windows**

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the Properties or Preferences button.

3. Click the Finishing tab.

4. In the Orientation area, select the Portrait or Landscape option.
   
   To print the page image upside down, select the Rotate by 180 degrees option.
Use HP ePrint

Use HP ePrint to print documents by sending them as an e-mail attachment to the product’s e-mail address from any e-mail enabled device.

**NOTE:** The product must be connected to a network and have Internet access to use HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.
   a. Type the product IP address into the address line of a Web browser to open the HP Embedded Web Server.
   b. Click the **Web Services** tab.
   c. Select the option to enable Web Services.
2. Use the HP ePrintCenter Web site to define security settings and to configure default print settings for all HP ePrint jobs sent to this product.
   a. Go to [www.hpeprintcenter.com](http://www.hpeprintcenter.com).
   b. Click **Sign In**, and enter your HP ePrintCenter credentials or sign up for a new account.
   c. Select your product from the list, or click **+ Add printer** to add it. To add the product, you need the printer code, which is the segment of the product e-mail address that is before the @ symbol.
   
   **NOTE:** This code is valid for only 24 hours from the time you enable HP Web Services. If it expires, follow the instructions to enable HP Web Services again, and obtain a new code.
   
   d. To prevent your product from printing unexpected documents, click **ePrint Settings**, and then click the **Allowed Senders** tab. Click **Allowed Senders Only**, and add the e-mail addresses from which you want to allow ePrint jobs.
   e. To set up default settings for all ePrint jobs sent to this product, click **ePrint Settings**, click **Print Options**, and select the settings that you want to use.
3. To print a document, attach it to an e-mail message sent to the product’s e-mail address.
Additional print tasks with Windows

Print on preprinted letterhead or forms with Windows

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Paper/Quality** tab.
4. From the **Paper type** drop-down list, click the **More...** option.

5. Expand the list of **Type is:** options.
6. Expand the list of Other options.

7. Select the option for the type of paper you are using, and click the OK button.

Print on special paper, labels, or transparencies with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Paper/Quality** tab.

4. From the **Paper type** drop-down list, click the **More...** option.
5. Expand the list of **Type is:** options.

6. Expand the category of paper types that best describes your paper.

   **NOTE:** Labels and transparencies are in the list of **Other** options.

7. Select the option for the type of paper you are using, and click the **OK** button.
Print the first or last page on different paper with Windows

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Paper/Quality** tab.
4. In the Special pages area, click the Print pages on different paper option, and then click the Settings button.

5. In the Pages in document area, select either the First or Last option.

6. Select the correct options from the Paper source and Paper type drop-down lists. Click the Add button.
7. If you are printing both the first and last pages on different paper, repeat steps 5 and 6, selecting the options for the other page.

8. Click the OK button.

Scale a document to fit page size with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Effects** tab.

4. Select the **Print document on** option, and then select a size from the drop-down list.
Add a watermark to a document with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Effects tab.
4. Select a watermark from the Watermarks drop-down list.
   Or, to add a new watermark to the list, click the Edit button. Specify the settings for the watermark, and then click the OK button.
5. To print the watermark on the first page only, select the First page only check box. Otherwise, the watermark is printed on each page.

Create a booklet with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the **Finishing** tab.

4. Select the **Print on both sides** check box.

5. In the **Booklet layout** drop-down list, click the **Left binding** or **Right binding** option. The **Pages per sheet** option automatically changes to **2 pages per sheet**.
Select output options with Windows

Select an output bin with Windows

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Output** tab.

4. In the **Output Bin Options** area, select a bin from the **Bin** drop-down list.

### Select staple options with Windows

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Output** tab.

4. In the **Output Options** area, select an option from the **Staple** drop-down list.
Use job storage features with Windows

The following job-storage modes are available for print jobs:

- **Proof and Hold**: This feature provides a quick way to print and proof one copy of a job and then print more copies.

- **Personal Job**: When you send a job to the product, the job does not print until you request it at the product control panel. If you assign a personal identification number (PIN) to the job, you must provide the required PIN at the control panel.

- **Quick Copy**: If the optional hard disk is installed on the product, you can print the requested number of copies of a job and then store a copy of the job on the optional hard disk. Storing the job allows you to print additional copies of the job later.

- **Stored Job**: If the optional hard disk is installed on the product, you can store a job such as a personnel form, time sheet, or calendar on the product and allow other users to print the job at any time. Stored jobs also can be protected by a PIN.

⚠️ **CAUTION**: If you turn off the product, all Quick Copy, Proof and Hold, and Personal Job types of stored jobs are deleted. To permanently store the job and prevent the product from deleting it when space is needed for something else, select the Stored Job option in the driver.

Create a stored job with Windows

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Job Storage** tab.

4. Select a **Job Storage Mode** option.

### Print a stored job

Use the following procedure to print a job that is stored in the product memory.

1. At the product control panel, press the Home button.
2. Open the **Retrieve Job from Device Memory** menu.
3. Select your username, and then select the name of the job or select the **All Jobs (With PIN)** or **All Jobs (No PIN)** option.
4. Enter the PIN if required, and then select the **Print** option. Select the **Copies** option to adjust the number of copies.

### Delete a stored job

When you send a stored job to the product memory, the product overwrites any previous jobs with the same user and job name. If a job is not already stored under the same user and job name, and the product needs additional space, the product might delete other stored jobs starting with the oldest. You
can change the number of jobs that can be stored from the **General Settings** menu on the product control panel.

Use this procedure to delete a job that is stored in the product memory.

1. At the product control panel, press the Home button.
2. Open the **Retrieve Job from Device Memory** menu.
3. Select your username, and then select the name of the job or select the **All Jobs (With PIN)** or **All Jobs (No PIN)** option.
4. Select the **Delete** option. The product prompts you to confirm the deletion.

**Set job storage options with Windows**

**Print one copy for proof before printing all the copies**

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Job Storage** tab.
4. In the **Job Storage Mode** area, click the **Proof and Hold** option.

**Temporarily store a personal job on the product and print it later**

*NOTE:* The product deletes the job after you print it.

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Job Storage** tab.
4. In the **Job Storage Mode** area, click the **Personal Job** option.
5. Optional: In the **Make Job Private** area, click the **PIN to print** option, and enter a 4-digit personal identification number (PIN).
6. Print the job at any time from the product control panel.

**Temporarily store a job on the product**

*NOTE:* This option is available if the optional hard disk is installed in the product.

*NOTE:* The product stores the job until you turn the product off.

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Job Storage** tab.

4. In the **Job Storage Mode** area, click the **Quick Copy** option.

   The requested number of copies are printed immediately, and you can print more copies from the product control panel.

**Permanently store a job on the product**

![NOTE: This option is available if the optional hard disk is installed in the product.]

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Job Storage** tab.

4. In the **Job Storage Mode** area, click the **Stored Job** option.

**Make a permanently stored job private so that anyone who tries to print it must provide a PIN**

![NOTE: This option is available if the optional hard disk is installed in the product.]

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Job Storage** tab.

4. In the **Job Storage Mode** area, click the **Stored Job** option or the **Personal Job** option.

5. In the **Make Job Private** area, click the **PIN to print** option, and enter a 4-digit personal identification number (PIN).

   ![NOTE: To print the job or to delete it, you must provide the PIN at the product control panel.]

**Receive notification when someone prints a stored job**

![NOTE: Only the person who created the stored job receives notification. You do not receive notification when someone prints a stored job that another person has created.]

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Job Storage** tab.

4. Select the job storage mode that you want.

5. In the **Job Notifications Options** area, click the **Display Job ID when printing** option.
Set the user name for a stored job

Follow this procedure to change the user name for a stored job.

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Job Storage tab.
4. Select the job storage mode that you want.
5. In the User Name area, click the User name option to use the Windows default user name. To provide a different user name, click the Custom option and type the name.

Specify a name for the stored job

Follow this procedure to change the default name for a stored job.

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Job Storage tab.
4. Select the job storage mode that you want.
5. To automatically generate the job name associated with the stored document, in the Job Name area, click the Automatic option. The driver uses the document file name, if it is available. If the document has no file name, the driver uses the software program name or a time stamp for the job name.

To specify a job name, click the Custom option and type the name.

6. Select an option from the If job name exists drop-down list.
   - Select the Use Job Name + (1-99) option to add a number to the end of the existing name.
   - Select the Replace Existing File option to overwrite a job that already has that name.

Print special jobs with Windows

Set the duplex alignment

For documents that are printed on both sides, such as brochures, set the registration for the tray before printing to ensure that the front and back of the page are aligned.

1. At the product control panel, press the Home button.
2. Open the following menus:
   a. Administration
   b. General Settings
c. Print Quality

d. Image Registration

e. Adjust Tray <X>

3. Select the Print Test Page item, and then press the OK button.

4. Follow the instructions on the test page to complete the adjustment.
Walk-up USB printing

This product features walk-up USB printing, so you can quickly print files without sending them from a computer. The product accepts standard USB storage accessories in the USB port on the front of the product. You can print the following types of files:

- .pdf
- .prn
- .pcl
- .ps
- .cht

1. Insert the USB storage accessory into the USB port on the front of the product.
   
   **NOTE:** You might need to remove the cover from the USB port.

   **NOTE:** If the product does not recognize the USB accessory, try using another type of USB accessory. Because of differences in USB specifications, the product does not recognize all types of USB accessories.

2. At the product control panel, press the Home button.

3. Open the **Retrieve Job from USB** menu.

4. Select the name of the document that you want to print.

5. If you need to adjust the number of copies, select the **Copies** option, and then enter the number of copies.

6. Press the **OK** button to print the document.
9  Manage and maintain

- Print information pages
- Use the HP Embedded Web Server
- Use HP Web Jetadmin software
- Product security features
- Economy settings
- Install memory and internal USB devices
- Clean the product
- Product updates
**Print information pages**

Information pages provide details about the product and its current configuration. Use the following procedure to print or view the information pages:

1. At the product control panel, press the Home button.
2. Open the following menus:
   - Administration
   - Reports
3. Select the name of the report you want to review, scroll up to the **Print** option, and then press the **OK** button to print the report.

<table>
<thead>
<tr>
<th>First level</th>
<th>Second level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration/Status Pages</td>
<td>Administration Menu Map</td>
<td>Shows the layout and current settings of the control-panel menu items.</td>
</tr>
<tr>
<td></td>
<td>Configuration Page</td>
<td>Shows the product settings and installed accessories.</td>
</tr>
<tr>
<td></td>
<td>Supplies Status Page</td>
<td>Shows the approximate remaining life for the supplies; reports statistics on total number of pages and jobs processed, serial number, page counts, and maintenance information. HP provides approximations of the remaining life for the supplies as a customer convenience. The actual remaining supply levels might be different than the approximations provided.</td>
</tr>
<tr>
<td></td>
<td>Usage Page</td>
<td>Shows a count of all paper sizes that have passed through the product; lists whether they were simplex or duplex, and reports the page count.</td>
</tr>
<tr>
<td></td>
<td>File Directory Page</td>
<td>Shows the file name and folder name for files that are stored in the product memory.</td>
</tr>
<tr>
<td></td>
<td>Current Settings Page</td>
<td>Shows the current settings for each option in the Administration menu.</td>
</tr>
<tr>
<td>Other Pages</td>
<td>PCL Font List</td>
<td>Prints the available PCL fonts.</td>
</tr>
<tr>
<td></td>
<td>PS Font List</td>
<td>Prints the available PS fonts.</td>
</tr>
</tbody>
</table>
Use the HP Embedded Web Server

Use the HP Embedded Web Server to view product status, configure product network settings, and manage printing functions from your computer instead of from the product control panel. The following are examples of what you can do using the HP Embedded Web Server:

- View product status information.
- Determine the remaining life for all supplies and order new ones.
- View and change tray configurations.
- View and change the product control-panel menu configuration.
- View and print internal pages.
- Receive notification of product and supplies events.
- View and change network configuration.

To use the HP Embedded Web Server, you must have Microsoft Internet Explorer 5.01 or later or Netscape 6.2 or later for Windows, Mac OS, and Linux (Netscape only). Netscape Navigator 4.7 is required for HP-UX 10 and HP-UX 11. The HP Embedded Web Server works when the product is connected to an IP-based network. The HP Embedded Web Server does not support IPX-based product connections. You do not have to have Internet access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically available.

Open the HP Embedded Web Server by using a network connection

1. Identify the product IP address or host name, which is listed on the product configuration page. Follow these steps to print the product configuration page:
   a. At the product control panel, press the Home button.
   b. Open the following menus:
      - Administration
      - Reports
      - Configuration/Status Pages
      - Configuration Page
   c. Press the OK button.
   d. Find the IP address or host name on the Jetdirect page.

2. In a supported Web browser on your computer, type the product IP address or host name in the address/URL field.
**HP Embedded Web Server features**

### Information tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device Status</strong></td>
<td>Shows the product status and shows the estimated life remaining of HP supplies. The page also shows the type and size of paper set for each tray. To change the default settings, click the Change Settings link.</td>
</tr>
<tr>
<td><strong>Job Log</strong></td>
<td>Shows a summary of all jobs the product has processed.</td>
</tr>
<tr>
<td><strong>Configuration Page</strong></td>
<td>Shows the information found on the configuration page.</td>
</tr>
<tr>
<td><strong>Supplies Status Page</strong></td>
<td>Shows the status of the supplies for the product.</td>
</tr>
<tr>
<td><strong>Event Log Page</strong></td>
<td>Shows a list of all product events and errors. Use the HP Instant Support link (in the Other Links area on all HP Embedded Web Server pages) to connect to a set of dynamic Web pages that help you solve problems. These pages also show additional services available for the product.</td>
</tr>
<tr>
<td><strong>Usage Page</strong></td>
<td>Shows a summary of the number of pages the product has printed, grouped by size, type, and paper print path.</td>
</tr>
<tr>
<td><strong>Device Information</strong></td>
<td>Shows the product network name, address, and model information. To customize these entries, click the Device Information menu on the General tab.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Upload a print-ready file from your computer to print. The product uses the default print settings to print the file.</td>
</tr>
<tr>
<td><strong>Printable Reports and Pages</strong></td>
<td>Lists the internal reports and pages for the product. Select one or more items to print or view.</td>
</tr>
</tbody>
</table>

### General tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Control Panel Administration Menu</strong></td>
<td>Shows the menu structure of the Administration menu on the control panel.</td>
</tr>
<tr>
<td><strong>Alerts</strong></td>
<td>Set up e-mail alerts for various product and supplies events.</td>
</tr>
<tr>
<td><strong>AutoSend</strong></td>
<td>Configure the product to send automated e-mails regarding product configuration and supplies to specific e-mail addresses.</td>
</tr>
<tr>
<td><strong>Control Panel Snapshot</strong></td>
<td>Shows an image of the current screen on the control-panel display.</td>
</tr>
<tr>
<td><strong>Edit Other Links</strong></td>
<td>Add or customize a link to another Web site. This link appears in the Other Links area on all HP Embedded Web Server pages.</td>
</tr>
<tr>
<td><strong>Ordering Information</strong></td>
<td>Enter information about ordering replacement print cartridges. This information appears on the supplies status page.</td>
</tr>
</tbody>
</table>
**Table 9-2  HP Embedded Web Server General tab (continued)**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Information</td>
<td>Name the product and assign an asset number to it. Enter the name of the primary contact who will receive information about the product.</td>
</tr>
<tr>
<td>Language</td>
<td>Set the language in which to display the HP Embedded Web Server information.</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Set the date and time or synchronize with a network time server.</td>
</tr>
<tr>
<td>Sleep Schedule</td>
<td>Set or edit a wake time, sleep time, and sleep delay for the product. You can set a different schedule for each day of the week and for holidays.</td>
</tr>
<tr>
<td>Backup and Restore</td>
<td>Create a backup file that contains product and user data. If necessary, you can use this file to restore data to the product.</td>
</tr>
<tr>
<td>Restore Factory Settings</td>
<td>Restore product settings to the factory defaults.</td>
</tr>
<tr>
<td>Solution Installer</td>
<td>Install third-party software programs that can enhance the product functionality.</td>
</tr>
<tr>
<td>Firmware upgrade</td>
<td>Download and install product firmware upgrade files.</td>
</tr>
<tr>
<td>Statistics Services</td>
<td>Provides connection information about third-party job-statistics services.</td>
</tr>
</tbody>
</table>

**Print tab**

**Table 9-3  Print tab**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve from USB Setup</td>
<td>Enable or disable the Retrieve Job from USB menu on the control panel.</td>
</tr>
<tr>
<td>Manage Stored Jobs</td>
<td>Enable or disable the ability to store jobs in the product memory, and configure job-storage options.</td>
</tr>
<tr>
<td>Adjust Paper Types</td>
<td>Adjust the print mode for each type of paper that the product supports.</td>
</tr>
<tr>
<td>General Print Settings</td>
<td>Establish default settings for print jobs.</td>
</tr>
<tr>
<td>Manage Trays</td>
<td>View or change paper type and size settings for each tray, and adjust general settings for all trays.</td>
</tr>
</tbody>
</table>

**Troubleshooting tab**

**Table 9-4  HP Embedded Web Server Troubleshooting tab**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports and Tests</td>
<td>Print a variety of reports to help you solve problems with the product.</td>
</tr>
<tr>
<td>Calibrations</td>
<td>Select an option to calibrate the product immediately.</td>
</tr>
<tr>
<td>Firmware upgrade</td>
<td>Download and install product firmware upgrade files.</td>
</tr>
<tr>
<td>Restore Factory Settings</td>
<td>Restore product settings to factory defaults.</td>
</tr>
</tbody>
</table>
Security tab

Table 9-5  HP Embedded Web Server Security tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Security</td>
<td>Configure an administrator password so you can restrict access to certain features on the product. Enable or disable the walk-up USB printing port on the control panel or the USB connectivity port on the formatter for printing directly from a computer.</td>
</tr>
<tr>
<td>Access Control</td>
<td>Configure access to product functions for specific individuals or groups. Also select the method by which individuals sign in to the product.</td>
</tr>
<tr>
<td>Protect Stored Data</td>
<td>Configure and manage the internal hard drive for the product. This product includes an encrypted hard drive for maximum security. Configure settings for jobs that are stored on the product hard drive.</td>
</tr>
<tr>
<td>Certificate Management</td>
<td>Install and manage security certificates for access to the product and the network.</td>
</tr>
</tbody>
</table>

HP Web Services tab

Use the HP Web Services tab to configure and enable HP Web Services for this product. You must enable HP Web Services to use the HP ePrint feature.

Networking tab

Use the Networking tab to change network settings for the product when it is connected to an IP-based network. This tab does not appear if the product is connected to other types of networks.

Other Links list

You can configure which items appear in the Other Links list by using the Edit Other Links menu on the General tab. The following items are the default links.

Table 9-6  HP Embedded Web Server Other Links list

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Support</td>
<td>Connects to the support site for the product, from which you can search for help regarding various topics.</td>
</tr>
<tr>
<td>HP Instant Support</td>
<td>Connects you to the HP Web site to help you find solutions to product problems.</td>
</tr>
</tbody>
</table>
Use HP Web Jetadmin software

HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of networked HP devices, including printers, multifunction products, and digital senders. This single solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging environment — ultimately increasing business productivity by helping you save time, control costs, and protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product features. Visit www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about updates.
Product security features

Security statements

The product supports security standards and recommended protocols that help you keep the product secure, protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP’s secure imaging and printing solutions, visit www.hp.com/go/secureprinting. The site provides links to white papers and FAQ documents about security features.

IP Security

IP Security (IPsec) is a set of protocols that control IP-based network traffic to and from the product. IPsec provides host-to-host authentication, data integrity, and encryption of network communications.

For products that are connected to the network and have an HP Jetdirect print server, you can configure IPsec by using the Networking tab in the HP Embedded Web Server.

Secure the HP Embedded Web Server

Assign an administrator password for access to the product and the HP Embedded Web Server so that unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a Web browser.
2. Click the Security tab.
3. Open the General Security menu.
4. In the Username field, type the name to associate with the password.
5. Type the password in the New Password box, and type it again in the Verify password box.

   **NOTE:** If you are changing an existing password, you must first type the existing password in the Old Password field.

6. Click the Apply button. Make note of the password and store it in a safe place.

Encryption support: HP Encrypted High Performance Hard Disks (xh models only)

This product includes an encrypted hard disk. This hard disk provides hardware-based encryption so you can securely store sensitive print, copy, and scan data without impacting product performance. This hard disk uses the latest Advanced Encryption Standard (AES) and has versatile time-saving features and robust functionality.

Use the Security menu in the HP Embedded Web Server to configure the disk.
For more information about the encrypted hard disk, see the *HP High-Performance Secure Hard Disk Setup Guide*.

2. Type *Secure Hard Disk* into the search box and click the >> button.
3. Click the *HP Secure High Performance Hard Disk Drive* link.
4. Click the *Manuals* link.

**Secure stored jobs**

You can protect jobs that are stored on the product by assigning a PIN to them. Anyone who tries to print these protected jobs must first enter the PIN at the product control panel.

**Lock the control panel menus**

You can lock various features on the control panel by using the HP Embedded Web Server.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a Web browser.
2. Click the the *Security* tab.
3. Open the *Access Control* menu.
4. In the *Sign In and Permission Policies* area, select which types of users have permission for each of the features.
5. Click the *Apply* button.

**Lock the formatter**

The formatter area, on the back of the product, has a slot that you can use to attach a security cable. Locking the formatter prevents someone from removing valuable components from it.
Economy settings

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner and decrease the cost per page. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the print cartridge.

**NOTE:** This feature is available with the PCL 6 printer driver for Windows. If you are not using that driver, you can enable the feature by using the HP Embedded Web Server.

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Click the EconoMode check box.

Powersave modes

Disable or enable sleep mode

1. At the product control panel, press the Home button.
2. Open each of the following menus:
   a. Administration
   b. General Settings
   c. Energy Settings
   d. Sleep Timer Settings
   e. Sleep/Auto Off Timer
3. Select one of the following options:
   * Enabled
   * Disabled
Set the sleep timer

Use the sleep timer feature to cause the product to enter sleep mode automatically after a predefined period of inactivity.

1. At the product control panel, press the Home button.
2. Open each of the following menus:
   a. Administration
   b. General Settings
   c. Energy Settings
   d. Sleep Timer Settings
   e. Sleep/Auto Off After
3. Select the appropriate time period, and then press the OK button.

   **NOTE:** The default value is 30 minutes.

Set the sleep schedule

Use the sleep schedule feature to reduce power consumption when the product is inactive. You can schedule specific times of the day at which the product enters sleep mode or wakes from sleep mode. You can customize this schedule for each day of the week. To set up a sleep schedule, use the HP Embedded Web Server.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a Web browser.
2. Click the General tab.
3. Click the Date and Time link, and then set the current date and time.
4. Click the Apply button.
5. Click the Sleep Schedule link, and then click the Add button to open the sleep schedule settings.
6. Configure the sleep schedule settings.
7. Click the Apply button.
Install memory and internal USB devices

Overview

The formatter has the following open slots and ports for expanding the product's capabilities:

- One dual inline memory module (DIMM) slot for upgrading the product with more memory
- Two internal USB ports for adding fonts, languages, and other third-party solutions

To find out how much memory is installed in the product or to find out what is installed in the USB ports, print a configuration page.

Install memory

You might want to add more memory to the product if you often print complex graphics, print PostScript (PS) documents, or use many downloaded fonts. Added memory also gives you more flexibility in supporting job-storage features, such as quick copying.

NOTE: Single inline memory modules (SIMMs) used in previous HP LaserJet products are not compatible with the product.

Install product memory

This product has one DIMM slot.

CAUTION: Static electricity can damage electronic components. When handling DIMMs, either wear an antistatic wrist strap or frequently touch the surface of the DIMM antistatic package, then touch bare metal on the product.

1. Print a configuration page to find out how much memory is installed in the product before adding more memory.
   a. At the product control panel, press the Home button.
   b. Open the following menus:
      - Administration
      - Reports
      - Configuration/Status Pages
      - Configuration Page
2. After the configuration page has printed, turn the product off.

3. Disconnect the power cord and interface cable.

4. Remove the right-side panel by sliding it towards the rear of the product to unlatch it.
5. Open the access door by pulling on the metal tab.

6. Remove the DIMM from the antistatic package.

⚠️ **CAUTION:** To reduce the possibility of damage caused by static electricity, always wear an electrostatic discharge (ESD) wrist strap or touch the surface of the antistatic package before handling DIMMs.

7. Hold the DIMM by the edges, and align the notches on the DIMM with the DIMM slot. (Check that the locks on each side of the DIMM slot are open.)
8. Press the DIMM straight into the slot, and press firmly. Make sure the locks on each side of the DIMM snap into place.

9. Close the access door, and press firmly until it snaps into place.

10. Reinstall the right-side panel. Align the tabs on the panel with the slots in the product, and push the panel toward the front of the product until it latches into place.
11. Reconnect the interface cable and the power cord.

12. Turn the product on.
## Enable memory

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Click Settings.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Printers and Faxes</strong> (using the default Start menu view) or click <strong>Printers</strong> (using the Classic Start menu view).</td>
</tr>
<tr>
<td></td>
<td>4. Right-click the product driver icon, and then select <strong>Properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>5. Click the <strong>Device Settings</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>6. Expand the area for <strong>Installable Options</strong>.</td>
</tr>
<tr>
<td></td>
<td>7. Next to <strong>Automatic Configuration</strong>, select <strong>Update Now</strong>.</td>
</tr>
<tr>
<td></td>
<td>8. Click <strong>OK</strong>.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> If the memory is not updated correctly after using the <strong>Update Now</strong> option, you can manually select the total amount of memory installed in the product in the <strong>Installable Options</strong> area.</td>
<td></td>
</tr>
<tr>
<td>The <strong>Update Now</strong> option overwrites any existing product configuration settings.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows 7</th>
<th>1. Click Start.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Click <strong>Devices and Printers</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Right-click the product driver icon, and then select <strong>Printer properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. Click the <strong>Device Settings</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>5. Expand the area for <strong>Installable Options</strong>.</td>
</tr>
<tr>
<td></td>
<td>6. Next to <strong>Automatic Configuration</strong>, select <strong>Update Now</strong>.</td>
</tr>
<tr>
<td></td>
<td>7. Click <strong>OK</strong>.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> If the memory is not updated correctly after using the <strong>Update Now</strong> option, you can manually select the total amount of memory installed in the product in the <strong>Installable Options</strong> area.</td>
<td></td>
</tr>
<tr>
<td>The <strong>Update Now</strong> option overwrites any existing product configuration settings.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mac OS X 10.5 and 10.6</th>
<th>1. From the Apple menu , click the <strong>System Preferences</strong> menu and then click the <strong>Print &amp; Fax</strong> icon.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Select the product in the left side of the window.</td>
</tr>
<tr>
<td></td>
<td>3. Click the <strong>Options &amp; Supplies</strong> button.</td>
</tr>
<tr>
<td></td>
<td>4. Click the <strong>Driver</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>5. Configure the installed options.</td>
</tr>
</tbody>
</table>
Check DIMM installation

After installing the DIMM, make sure that the installation was successful.

1. Turn the product on. Check that the Ready light is illuminated after the product has gone through the startup sequence. If an error message appears, a DIMM might have been incorrectly installed.

2. Print a configuration page.

3. Check the memory section on the configuration page and compare it to the configuration page that was printed before the memory installation. If the amount of memory has not increased, the DIMM might not be installed correctly, or the DIMM might be defective. Repeat the installation procedure. If necessary, install a different DIMM.

**NOTE:** If you installed a product language (personality), check the “Installed Personalities and Options” section on the configuration page. This area should list the new product language.

Memory allocation

Utilities or jobs that you download to the product sometimes include resources (for example, fonts, macros, or patterns). Resources that are internally marked as permanent remain in the product memory until you turn the product off.

Use the following guidelines if you use the page description language (PDL) ability to mark resources as permanent. For technical details, see an appropriate PDL reference for PCL or PS.

- Mark resources as permanent only when it is absolutely necessary that they remain in memory while the product is turned on.

- Send permanent resources to the product only at the beginning of a print job and not while the product is printing.

**NOTE:** Overusing permanent resources or downloading them while the product is printing might affect product performance or the ability to print complex pages.
Install internal USB devices

The product has two internal USB ports.

1. Turn the product off.

2. Disconnect the power cord and interface cable.

3. Remove the right-side panel by sliding it towards the rear of the product to unlatch it.
4. Open the access door by pulling on the metal tab.

5. Locate the USB ports near the bottom of the formatter board. Insert the USB device into one of the ports.

**CAUTION:** To prevent static electricity from damaging the formatter board, hold the metal access door with one hand while you insert the USB device with the other hand. If you move away from the product during this procedure, be sure to touch the metal access door to discharge electricity before continuing.

6. Close the access door, and press firmly until it snaps into place.
7. Reinstall the right-side panel. Align the tabs on the panel with the slots in the product, and push the panel toward the front of the product until it latches into place.

8. Reconnect the interface cable and the power cord.

9. Turn the product on.
Clean the product

To clean the product exterior, use a soft, water-moistened cloth.

Clean the paper path

1. At the product control panel, press the Home button.
2. Open the following menus:
   - Device Maintenance
   - Calibrate/Cleaning
3. Select the Print Cleaning Page item, and press the OK button to print the page.
4. The cleaning process can take several minutes. When it is finished, discard the printed page.

Product updates

HP regularly updates features that are available in the product firmware. To take advantage of the most current features, update the product firmware. To download the most recent firmware upgrade, go to www.hp.com/go/lj600Series_firmware.
10 Solve problems

- Self help
- Solve problems checklist
- Restore factory settings
- Interpret control-panel messages
- Paper feeds incorrectly or becomes jammed
- Clear jams
- Improve print quality
- The product does not print or it prints slowly
- Solve walk-up USB printing problems
- Solve connectivity problems
- Solve product software problems with Windows
- Solve product software problems with Mac
In addition to the information in this guide, other sources are available that provide helpful information.

<table>
<thead>
<tr>
<th>Quick Reference Topics</th>
<th>Several Quick Reference Topics for this product are available at this Web site: <a href="http://www.hp.com/support/lj600Series">www.hp.com/support/lj600Series</a></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can print these topics and keep them near the product. They are a handy reference for procedures that you perform frequently.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Control panel help</th>
<th>The control panel has built-in help that guides you through several tasks, such as replacing print cartridges and clearing jams. To open the Help system, press the Help button ?</th>
</tr>
</thead>
</table>
Solve problems checklist

Follow these steps when trying to solve a problem with the product.

1. Make sure the product Ready light is on. If no lights are on, complete these steps:
   a. Check the power-cable connections.
   b. Check that the power is turned on.
   c. Make sure that the line voltage is correct for the product power configuration. (See the label that is on the back of the product for voltage requirements.) If you are using a power strip and its voltage is not within specifications, plug the product directly into the wall. If it is already plugged into the wall, try a different outlet.
   d. If none of these measures restores power, contact HP Customer Care.

2. Check the cabling.
   a. Check the cable connection between the product and the computer or network port. Make sure that the connection is secure.
   b. Make sure that the cable itself is not faulty by using a different cable, if possible.
   c. Check the network connection.

3. The control panel should indicate ready status. If an error message appears, resolve the error.

4. Ensure that the paper that you are using meets specifications.

5. Print a configuration page. If the product is connected to a network, an HP Jetdirect page also prints.
   a. At the product control panel, press the Home button.
   b. Open the following menus:
      - Administration
      - Reports
      - Configuration/Status Pages
      - Configuration Page
   c. Press the OK button.

   If the pages do not print, check that at least one tray contains paper.

   If the page jams in the product, follow the instructions on the control panel to clear the jam.
6. If the configuration page prints, check the following items:
   a. If the page does not print correctly, the problem is with the product hardware. Contact HP Customer Care.
   b. If the page prints correctly, then the product hardware is working. The problem is with the computer you are using, with the printer driver, or with the program.

7. Select one of the following options:
   - Windows: Click Start, click Settings, and then click Printers or Printers and Faxes. Double-click the name of the product.
   - or -
   - Mac OS X: Open the Printer Setup Utility or the Print & Fax list, and double-click the line for the product.

8. Verify that you have installed the printer driver for this product. Check the program to make sure that you are using the printer driver for this product. The printer driver is on the CD that came with the product. You can also download the printer driver from this Web site: www.hp.com/support/lj600Series.

9. Print a short document from a different program that has worked in the past. If this solution works, then the problem is with the program you are using. If this solution does not work (the document does not print), complete these steps:
   a. Try printing the job from another computer that has the product software installed.
   b. If you connected the product to the network, connect the product directly to a computer with a USB cable. Redirect the product to the correct port, or reinstall the software, selecting the new connection type that you are using.

Factors that affect product performance

Several factors affect the time it takes to print a job:

- Maximum product speed, measured in pages per minute (ppm)
- The use of special paper (such as transparencies, heavy paper, and custom-size paper)
- Product processing and download time
- The complexity and size of graphics
- The speed of the computer you are using
- The USB connection
- The product I/O configuration
- The network operating system and configuration (if applicable)
- The printer driver that you are using
**Restore factory settings**

1. At the product control panel, press the Home button.

2. Open the following menus:
   - Administration
   - General Settings
   - Restore Factory Settings

3. Press the OK button.
Interpret control-panel messages

Control-panel message types

Four types of control-panel messages can indicate the status of or problems with the product.

<table>
<thead>
<tr>
<th>Message type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status messages</td>
<td>Status messages reflect the current state of the product. They inform you of normal product operation and require no interaction to clear them. They change as the state of the product changes. Whenever the product is ready, not busy, and has no pending warning messages, the Ready status message appears if the product is online.</td>
</tr>
<tr>
<td>Warning messages</td>
<td>Warning messages inform you of data and print errors. These messages typically alternate with the Ready or status messages and remain until you press the OK button. Some warning messages are clearable. If the Clearable Warnings menu in the Display Settings menu is set to the Job option, the next print job clears these messages.</td>
</tr>
<tr>
<td>Error messages</td>
<td>Error messages communicate that some action must be performed, such as adding paper or clearing a jam. Some error messages are auto-continuable. If the Continuable Events menu in the Display Settings menu is set to the Auto-Continue option, the product continues normal operation after an auto-continuable error message appears for 10 seconds. <strong>NOTE:</strong> Pressing any button during the 10-second auto-continuable error message overrides the auto-continue feature, and the button function takes precedence. For example, pressing the Stop button pauses printing and offers the option to cancel the print job.</td>
</tr>
<tr>
<td>Critical-error messages</td>
<td>Critical error messages inform you of a product failure. You can clear some of these messages by turning the product off and then on. These messages are not affected by the Auto-Continue setting. If a critical error persists, service is required.</td>
</tr>
</tbody>
</table>

Control-panel messages

The product provides robust control panel messaging. When a message appears on the control panel, follow the on-screen instructions to resolve the issue. If the product displays an “Error” or “Attention” message, and no steps are shown to resolve the issue, turn the product off then on. Contact HP support if you continue to experience issues with the product.

For additional information on a variety of topics, press the Help button.
Paper feeds incorrectly or becomes jammed

- The product does not pick up paper
- The product picks up multiple sheets of paper
- Prevent paper jams

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.
2. Load the tray with the correct size of paper for your job.
3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the appropriate indentation in the tray.
4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the paper. Return the stack of paper to the tray.
2. Use only paper that meets HP specifications for this product.
3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.
2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
3. Use paper that has not previously been printed or copied on.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.
Clear jams

Jam locations

If a jam message appears on the control-panel display, look for jammed paper or other print media in the locations that are indicated in the following illustration. Then follow the procedure for clearing the jam. You might need to look for paper in other locations than those that are indicated in the jam message. If the location of the jam is not obvious, look first in the top-cover area underneath the print cartridge.

When clearing jams, be very careful not to tear jammed paper. If a small piece of paper is left in the product, it could cause additional jams.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Top-cover and print-cartridge areas</td>
</tr>
<tr>
<td>2</td>
<td>Optional envelope feeder</td>
</tr>
<tr>
<td>3</td>
<td>Tray areas (Tray 1, Tray 2, and optional trays)</td>
</tr>
<tr>
<td>4</td>
<td>Optional duplexer</td>
</tr>
<tr>
<td>5</td>
<td>Fuser area</td>
</tr>
<tr>
<td>6</td>
<td>Output areas (top bin; rear bin; and optional stacker, stapler/stacker, or 5-bin mailbox)</td>
</tr>
</tbody>
</table>

**NOTE:** Loose toner might remain in the product after a jam and cause temporary print-quality problems. These problems should clear up within a few pages.

Clear jams from the output areas

Use these procedures to clear jams that occur in the rear output bin or in the optional stacker, stapler/stacker, or 5-bin mailbox.
Clear jams from the rear output bin

1. Open the rear output bin.

**NOTE:** If most of the paper is still inside the product, it might be easier to remove it through the top-cover area.

2. Grasp both sides of the paper, and slowly pull the paper out of the product. Loose toner might be on the sheet. Be careful not to spill it on yourself or into the product.

**NOTE:** If the jammed paper is difficult to remove, try opening the top cover all the way to release pressure on the paper. If the sheet has torn, or if you still cannot remove it, clear the jam from the fuser area.

3. Close the rear output bin.

4. If a jam message persists, a sheet is still jammed in the product. Look for the jam in another location.

Clear jams from the optional stacker or stapler/stacker

Paper jams can occur in the optional stacker or the optional stapler/stacker. Staple jams can occur only in the optional stapler/stacker.
Clear paper jams from the optional stacker or stapler/stacker

1. At the back of the product, open the door on the stacker or stapler/stacker, and open the rear output bin.

2. Carefully remove any jammed paper.

3. Close the door on the stacker or stapler/stacker, and close the rear output bin.

4. If a jam message persists, a sheet is still jammed. Look for it in another location. Check the front of the accessory and carefully remove any jammed paper.

   **NOTE:** The output bin must be pushed down into the lowest position for printing to continue.

Clear staple jams from the optional stapler/stacker

The stapler needs to reload after clearing a staple jam, so the first few documents might not be stapled. If a print job is sent and the stapler is jammed or is out of staples, the job will still print as long as the path to the stacker bin is not blocked.
1. On the right side of the stapler/stacker, turn the stapler unit toward the front of the product until the unit clicks into the open position. Pull outward on the blue staple cartridge to remove it.

2. Rotate the green cover on the end of the staple cartridge upward, and remove the jammed staple.

3. Insert the staple cartridge into the stapler unit, and rotate the stapler unit toward the rear of the product until the unit snaps into place.
Clear jams from the optional 5-bin mailbox

1. Remove any paper that is in the output bins.

2. On the back of the 5-bin mailbox, open the jam-access door.

3. If the paper is jammed at the top of the 5-bin mailbox, pull it straight down to remove it.
4. If the paper is jammed at the bottom of the 5-bin mailbox, open the rear output bin, and then pull straight up on the paper to remove it.

5. Close the jam-access door and the rear output bin.
Clear jams from the fuser area

Use this procedure only in these situations:

- Paper has jammed inside the fuser and cannot be removed from the top-cover area or the rear-output area.
- A sheet of paper has torn while you were trying to clear a jam from the fuser.

1. Turn the product off.

2. Rotate the product so the rear is facing you. If an optional duplexer is installed, lift it and pull it straight out. Set it aside.

3. Disconnect the power cord.

**WARNING!** The fuser is very hot. To avoid minor burns, allow the fuser to cool before removing it from the product.
4. Open the rear output bin.

5. Remove the rear output bin. Place your finger near the left-side hinge, and push firmly to the right until the hinge-pin clears the hole inside the product. Rotate the output bin outward to remove it.

6. If paper is visible, remove it.
   If paper is not visible, push up on the two blue levers on the sides of the fuser, and pull the fuser straight out.

7. Remove the jammed paper. If necessary, lift the black plastic guide that is located on the top of the fuser to gain access to the jammed sheet.
   **CAUTION:** Do not use a sharp or metal object to clear paper from the fuser area. You might damage the fuser.
8. Push the fuser firmly into the product until the blue levers on both sides click into place.

9. Reinstall the rear output bin. Insert the right hinge-pin into the hole inside the product. Push inward on the left hinge, and slide it into the hole inside the product. Close the rear output bin.

10. Plug the power cord into the product.

11. Replace the optional duplexer, if it was removed.
12. Turn the product on.

13. If a jam message persists, a sheet is still jammed in the product. Look for the jam in another location.

Clear jams from the optional duplexer

1. Lift the optional duplexer up and then pull it out to remove it.

2. Remove any paper that is on top of Tray 2. (You might need to reach inside the product.)

4. Insert the optional duplexer into the product.

5. If a jam message persists, a sheet is still jammed in the product. Look for the jam in another location.
Clear jams from the trays

Use these procedures to clear jams from the trays.

Clear jams from Tray 1

1. Slowly pull the jammed paper out of the product.

Clear jams from Tray 2 or an optional 500-sheet tray

1. Slide the tray out of the product, lift it slightly, and remove any damaged paper from the tray.

2. If the edge of the jammed paper is visible in the feed area, slowly pull the paper down and out of the product. (Do not pull the paper straight out, or it will tear.) If the paper is not visible, look in the next tray or in the top-cover area.
3. Make sure that the paper is flat in the tray at all four corners and below the maximum-height indicators.

4. Slide the tray into the product.

5. Press the OK button to clear the jam message.

6. If a jam message persists, a sheet is still jammed in the product. Look for the jam in another location.

**Clear jams from the optional 1,500-sheet tray**

1. Open the front door of the tray.
2. If the edge of the jammed paper is visible in the feed area, slowly pull the paper down and out of the product. (Do not pull the paper straight out, or it will tear.) If the paper is not visible, look in the top-cover area.

3. Make sure that the paper does not exceed the fill marks on the paper guides, and that the front edge of the stack is aligned with the arrows.

4. Close the front door of the tray.

5. Press the OK button to clear the jam message.

6. If a jam message persists, a sheet is still jammed in the product. Look for the jam in another location.
Clear jams from the optional envelope feeder

This procedure applies only to jams that occur when you are using an optional envelope feeder.

1. Remove any envelopes that are loaded in the optional envelope feeder. Lower the envelope weight and lift the tray extension up, to the closed position.

2. Grasp both sides of the optional envelope feeder and carefully pull it out of the product.

3. Slowly remove any jammed envelopes from the optional envelope feeder.

4. Slowly remove any jammed envelopes from the product.
5. Reinstall the envelope feeder.

6. Press the OK button to clear the jam message.

7. If a jam message persists, an envelope is still jammed in the product. Look for the jam in another location.

8. Replace the envelopes, making sure that you push the bottom envelopes in slightly further than the top envelopes.

Clear jams from the top-cover and print-cartridge areas

1. Open the top cover.

2. Remove the print cartridge.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few minutes. Cover the print cartridge with a sheet of paper while it is outside of the product.
3. Use the green handle to lift the paper-access plate. Slowly pull the jammed paper out of the product. Do not tear the paper. If paper is difficult to remove, try clearing it from the tray area.

4. Open Tray 1 and remove the envelope accessory cover. If paper is present, remove it.

5. Rotate the paper guide to check for additional jammed paper underneath. If jammed paper is present, remove it.

6. Replace the envelope accessory cover and close Tray 1.
7. Reinstall the print cartridge and close the top cover.

8. If a jam message persists, jammed paper is still in the product. Look for the jam in another location.

Change jam recovery

This product provides a jam recovery feature that reprints jammed pages. The following options are available:

- **Auto** — The product attempts to reprint jammed pages when sufficient memory is available. This is the default setting.

- **Off** — The product does not attempt to reprint jammed pages. Because no memory is used to store the most recent pages, performance is optimal.

**NOTE:** When using this option, if the product runs out of paper and the job is being printed on both sides, some pages can be lost.

- **On** — The product always reprints jammed pages. Additional memory is allocated to store the last few pages printed. This might cause overall performance to suffer.

1. At the product control panel, press the Home button.

2. Open the following menus:
   - **Administration**
   - **General Settings**
   - **Jam Recovery**

3. Select the appropriate setting, and then press the OK button.
Improve print quality

You can prevent most print-quality problems by following these guidelines.

- Use the correct paper type setting in the printer driver.
- Use paper that meets HP specifications for this product.
- Clean the product as necessary.
- Replace print cartridges when they are reaching the end of their estimated life and print quality is no longer acceptable.
- Use the printer driver that best meets your printing needs.

Select a paper type

1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/Quality tab.
2. Select a type from the Type is drop-down list.
3. Click the OK button.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

- The printing is too light or seems faded in areas.
- Specks of toner are on the printed pages.
- Toner is smearing on the printed pages.
- Printed characters seem misformed.
- Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines when selecting paper:

- Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, staples, and curled or bent edges.
- Use paper that has not been previously printed on.
- Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in Inkjet printers.
- Use paper that is not too rough. Using smoother paper generally results in better print quality.
Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the following problems:

- Specks of toner are on the printed pages.
- Toner is smearing on the printed pages.
- Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. At the product control panel, press the Home button.
2. Open the following menus:
   - Device Maintenance
   - Calibrate/Cleaning
3. Select the Print Cleaning Page item, and press the OK button to print the page.
4. The cleaning process can take several minutes. When it is finished, discard the printed page.

Check the print cartridge

Check the print cartridge, and replace it if necessary, if you are having any of the following problems:

- The printing is too light or seems faded in areas.
- Printed pages have small unprinted areas.
- Printed pages have streaks or bands.

**NOTE:** If you are using a draft or EconoMode print setting, the printing might appear light.

If you determine that you need to replace a print cartridge, print the supplies status page to find the part number for the correct genuine HP print cartridge.
<table>
<thead>
<tr>
<th>Type of print cartridge</th>
<th>Steps to resolve the problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refilled or remanufactured print cartridge</td>
<td>Hewlett-Packard Company cannot recommend the use of non-HP supplies, either new or remanufactured. Because they are not HP products, HP cannot influence their design or control their quality. If you are using a refilled or remanufactured print cartridge and are not satisfied with the print quality, replace the cartridge with a genuine HP cartridge.</td>
</tr>
<tr>
<td>Genuine HP print cartridge</td>
<td>1. The product control panel or the supplies status page indicates <strong>Very Low</strong> status when the cartridge has reached the end of its designated life. Replace the print cartridge if print quality is no longer acceptable.</td>
</tr>
<tr>
<td></td>
<td>2. Visually inspect the print cartridge for damage. See the instructions that follow. Replace the print cartridge if necessary.</td>
</tr>
<tr>
<td></td>
<td>3. If printed pages have marks that repeat several times at the same distance apart, print a cleaning page. If this does not solve the problem, use the repeating defects information in this document to identify the cause of the problem.</td>
</tr>
</tbody>
</table>
### Use the printer driver that best meets your printing needs

You might need to use a different printer driver if the printed page has unexpected lines in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.

<table>
<thead>
<tr>
<th>Printer Driver</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP PCL 6 driver</strong></td>
<td>• Provided as the default driver. This driver is automatically installed unless you select a different one.</td>
</tr>
<tr>
<td></td>
<td>• Recommended for all Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Provides the overall best speed, print quality, and product-feature support for most users</td>
</tr>
<tr>
<td></td>
<td>• Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Might not be fully compatible with third-party and custom software programs that are based on PCL 5</td>
</tr>
<tr>
<td><strong>HP UPD PS driver</strong></td>
<td>• Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs</td>
</tr>
<tr>
<td></td>
<td>• Provides support for printing from postscript emulation needs, or for postscript flash font support</td>
</tr>
<tr>
<td><strong>HP UPD PCL 5</strong></td>
<td>• Recommended for general office printing in Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Compatible with previous PCL versions and older HP LaserJet products</td>
</tr>
<tr>
<td></td>
<td>• The best choice for printing from third-party or custom software programs</td>
</tr>
<tr>
<td></td>
<td>• The best choice when operating with mixed environments, which require the product to be set to PCL 5 (UNIX, Linux, mainframe)</td>
</tr>
<tr>
<td></td>
<td>• Designed for use in corporate Windows environments to provide a single driver for use with multiple printer models</td>
</tr>
<tr>
<td></td>
<td>• Preferred when printing to multiple printer models from a mobile Windows computer</td>
</tr>
<tr>
<td><strong>HP UPD PCL 6</strong></td>
<td>• Recommended for printing in all Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Provides the overall best speed, print quality, and printer feature support for most users</td>
</tr>
<tr>
<td></td>
<td>• Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Might not be fully compatible with third-party and custom software programs that are based on PCL 5</td>
</tr>
</tbody>
</table>

Download additional printer drivers from this Web site: [www.hp.com/go/lj600Series_software](http://www.hp.com/go/lj600Series_software).
The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.
   ◦ If the control panel does not indicate the product is ready, turn the product off and then on again.
   ◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check the following items:
   ◦ Check the light next to the network connection on the product. If the network is active, the light is green.
   ◦ Make sure that you are using a network cable and not a phone cord to connect to the network.
   ◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties, and open the Ports tab.
   ◦ If you are using a network cable to connect to the network, make sure the printer name listed on the Ports tab matches the product name on the product configuration page.
   ◦ If you are using a USB cable and are connecting to a wireless network, make sure the box is checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.
The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of specifications, go to this Web site: www.hp.com/support/lj600Series.

2. When you configure the product to print on some paper types, such as heavy paper, the product prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not correct for the type of paper you are using, change the setting to the correct paper type.
Solve walk-up USB printing problems

- The Retrieve From USB menu does not open when you insert the USB accessory
- The file does not print from the USB storage accessory
- The file that you want to print is not listed in the Retrieve From USB menu

The Retrieve From USB menu does not open when you insert the USB accessory

1. You might be using a USB storage accessory or a file system that this product does not support. Save the files on a standard USB storage accessory that uses File Allocation Table (FAT) file systems. The product supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB storage accessory.

3. The USB storage accessory might have multiple partitions. (Some USB storage accessory manufacturers install software on the accessory that creates partitions, similar to a CD.) Reformat the USB storage accessory to remove the partitions, or use a different USB storage accessory.

4. The USB storage accessory might require more power than the product can provide.
   a. Remove the USB storage accessory.
   b. Turn the product off and then on.
   c. Use a USB storage accessory that has its own power supply or that requires less power.

5. The USB storage accessory might not be functioning correctly.
   a. Remove the USB storage accessory.
   b. Turn the product off and then on.
   c. Try printing from another USB storage accessory.

The file does not print from the USB storage accessory

1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
The file that you want to print is not listed in the Retrieve From USB menu

1. You might be trying to print a file type that the USB printing feature does not support. The product supports .pdf, .prn, .pcl, .ps, and .cht file types.

2. You might have too many files in a single folder on the USB storage accessory. Reduce the number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case, the product replaces the file names with characters from a different character set. Rename the files using ASCII characters.
Solve connectivity problems

Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

- Verify that the cable is connected to the computer and to the product.
- Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.
- Verify that the cable is working correctly by connecting it to another product. Replace the cable if necessary.

Solve network problems

Check the following items to verify that the product is communicating with the network. Before beginning, print a configuration page from the product control panel and locate the product IP address that is listed on this page.

- Poor physical connection
- The computer is using the incorrect IP address for the product
- The computer is unable to communicate with the product
- The product is using incorrect link and duplex settings for the network
- New software programs might be causing compatibility problems
- The computer or workstation might be set up incorrectly
- The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.
2. Verify that cable connections are secure.
3. Look at the network port connection on the back of the product, and verify that the amber activity light and the green link-status light are lit.
4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the product is selected. The product IP address is listed on the product configuration page.
2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always print to this printer, even if its IP address changes.
3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the network.
   a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and then type cmd.
   b. Type ping followed by the IP address for your product.
      For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in the Ping pane.
   c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

   Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change these settings, you must also change them for your network.

New software programs might be causing compatibility problems

   Verify that any new software programs are correctly installed and that they use the correct printer driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.
2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.
2. Reconfigure the network settings if necessary.
Solve product software problems with Windows

A printer driver for the product is not visible in the Printer folder

1. Reinstall the product software.

   **NOTE:** Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select **Close** or **Disable**.

2. Try plugging the USB cable into a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

   **NOTE:** Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select **Close** or **Disable**.

2. Check the amount of free space on the drive where you are installing the product software. If necessary, free up as much space as you can, and reinstall the product software.

3. If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB and power cables. Try a new cable.

3. Verify that the IP address on the configuration page matches the IP address for the software port. Use one of the following procedures:


   a. Click **Start**.

   b. Click **Settings**.

   c. Click **Printers and Faxes** (using the default Start menu view) or click **Printers** (using the Classic Start menu view).

   d. Right-click the product driver icon, and then select **Properties**.

   e. Click the **Ports** tab, and then click **Configure Port**.

   f. Verify the IP address, and then click **OK** or **Cancel**.

   g. If the IP addresses are not the same, delete the driver, and reinstall the driver using the correct IP address.
Windows 7

a. Click Start.

b. Click Devices and Printers.

c. Right-click the product driver icon, and then select Printer properties.

d. Click the Ports tab, and then click Configure Port.

e. Verify the IP address, and then click OK or Cancel.

f. If the IP addresses are not the same, delete the driver, and then reinstall the driver using the correct IP address.
Solve product software problems with Mac

- The printer driver is not listed in the Print & Fax list
- The product name does not appear in the product list in the Print & Fax list
- The printer driver does not automatically set up the selected product in the Print & Fax list
- A print job was not sent to the product that you wanted
- When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is selected.
- You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/Contents/Resources. If necessary, reinstall the software.
2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.

The product name does not appear in the product list in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.
2. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax list.
3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected product in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.
2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/Contents/Resources. If necessary, reinstall the software.
3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.
4. Replace the USB or network cable with a high-quality cable.
A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.
2. Another product with the same or similar name might have received your print job. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax list.

When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.
2. Make sure that the USB cable is connected correctly.
3. Make sure that you are using the appropriate high-speed USB cable.
4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect all of the devices from the chain, and connect the cable directly to the USB port on the computer.
5. Check to see if more than two non-powered USB hubs are connected in a row on the chain. Disconnect all of the devices from the chain, and then connect the cable directly to the USB port on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic printer driver instead of the driver for this product.

1. Delete the generic printer driver.
2. Reinstall the software from the product CD. Do not connect the USB cable until the software installation program prompts you.
3. If multiple printers are installed, make sure that you have selected the correct printer in the Format For drop-down menu in the Print dialog box.
A  Product supplies and accessories

- Order parts, accessories, and supplies
- Part numbers
## Order parts, accessories, and supplies

<table>
<thead>
<tr>
<th>Order</th>
<th>Website</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order supplies and paper</td>
<td><a href="http://www.hp.com/go/suresupply">www.hp.com/go/suresupply</a></td>
</tr>
<tr>
<td>Order genuine HP parts or accessories</td>
<td><a href="http://www.hp.com/buy/parts">www.hp.com/buy/parts</a></td>
</tr>
<tr>
<td>Order through service or support providers</td>
<td>Contact an HP-authorized service or support provider.</td>
</tr>
<tr>
<td>Order using HP software</td>
<td><a href="http://www.hp.com/buy/parts">Use the HP Embedded Web Server on page 147</a></td>
</tr>
</tbody>
</table>
Part numbers

The following list of accessories was current at the time of printing. Ordering information and availability of the accessories might change during the life of the product.

Paper-handling accessories

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional 500-sheet tray and feeder unit</td>
<td>Optional tray to increase paper capacity. Holds Letter, A4, Legal, A5, B5 (JIS), Executive, and 8.5 x 13 inch paper sizes. The product can accommodate up to four optional 500-sheet feeders.</td>
<td>CE998A</td>
</tr>
<tr>
<td>Optional 1,500-sheet tray and feeder unit</td>
<td>Optional tray to increase paper capacity. Holds Letter, Legal, and A4 paper sizes.</td>
<td>CE398A</td>
</tr>
<tr>
<td>Custom media cassette</td>
<td>Enables the product to print A6-size paper from Tray 2.</td>
<td>CB527A</td>
</tr>
<tr>
<td>Envelope feeder</td>
<td>Holds up to 75 envelopes.</td>
<td>CE399A</td>
</tr>
<tr>
<td>Duplexer (duplex printing accessory)</td>
<td>Allows automatic printing on both sides of the paper.</td>
<td>CF062A</td>
</tr>
<tr>
<td>500-sheet stacker</td>
<td>Provides an additional output bin that holds 500 sheets.</td>
<td>CE404A</td>
</tr>
<tr>
<td>500-sheet stapler/stacker</td>
<td>Allows for high-volume output with automatic job finishing. Staples up to 15 sheets of paper.</td>
<td>CE405A</td>
</tr>
<tr>
<td>HP 5-bin mailbox</td>
<td>Provides five output bins that you can use to sort jobs.</td>
<td>CE997A</td>
</tr>
<tr>
<td>Printer stand</td>
<td>Provides stability when multiple optional trays are installed. The stand has casters so you can easily move the product.</td>
<td>CB525A</td>
</tr>
</tbody>
</table>

Customer self-repair parts

The following Customer Self-Repair parts are available for your product.

- Parts listed as Mandatory self-replacement are to be installed by customers, unless you are willing to pay HP service personnel to perform the repair. For these parts, on-site or return-to-depot support is not provided under your HP product warranty.

- Parts listed as Optional self-replacement can be installed by HP service personnel at your request for no additional charge during the product warranty period.
### Item Description

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Description</th>
<th>Self-replacement options</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet black print cartridge</td>
<td>Standard black cartridge</td>
<td>Mandatory</td>
<td>CE390A</td>
</tr>
<tr>
<td>High-capacity black cartridge</td>
<td>Mandatory</td>
<td>CE390X</td>
<td></td>
</tr>
<tr>
<td><strong>NOTE:</strong> M602 and M603 models only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1,000-staple cartridge</td>
<td>Provides three staple cartridges</td>
<td>Mandatory</td>
<td>Q3216A</td>
</tr>
<tr>
<td>Preventive maintenance kit</td>
<td>Includes a replacement fuser, a transfer roller,</td>
<td>Mandatory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a transfer-roller tool, a Tray 1 roller, eight</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>feed rollers, and one pair of disposable gloves.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Includes instructions for installing each</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>component.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>44 x 32-pin DDR2 memory DIMM, 512 MB</td>
<td>Boosts the ability of the product to handle</td>
<td>Mandatory</td>
<td>CE483A</td>
</tr>
<tr>
<td></td>
<td>large or complex print jobs.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1 For more information, go to [www.hp.com/go/learnaboutsupplies](http://www.hp.com/go/learnaboutsupplies).

### Cables and interfaces

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Description</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Jetdirect print server devices</td>
<td>HP Jetdirect 2700w USB Wireless device</td>
<td>J8026A</td>
</tr>
<tr>
<td>USB cable</td>
<td>2-meter (6-ft) A-to-B cable</td>
<td>C6518A</td>
</tr>
</tbody>
</table>
B  Service and support

- Hewlett-Packard limited warranty statement
- HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement
- Data stored on the print cartridge
- End User License Agreement
- Customer self-repair warranty service
- Customer support
- Repack the product
Hewlett-Packard limited warranty statement

<table>
<thead>
<tr>
<th>HP PRODUCT</th>
<th>DURATION OF LIMITED WARRANTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet 600 M601n, M601dn, M602n, M602dn, M602x, M603n, M603dn, M603xh</td>
<td>One-year return-to-bench repair warranty</td>
</tr>
</tbody>
</table>

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in materials and workmanship after the date of purchase, for the period specified above. If HP receives notice of such defects during the warranty period, HP will, at its option, either repair or replace products which prove to be defective. Replacement products may be either new or equivalent in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date of purchase, for the period specified above, due to defects in material and workmanship when properly installed and used. If HP receives notice of such defects during the warranty period, HP will replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable, within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d) operation outside of the published environmental specifications for the product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or provinces do not allow limitations on the duration of an implied warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific legal rights and you might also have other rights that vary from country/region to country/region, state to state, or province to province.

HP’s limited warranty is valid in any country/region or locality where HP has a support presence for this product and where HP has marketed this product. The level of warranty service you receive may vary according to local standards. HP will not alter form, fit or function of the product to make it operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOSS PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or tampered with in any way, (b) experience problems resulting from misuse, improper storage, or operation outside of the published environmental specifications for the printer product or (c) exhibit wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of the problem and print samples) or contact HP customer support. At HP's option, HP will either replace products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
Data stored on the print cartridge

The HP print cartridges used with this product contain a memory chip that assists in the operation of the product.

In addition, this memory chip collects a limited set of information about the usage of the product, which might include the following: the date when the print cartridge was first installed, the date when the print cartridge was last used, the number of pages printed using the print cartridge, the page coverage, the printing modes used, any printing errors that might have occurred, and the product model. This information helps HP design future products to meet our customers’ printing needs.

The data collected from the print cartridge memory chip does not contain information that can be used to identify a customer or user of the print cartridge or their product.

HP collects a sampling of the memory chips from print cartridges returned to HP’s free return and recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling are read and studied in order to improve future HP products. HP partners who assist in recycling this print cartridge might have access to this data, as well.

Any third party possessing the print cartridge might have access to the anonymous information on the memory chip. If you prefer to not allow access to this information, you can render the chip inoperable. However, after you render the memory chip inoperable, the memory chip cannot be used in an HP product.
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License Agreement ("EULA") is a contract between (a) you (either an individual or the entity you represent) and (b) Hewlett-Packard Company ("HP") that governs your use of the software product ("Software"). This EULA does not apply if there is a separate license agreement between you and HP or its suppliers for the Software, including a license agreement in online documentation. The term "Software" may include (i) associated media, (ii) a user guide and other printed materials, and (iii) "online" or electronic documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software ("HP Software"), software under licenses from third parties ("Third Party Software" and "Third Party License"). Any Third Party Software is licensed to you subject to the terms and conditions of the corresponding Third Party License. Generally, the Third Party License is in a file such as "license.txt" or a "readme" file. You should contact HP support if you cannot find a Third Party License. If the Third Party Licenses include licenses that provide for the availability of source code (such as the GNU General Public License) and the corresponding source code is not included with the Software, then check the product support pages of HP's website (hp.com) to learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying, storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify the HP Software or disable any licensing or control feature of the HP Software. If this Software is provided by HP for Use with an imaging or printing product (for example, if the Software is a printer driver, firmware, or add-on), the HP Software may only be used with such product ("HP Product"). Additional restrictions on Use may appear in the User Documentation. You may not separate component parts of the HP Software for Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software, provided each copy contains all the original HP Software’s proprietary notices and is used only for back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement (collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP as eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you may no longer use such HP Software. This EULA applies to each Upgrade unless HP provides other terms with the Upgrade. In case of a conflict between this EULA and such other terms, the other terms will prevail.
4. TRANSFER.

   a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of
      the HP Software to another end user. Any transfer will include all component parts, media,
      User Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer
      may not be an indirect transfer, such as a consignment. Prior to the transfer, the end user
      receiving the transferred Software will agree to this EULA. Upon transfer of the HP Software,
      your license is automatically terminated.

   b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
      commercial timesharing or bureau use. You may not sublicense, assign or otherwise transfer
      the HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
   owned by HP or its suppliers and are protected by law, including applicable copyright, trade
   secret, patent, and trademark laws. You will not remove any product identification, copyright
   notice, or proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
   disassemble the HP Software, except and only to the extent that the right to do so is allowed under
   applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
   provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
   services related to the Software or the HP Product. All such information will be subject to HP’s
   privacy policy. HP will not use such information in a form that personally identifies you except to
   the extent necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability
   of HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited
   to the greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE
   MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS
   BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
   (INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION,
   PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR
   INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE
   POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL
   PURPOSE. Some states or other jurisdictions do not allow the exclusion or limitation of incidental
   or consequential damages, so the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Software was developed entirely at private expense. All
   Software is commercial computer software within the meaning of the applicable acquisition
   regulations. Accordingly, pursuant to US FAR 48 CFR 12.212 and DFAR 48 CFR 227.7202, use,
   duplication and disclosure of the Software by or for the U.S. Government or a U.S. Government
   subcontractor is subject solely to the terms and conditions set forth in this End User License
   Agreement, except for provisions which are contrary to applicable mandatory federal laws.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
    applicable to the export or import of the Software, or (ii) restricting the Use of the Software,
    including any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you in
    this EULA.
Customer self-repair warranty service

HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs of this service. 2) Parts for which customer self repair is optional. These parts are also designed for Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day delivery. Same-day or four-hour delivery may be offered at an additional charge where geography permits. If assistance is required, you can call the HP Technical Support Center and a technician will help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether a defective part must be returned to HP. In cases where it is required to return the defective part to HP, you must ship the defective part back to HP within a defined period of time, normally five (5) business days. The defective part must be returned with the associated documentation in the provided shipping material. Failure to return the defective part may result in HP billing you for the replacement. With a customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to be used.
## Customer support

<table>
<thead>
<tr>
<th>Service</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get telephone support for your country/region</td>
<td>Have the product name, serial number, date of purchase, and problem description ready. Country/region phone numbers are on the flyer that was in the box with your product or at <a href="http://www.hp.com/support/">www.hp.com/support/</a>.</td>
</tr>
<tr>
<td>Get 24-hour Internet support</td>
<td><a href="http://www.hp.com/support/lj600Series">www.hp.com/support/lj600Series</a></td>
</tr>
<tr>
<td>Get support for products used with a Macintosh computer</td>
<td><a href="http://www.hp.com/go/macosx">www.hp.com/go/macosx</a></td>
</tr>
<tr>
<td>Download software utilities, drivers, and electronic information</td>
<td><a href="http://www.hp.com/go/lj600Series_software">www.hp.com/go/lj600Series_software</a></td>
</tr>
<tr>
<td>Order additional HP service or maintenance agreements</td>
<td><a href="http://www.hp.com/go/carepack">www.hp.com/go/carepack</a></td>
</tr>
<tr>
<td>Register your product</td>
<td><a href="http://www.register.hp.com">www.register.hp.com</a></td>
</tr>
</tbody>
</table>
Repack the product

If HP Customer Care determines that your product needs to be returned to HP for repair, follow these steps to repack the product before shipping it.

⚠️ **CAUTION:** Shipping damage as a result of inadequate packing is the customer’s responsibility.

1. Remove and retain any DIMM cards that you have purchased and installed in the product.
   
   ⚠️ **CAUTION:** Static electricity can damage electronic parts. When handling DIMMs, either wear an antistatic wrist strap, or frequently touch the surface of the DIMM antistatic package and then touch bare metal on the product.

2. Remove and retain the print cartridge.
   
   ⚠️ **CAUTION:** It is extremely important to remove the print cartridge before shipping the product. A print cartridge that remains in the product during shipping can leak and cover the product engine and other parts with toner.

   To prevent damage to the print cartridge, avoid touching the roller on it, and store the print cartridge in its original packing material or so that it is not exposed to light.

3. Remove and retain the power cable, interface cable, and optional accessories.

4. If possible, include print samples and 50 to 100 sheets of paper or other print media that did not print correctly.

5. In the U.S., call HP Customer Care to request new packing material. In other areas, use the original packing material, if possible. Hewlett-Packard recommends insuring the equipment for shipment.
C Product specifications

- Physical specifications
- Power consumption, electrical specifications, and acoustic emissions
- Operating environment
Physical specifications

Table C-1  Product dimensions and weights

<table>
<thead>
<tr>
<th>Product model</th>
<th>Height</th>
<th>Depth</th>
<th>Width</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>n and dn models</td>
<td>394 mm (15.5 in)</td>
<td>4515 mm (17.8 in)</td>
<td>425 mm (16.75 in)</td>
<td>23.6 kg (51.9 lb)</td>
</tr>
<tr>
<td>x and xh models</td>
<td>514 mm (20.25 in)</td>
<td>451 mm (17.8 in)</td>
<td>425 mm (16.75 in)</td>
<td>30.4 kg (66.8 lb)</td>
</tr>
<tr>
<td>Optional 500-sheet feeder</td>
<td>121 mm (4.8 in)</td>
<td>448.4 mm (17.7 in)</td>
<td>415 mm (16.3 in)</td>
<td>6.7 kg (14.7 lb)</td>
</tr>
<tr>
<td>Optional 1500-sheet tray</td>
<td>263.5 mm (10.4 in)</td>
<td>511.5 mm (20.1 in)</td>
<td>421 mm (16.6 in)</td>
<td>13 kg (28.7 lb)</td>
</tr>
<tr>
<td>Optional duplexing unit</td>
<td>154 mm (6.1 in)</td>
<td>348 mm (13.7 in)</td>
<td>332 mm (13.1 in)</td>
<td>2.5 kg (5.5 lb)</td>
</tr>
<tr>
<td>Optional envelope feeder</td>
<td>113 mm (4.4 in)</td>
<td>354 mm (13.9 in)</td>
<td>328 mm (12.9 in)</td>
<td>2.5 kg (5.5 lb)</td>
</tr>
<tr>
<td>Optional stapler/stacker</td>
<td>371 mm (14.6 in)</td>
<td>430 mm (16.9 in)</td>
<td>387 mm (15.2 in)</td>
<td>4.2 kg (9.3 lb)</td>
</tr>
<tr>
<td>Optional stacker</td>
<td>304 mm (12 in)</td>
<td>430 mm (16.9 in)</td>
<td>378 mm (14.9 in)</td>
<td>3.2 kg (7.1 lb)</td>
</tr>
<tr>
<td>Optional multi-bin mailbox</td>
<td>522 mm (20.6 in)</td>
<td>306 mm (12 in)</td>
<td>353 mm (13.9 in)</td>
<td>7.0 kg (15.4 lb)</td>
</tr>
<tr>
<td>Optional printer stand</td>
<td>114 mm (4.5 in)</td>
<td>653 mm (25.7 in)</td>
<td>663 mm (26.1 in)</td>
<td>13.6 kg (30 lb)</td>
</tr>
</tbody>
</table>

Table C-2  Product dimensions with all doors and trays fully opened

<table>
<thead>
<tr>
<th>Product model</th>
<th>Height</th>
<th>Depth</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>n and dn models</td>
<td>394 mm (15.5 in)</td>
<td>864 mm (34.0 in)</td>
<td>425 mm (16.75 in)</td>
</tr>
<tr>
<td>x and xh models</td>
<td>514 mm (20.25 in)</td>
<td>864 mm (34.0 in)</td>
<td>425 mm (16.75 in)</td>
</tr>
</tbody>
</table>

Power consumption, electrical specifications, and acoustic emissions

See [www.hp.com/go/lj600Series_regulatory](http://www.hp.com/go/lj600Series_regulatory) for current information.

⚠️ **CAUTION:** Power requirements are based on the country/region where the product is sold. Do not convert operating voltages. This will damage the product and void the product warranty.

Operating environment

Table C-3  Necessary conditions

<table>
<thead>
<tr>
<th>Environmental condition</th>
<th>Printing</th>
<th>Storage/standby</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature (product and print cartridge)</td>
<td>7.5°C to 32.5°C (45.5°F to 90.5°F)</td>
<td>0°C to 35°C (32°F to 95°F)</td>
</tr>
<tr>
<td>Relative humidity</td>
<td>5% to 90%</td>
<td>35% to 85%</td>
</tr>
</tbody>
</table>
D  Regulatory information

- FCC regulations
- Environmental product stewardship program
- Declaration of Conformity
- Safety statements
FCC regulations

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy, and if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class A limits of Part 15 of FCC rules.
Environmental product stewardship program

Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production

This product generates no appreciable ozone gas (O₃).

Power consumption

Power usage drops significantly while in Sleep mode, which saves natural resources and saves money without affecting the high performance of this product. Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark will appear on ENERGY STAR qualified imaging products:

![Energy Star Logo]

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Toner consumption

EconoMode uses less toner, which might extend the life of the print cartridge. HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the print cartridge.

Paper use

This product’s optional automatic duplex feature (two-sided printing) and N-up printing (multiple pages printed on one page) capability can reduce paper usage and the resulting demands on natural resources.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of the product’s life.
HP LaserJet print supplies

It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge— with HP Planet Partners. Multilingual program information and instructions are included in every new HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally sound, from product design and manufacturing to distribution, customer use and recycling. When you participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled properly, processing them to recover plastics and metals for new products and diverting millions of tons of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be returned to you. Thank you for being environmentally responsible!

**NOTE:** Use the return label to return original HP LaserJet print cartridges only. Please do not use this label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty returns. For information about recycling your HP inkjet cartridges please go to [http://www.hp.com/recycle](http://www.hp.com/recycle).

Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg (70 lb).

3. Use a single pre-paid shipping label.

**OR**

1. Use your own suitable box, or request a free bulk collection box from [www.hp.com/recycle](http://www.hp.com/recycle) or 1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For US and Puerto Rico HP LaserJet print cartridge recycling returns, use the pre-paid, pre-addressed shipping label contained in the box. To use the UPS label, give the package to the UPS driver during
your next delivery or pick-up, or take it to an authorized UPS drop-off center. (Requested UPS Ground pickup will be charged normal pick-up rates) For the location of your local UPS drop-off center, call 1-800-PICKUPS or visit www.ups.com.

If you are returning the package with the FedEx label, give the package to either the U.S. Postal Service carrier or FedEx driver during your next pick-up or delivery. (Requested FedEx Ground pickup will be charged normal pick-up rates). Or, you can drop off your packaged print cartridge(s) at any U.S. Post Office or any FedEx shipping center or store. For the location of your nearest U.S. Post Office, please call 1-800-ASK-USPS or visit www.usps.com. For the location of your nearest FedEx shipping center/store, please call 1-800-GOFEDEX or visit www.fedex.com.

For more information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle or call 1-800-340-2445. Information subject to change without notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal Service provides no-cost cartridge return transportation services under an arrangement with HP for Alaska and Hawaii.

Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in the recycling guide (found inside the packaging of your new product supply item) or visit www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet printing supplies.

Paper

This product is capable of using recycled papers when the paper meets the guidelines outlined in the HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper according to EN12281:2002.

Material restrictions

This HP product does not contain added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries contained in or supplied by Hewlett-Packard for this product include the following:

<table>
<thead>
<tr>
<th>HP LaserJet Enterprise 600 M601, M602, and M603 Series Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td><strong>Weight</strong></td>
</tr>
<tr>
<td><strong>Location</strong></td>
</tr>
<tr>
<td><strong>User-removable</strong></td>
</tr>
</tbody>
</table>
Disposal of waste equipment by users in private households in the European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner) can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/community/environment/productinfo/safety.

For more information

To obtain information about these environmental topics:

- Product environmental profile sheet for this and many related HP products
- HP’s commitment to the environment
- HP’s environmental management system
- HP’s end-of-life product return and recycling program
- Material Safety Data Sheets

Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer’s Name: Hewlett-Packard Company
DoC#: BOISB-1101-00-rel.1.0

Manufacturer’s Address: 11311 Chinden Boulevard
Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Enterprise 600 M601, M602, and M603
Including:
CE998A – 500-sheet paper tray
CF062A – Duplexer

Regulatory Model Number2) BOISB-1101-00

Product Options: ALL

Print Cartridges: CE390A, CE390X

conforms to the following Product Specifications:

SAFETY:
IEC 60950-1:2005 / EN60950-1: 2006 +A11
IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)
GB4943-2001

EMC:
EN 61000-3-2:2006
EN 61000-3-3:2008
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class A1/ ICES-003, Issue 4
GB9254-2008, GB17625.1-2003

Supplementary Information:
This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name or the product number(s).

3. The product meets the requirements of EN55022 & CNS13438 Class A in which case the following applies: “Warning – This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures”.

Boise, Idaho USA

September 2011

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards Europe, Herrenberger Straße 140, D-71034, Böblingen (FAX: +49-7031-14-3143) www.hp.eu/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho 83707-0015 (Phone: 208-396-6000)
Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has implemented regulations for laser products manufactured since August 1, 1976. Compliance is mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the device is completely confined within protective housings and external covers, the laser beam cannot escape during any phase of normal user operation.

⚠️ WARNING! Using controls, making adjustments, or performing procedures other than those specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations

Complies with Canadian EMC Class A requirements.

« Conforme à la classe A des normes canadiennes de compatibilité électromagnétiques. « CEM ».

VCCI statement (Japan)

この装置は、クラスA情報技術装置です。この装置を家庭環境で使用すると電波妨害を引き起こすことがあります。この場合には使用者は適切な対策を講ずるよう要求されます。

VCCI-A

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

⚠️ CAUTION: To prevent damage to the product, use only the power cord that is provided with the product.

Power cord statement (Japan)

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。
EMC statement (China)

此为A级产品，在生活环境中，该产品可能会造成无线电干扰。在这种情况 下，可能需要用户对其干扰采取切实可行的措施。

EMC statement (Korea)

| A급 기기  | 이 기기는 업무용(A급)으로 전자파적합등록을 한 기기  
| (업무용 방송통신기기) | 기이오니 판매자 또는 사용자는 이점을 주의하시기 바라며, 가정 외의 지역에서 사용하는 것을 목적으로 합니다. |

EMI statement (Taiwan)

警告使用者：
这是甲類的資訊產品，在居住的環境中使用時，可能會造成射頻干擾，在這種情況下，使用者會被要求採取某些適當的對策。

Product Stability

Do not extend more than one paper tray at a time.

Laser statement for Finland

**Luokan 1 laserlaite**

Klass 1 Laser Apparat


**VAROITUS !**

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

**WARNING !**

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för osynlig laserstrålning, som överskrider gränserna för laserklass 1.
HUOLTO

HP LaserJet 600 M601n, M601dn, M602n, M602dn, M602x, M603n, M603dn, M603xh - kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömälle lasersäteilylle laitteen ollessa toiminnassa. Älä katso säteeseen.

WARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.

GS statement (Germany)

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.
### Substances Table (China)

有毒有害物质表
根据中国电子信息产品污染控制管理办法的要求而出台

<table>
<thead>
<tr>
<th>部件名称</th>
<th>铅 (Pb)</th>
<th>汞 (Hg)</th>
<th>镉 (Cd)</th>
<th>六价铬 (Cr(VI))</th>
<th>多溴联苯 (PBB)</th>
<th>多溴二苯醚 (PBDE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>打印引擎</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>控制面板</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>塑料外壳</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>格式化板组件</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>碳粉盒</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

0：表示在此部件所用的所有同类材料中，所含的此有毒或有害物质均低于 SJ/T11363-2006 的限制要求。
X：表示在此部件所用的所有同类材料中，至少一种所含的此有毒或有害物质高于 SJ/T11363-2006 的限制要求。

注：引用的“环保使用期限”是根据在正常温度和湿度条件下操作使用产品而确定的。

### Restriction on Hazardous Substances statement (Turkey)

Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
# Index

## Symbols/Numerics

<table>
<thead>
<tr>
<th>Symbol/Numerical</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,500-sheet tray</td>
<td>Loading 81, Paper jams 187</td>
</tr>
<tr>
<td>500-sheet tray</td>
<td>Loading 79, Paper jams 186</td>
</tr>
</tbody>
</table>

## A

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Ordering 208, Part numbers 209</td>
</tr>
<tr>
<td>Acoustic specifications</td>
<td>224</td>
</tr>
<tr>
<td>Administration menu, control panel</td>
<td>18</td>
</tr>
<tr>
<td>AirPrint</td>
<td>52</td>
</tr>
<tr>
<td>Alerts, e-mail</td>
<td>51</td>
</tr>
<tr>
<td>Anticounterfeit supplies</td>
<td>95</td>
</tr>
</tbody>
</table>

## B

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup/Restore menu, control panel</td>
<td>32</td>
</tr>
<tr>
<td>Batteries included</td>
<td>229</td>
</tr>
<tr>
<td>Bins, output</td>
<td>Jams, clearing 175, Selecting 87</td>
</tr>
<tr>
<td>Booklets</td>
<td>Creating (Windows) 132, Both sides, printing on (Mac) 51</td>
</tr>
<tr>
<td>Browser requirements</td>
<td>HP Embedded Web Server 147</td>
</tr>
<tr>
<td>Buttons, control panel</td>
<td>12</td>
</tr>
</tbody>
</table>

## C

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibrate/Cleaning menu, control panel</td>
<td>32</td>
</tr>
<tr>
<td>Canadian DOC regulations</td>
<td>234</td>
</tr>
<tr>
<td>Canceling</td>
<td>Print job 54, Canceling a print request (Windows) 108</td>
</tr>
<tr>
<td>Card stock</td>
<td>Output bin, selecting 87</td>
</tr>
<tr>
<td>Cartridges</td>
<td>Non-HP 95, Recycling 95, 228, Replacing 97, Status messages 12, Storage 95, Warranty 214</td>
</tr>
<tr>
<td>Cartridges, staple</td>
<td>Loading 99</td>
</tr>
<tr>
<td>Cleaning</td>
<td>Paper path 166, 194, Product 166</td>
</tr>
<tr>
<td>Clearing jams</td>
<td>1,500-sheet tray 187, 500-sheet tray 186, Duplexer 184, Envelope feeder 189, Fuser area 181, Locations 175, Output area 175, Staple 177, Top-cover 190, Tray 1 186</td>
</tr>
<tr>
<td>Configuration Pages</td>
<td>Description 146, Configuring IP address 63, Connection USB with Mac 46, USB with Windows 60, Connectivity solving problems 201</td>
</tr>
<tr>
<td>Control panel</td>
<td>Administration menu 18, Backup/Restore menu 32, Buttons 12, Calibrate/Cleaning menu 32, Cleaning page, printing 166, Display 12, Display Settings menu 23, General Settings menu 18, Lights 12, Manage Supplies menu 24, Manage Trays menu 25, Messages, numerical list 104, Messages, types of 172, Multi-Bin Mailbox Settings menu 26, Network Settings menu 27, Print Settings menu 21, Reports menu 18, Security 153, Service menu 33, Settings 39, 50, Stapler/Stacker Settings menu 26, Troubleshooting menu 31, USB Firmware Upgrade menu 33</td>
</tr>
<tr>
<td>Retrieve job</td>
<td>14, 15</td>
</tr>
<tr>
<td>Conventions, document</td>
<td>iii</td>
</tr>
<tr>
<td>Copies</td>
<td>Changing number of (Windows) 110</td>
</tr>
<tr>
<td>Counterfeit supplies</td>
<td>95</td>
</tr>
<tr>
<td>Cover pages</td>
<td>Printing (Mac) 55, Printing on different paper (Windows) 128</td>
</tr>
</tbody>
</table>
Current Settings Page
  description 146
custom print settings (Windows) 111
custom-size paper settings
  Macintosh 54
customer support
  online 220
  repacking product 221

default gateway, setting 66
defects, repeating 103
deleting
  stored jobs 138
dimensions, product 224
DIMMs
  installing 156
  part numbers 210
  verifying installation 162
Display Settings menu, control panel 23
disposal, end-of-life 229
document conventions iii
double-sided printing (duplexing)
  turning on (Mac) 51
drivers
  changing paper types and sizes 72
  changing settings (Mac) 50
  changing settings (Windows) 39
  paper types 75
  presets (Mac) 54
  settings 39
  settings (Mac) 54
  settings (Windows) 109
  supported (Windows) 36
  universal 37
duplex alignment
  setting 141
duplex printing (double-sided)
  settings (Windows) 116
  turning on (Mac) 51
duplex printing accessory
  jams 184
  part number 209
duplex settings, changing 68
e-mail alerts 51
EconoMode setting 95, 154
economy settings 154
EIO cards
  installing 156
electrical specifications 224
Embedded Web Server
  features 147
Embedded Web Server (EWS)
  assigning passwords 152
  end-of-life disposal 229
envelope feeder
  paper jams 189
  part number 209
envelopes
  loading 84
  output bin, selecting 87
environment for product
  specifications 224
environmental features 5
Environmental Product Stewardship Program 227
error messages
  control panel 172
  e-mail alerts 51
  lights, control panel 12
  numerical list 104
  types of 172
errors
  software 203
European Union, waste disposal 230
Explorer, versions supported
  HP Embedded Web Server 147
F
FCC regulations 226
features 2
feed rollers, replacing 100
File Directory Page
  description 146
  file upload, Mac 51
Finnish laser safety statement 235
firmware
  update, Mac 51
  firmware, downloading new 166
first page
  printing on different paper
    (Windows) 128
    use different paper 55
fonts
  permanent resources 162
  upload, Mac 51
formatter
  security 153
forms
  printing (Windows) 123
fraud Web site 95
fuser
  paper jams 181
  replacing 100

gateway, setting default 66
general configuration
  HP Embedded Web Server 148
General Settings menu, control panel 18
hard disks
  encrypted 152
heavy paper
  output bin, selecting 87
help
  printing options (Windows) 110
Help button, control panel 12
HP Customer Care 220
HP Embedded Web Server 42
  features 147
  general configuration 148
  HP Web Services 150
  information pages 148
  network settings 150
  other links list 150
  print settings 149
  security settings 150
  troubleshooting tools 149
HP ePrint
  description 42, 52
  HP ePrint, using 122
HP fraud Web site 95
HP Printer Utility 51
HP Universal Print Driver 37
upgrading 156
verifying installation 162
memory chip, print cartridge
  description 215
  location 93
memory DIMMs
  security 153
menus, control panel
  accessing 12
  Administration 18
  Backup/Restore 32
  Calibrate/Cleaning 32
  Display Settings 23
  General Settings 18
  Manage Supplies 24
  Manage Trays 25
  Multi-Bin Mailbox Settings 26
  Network Settings 27
  Print Settings 21
  Reports 18
  Service 33
  Stapler/Stacker Settings 26
  Troubleshooting 31
USB Firmware Upgrade 33
menus, control-panel
  retrieve job 14, 15
mercury-free product 229
messages
  e-mail alerts 51
  lights, control panel 12
  numerical list 104
  types of 172
models, feature comparison 2
Multi-Bin Mailbox Settings menu, control panel 26
multiple pages per sheet 56
  printing (Windows) 119
n-up printing 56
  selecting (Windows) 119
names, job
  specifying (Windows) 141
Netscape Navigator, versions supported
  HP Embedded Web Server 147
network
  password, changing 65
  password, setting 65
  settings, changing 65
  settings, viewing 65
network settings
  HP Embedded Web Server 150
Network Settings menu, control panel 27
networks
  configuring 61
  default gateway 66
  HP Web Jetadmin 151
  IPv4 address 66
  IPv6 address 67
  protocols supported 61
  security 62
  subnet mask 66
networks, wired
  installing product, Mac 47
  installing product, Windows 63
  non-HP supplies 95
  notes iii
O
  online support 220
  opening printer drivers (Windows) 109
operating environment
  specifications 224
operating systems supported 36, 46
ordering
  part numbers for 209
  supplies and accessories 208
orientation
  selecting, Windows 120
other links list
  HP Embedded Web Server 150
output bins
  paper jams 175
  selecting (Windows) 134
P
  packaging product 221
  page sizes
    scaling documents to fit (Windows) 130
  pages per sheet 56
  selecting (Windows) 119
paper
  covers, using different paper 128
  custom-size, Macintosh
    settings 54
  first and last pages, using different paper 128
first page 55
  jams 173
  loading 1,500-sheet tray 81
  loading 500-sheet tray 79
  loading Tray 1 78
pages per sheet 56
  printing on preprinted letterhead or forms (Windows) 123
  selecting 193
  supported sizes 73
  supported types 75
paper jams
  1,500-sheet tray 187
  500-sheet tray 186
duplexer 184
envelope feeder 189
fuser area 181
locations 175
output bin 175
top-cover 190
Tray 1 186
paper pickup problems
  solving 173
paper size
  changing 72
paper sizes
  selecting 115
  selecting custom 115
  supported 73
paper types
  changing 72
  selecting 115
paper, ordering 208
paper, special
  printing (Windows) 125
part numbers
  maintenance kits 209
  memory 210
  print cartridges 209
  supplies 209
  trays 209
PCL drivers 36
universal 37
PCL Font List

description 146
perform printer maintenance message 100
permanent resources 162
personal jobs
storing temporarily (Windows) 139
physical specifications 224
pickup rollers
ordering 210
replacing 100
portrait orientation
selecting, Windows 120
postcards
output bin, selecting 87
PostScript Printer Description (PPD) files
included 51
power
consumption 224
PPDs
included 51
preprinted paper
printing (Windows) 123
presets (Mac) 54
print cartridge
paper jams 190
print cartridges
checking for damage 102
memory chips 215
non-HP 95
part numbers 209
recycling 95, 228
replacing 97
status messages 12
storage 95
warranty 214
print jobs
canceling (Mac) 54
storing permanent copies (Windows) 140
storing permanent private copies (Windows) 140
storing temporarily (Windows) 139
storing temporary copies (Windows) 139
print quality
improving 193
improving (Windows) 115
print settings
HP Embedded Web Server 149
Print Settings menu, control panel 21
print tasks 107
printer drivers
choosing 196
printer drivers (Mac)
changing settings 50
settings 54
printer drivers (Windows)
changing settings 39
settings 109
supported 36
printer maintenance kit
using 100
printer stand
part number 209
printing
from USB storage accessories 143
settings (Mac) 54
settings (Windows) 109
stored jobs 138
printing on both sides
settings (Mac) 56
settings (Windows) 116
priority, settings 39, 50
private jobs
storing permanently (Windows) 140
problem-solving
e-mail alerts 51
messages, types of 172
no response 197
slow response 198
product comparison 2
proof and hold
selecting (Windows) 139
protocols, network 61
PS Emulation drivers 36
PS Font List
description 146
Q
quick copy jobs
storing (Windows) 139
R
rear output bin
paper jams 175
printing to 87
recycling 5, 228
HP printing supplies returns and environmental program 228
recycling supplies 95
regulatory statements
environmental product stewardship program 227
removing Mac software 49
removing Windows software 41
repacking product 221
repeating defects, troubleshooting 103
replacing printing cartridges 97
Reports menu, control panel 18
resize documents
Macintosh 54
Windows 130
resource saving 162
restore factory settings 171
retention, job
modes available 137
setting options (Windows) 139
retrieve job menu 14, 15
rollers
ordering 210
replacing 100
rough paper
output bin, selecting 87
S
safety statements 234, 235
SAP software 43
saving resources, memory 162
scale documents
Macintosh 54
Windows 130
security
encrypted hard disk 152
security features 62
security settings
HP Embedded Web Server 150
service
  repacking product 221
Service menu, control panel 33
settings
  driver presets (Mac) 54
drivers 39
  drivers (Mac) 50
  priority 39, 50
  restore factory 171
shipping product 221
shortcuts (Windows)
  creating 112
  using 111
SIMMs, incompatibility 156
sleep delay
  disabling 155
  enabling 155
sleep mode
  disabling 154
  enabling 154
Sleep Schedule
  setting 155
sleep schedule
  disabling 155
  enabling 155
small paper, printing on 87
software
  embedded Web server 42
  HP Printer Utility 51
  HP Web Jetadmin 42
  installing, USB connections 60
  installing, wired networks 64
  Mac 51
  problems 203
  settings 39, 50
  software license agreement
    216
  supported operating systems
    36, 46
  uninstalling for Windows 41
  uninstalling Mac 49
Solaris software 43
solving
  direct-connect problems 201
  network problems 201
  walk-up USB printing
    problems 199
special media
  guidelines 70
special paper
  guidelines 70
  printing (Windows) 125
specifications
  electrical and acoustic 224
  operating environment 224
  physical 224
stapler
  part number 209
  printing to 88
staple cartridges
  loading 99
  part numbers 210
staple jams 177
staple options
  selecting (Windows) 135
stapler/stacker
  jams, staple 177
  loading staples 99
  part number 209
  printing to 88
Stapler/Stacker Settings menu, control panel 26
status
  HP Utility, Mac 51
  messages, types of 172
status, supplies
  control panel messages 12
  stopping a print request (Windows) 108
storage, job
  Macintosh settings 51, 56
  modes available 137
  setting options (Windows) 139
stored jobs
  creating (Windows) 137
  deleting 138
  printing 138
  receiving notification when printed (Windows) 140
  security 153
  setting user names (Windows) 141
  specifying names (Windows) 141
storing
  print cartridges 95
  storing jobs
  permanent copies (Windows) 140
permanent private copies (Windows) 140
proof and hold (Windows) 139
setting options (Windows) 139
temporary copies (Windows) 139
temporary personal jobs (Windows) 139
  with Windows 137
straight-through paper path 87
subnet mask 66
supplies
  counterfeit 95
  memory errors 104
  non-HP 95
  ordering 208
  part numbers 209, 210
  recycling 95, 228
  replacing print cartridges 97
  status, viewing with HP Utility 51
supplies status page
  description 146
  printing 103
supplies, status
  control panel messages 12
support
  online 220
  repacking product 221
supported paper 73
system requirements
  HP Embedded Web Server 147
Taiwan EMI statement 235
TCP/IP
  manually configuring IPv4 parameters 66
  manually configuring IPv6 parameters 67
technical support
  online 220
  repacking product 221
temperature specifications 224
tips iii
toner cartridges. See print cartridges
top cover
  paper jams, clearing 190
top output bin
  paper jams 175
  printing to 87
transfer rollers, replacing 100
transparencies
  output bin 87
  printing (Windows) 125
Tray 1
  loading 78
  paper jams 186
Tray 2
  loading 79
  paper jams 186
Tray 3
  loading 79
  paper jams 186
physical specifications 224
trays
  configure 85
  load 78
  loading 1,500-sheet tray 81
  loading 500-sheet tray 79
  loading Tray 1 78
  Macintosh settings 51
  paper jams 175, 186, 187
  paper orientation 83
  part numbers 209
  selecting (Windows) 115
troubleshooting
  1,500-sheet tray paper jams 187
  500-sheet tray paper jams 186
  direct-connect problems 201
duplexer jams 184
envelope feeder jams 189
error messages, numerical list 104
fuser-area paper jams 181
jams 173
Mac problems 205
network problems 201
output bin jams 175
paper feed problems 173
paper jams 175
repeating defects 103
staple jams 177
top-cover paper jams 190
Tray 1 paper jams 186
walk-up USB printing
  problems 199
Windows problems 203
Troubleshooting menu, control panel 31
troubleshooting tools
  cleaning page 166
  control-panel messages 104, 172
  HP Embedded Web Server 149
  solve problems checklist 169
two-sided printing
  settings (Windows) 116
  turning on (Mac) 51
U
  uninstalling Mac software 49
  uninstalling Windows software 41
universal print driver 37
updates, downloading product 166
upgrading memory 156
Usage Page
  description 146
USB cable, part number 210
USB configuration, Mac 46
USB configuration, Windows 60
USB devices
  installing 163
USB Firmware Upgrade menu, control panel 33
USB storage accessories
  printing from 143
user names
  setting for stored jobs (Windows) 141
W
  walk-up USB printing 143
warnings iii
warranty
  customer self repair 219
  license 216
  print cartridges 214
  product 212
watermarks 55
  adding (Windows) 132
Web browser requirements
  HP Embedded Web Server 147
Web printing
  HP ePrint 42, 52
Web sites
  customer support 220
  fraud reports 95
  HP Web Jetadmin, downloading 151
  Macintosh customer support 220
  Material Safety Data Sheet (MSDS) 230
  universal print driver 37
weight, product 224
Windows
  driver settings 39
  drivers supported 36
  supported operating systems 36
  universal print driver 37

ENWW Index 245